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1 Basics

1.1 Introduction

Remark:

The user manual describes the functions of the Belimo PC- Tool. The Belimo
PC-Tool is a PC-based tool for parameterizing Belimo MFT(2), MP, MF, LON and
BF-TopLine actuators, MFT(2), MP and BF-TopLine actuators can be configured
for MP-Bus operation and can be monitored via bus.

This document is designed to present basic information. Since the PC-Tool has a
modular structure, the explanations for specific modules are given in the
individual module documents.

The documentation of the individual modules can be accessed through the main
document.

1.2 Information on using the manual

Variant

An arrow symbol shows the order of menu commands in sub-menus. For the
function

MP-Channel » Trigger scan,
select MP-Channel in the main menu and then Trigger scan in the submenu.

This manual uses English terms for control elements frequently encountered in
Microsoft Windows:

Button

Combobox

Radio button

Checkbox

Notes are enclosed in separation lines.

If a function can be triggered in several ways, variant ways are described in
addition to the recommended way.
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1.3 General structure of the user interface

=101 =]
File Project MP Channel Tools H A
—

0| Bl &6 (e[ =-HB
5 - PCToal V.0 Type NM24-MFT2 Sh 004489-20025-062-069
E ..... ? ,:[;'Ef: ACITIEEDM Desighation NM24-MFT2 Address MP1
..... -Channet: 5 iti
S B Position Room1
Ll MPZ: Boom?,

. Simulation | |E|

C Actual S ettings = Test |
Control function” DC 2-10V
Sengitivity Mormal Adaption |

Synchronisation

Service | Configuration

Hominalrange 93.72°
Running time 80s
Angle of rotation Maw 100 [947] . . "
:BlE
Wir: 0% 0] Mid.: 50 [47°] |
Direction of rotation cw é‘ﬁ
Synchronisation at v=0% 1003

Torque 100%
Bus fail position Analog setpaint
Power ON HMathing
M anual button [once] Synchronisation
Manual button [twace] Adaption ;I

——

4| I _;I State: IEI 0
User interface PC-Tool

”T— whole. An explanatory text (tooltip) appears for each icon in the toolbar when you
[Parameterize Limited Lot POSItion the mouse pointer on it.
The MP-Channels and actuators belonging to the project are displayed in the
outline bar [C] in the form of a tree (as in the Explorer). The object to be worked
on is marked here. Depending on the selected object, pop-up menus offer

corresponding functions at a click of the right mouse button.

E! e | e | J27 | Menu bar [A] and toolbar [B] provide functions that affect the program as a

----- § ' Change MP-Address
---- - Nie De-.ﬁ.ddressing device

Print |abel
Prinkt parameter set

Pop-up menu after clicking the right mouse button

The detail area [D] contains all the detailed information on the object marked. The
values that are displayed and changed in this area are grouped as needed and
distributed over several index tabs.

The status bar [E] at the lower margin shows the current status of the connected
device (e.g.: the actuator is carrying out a synchronization or adaptation.)
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Missing or invalid entries are indicated by a flashing exclamation mark. If you
move the mouse pointer to the exclamation mark, an explanatory text (tooltip)

appears.
Froject: I a2 | |
| This Field is required! |
TI Inactive commands are displayed in gray letters (or as gray icons) according to
g = the Windows standard.

Texts in boxes with a black font on a gray background cannot be changed. You
can mark the contents with the mouse, however, and copy them into the
clipboard with CTRL+C, for example.

IMesssignal 115 wariabel

1.4 Modules and actuator types

Multifunctional damper actuators
The following actuator types can be parameterized with the program PC-Tool:

Generation Type MP-bus Sensors

NEW MP YES active, passive, switch
MPL YES (see datasheet)
MF No (none)

OLD MFT2 YES active, passive, switch
MFT YES active, switch
BF..24TL.. YES (none)

The manual is organized according to the application areas for actuators
(modules). Detailed descriptions can be found in the module-specific sections,
e.g. Air module, Water module, Fire & Smoke module, VAV module, EPIV
Module.

VAV controller

The VAV module (VAV = Variable Air Volume) is for operating and
parameterizing the Belimo VAV-Compact controller xXMV-D2-MP.
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2 Getting started with PC-Tool

2.1 Connecting the computer with the actuators

Connect the level converter ZIP-USB-MP to your computer. The connection of
the actuators to the ZIP box is explained in the Appendix. If you use a different
interface than COM1, you must subsequently adapt the setting [= 3.3.1 Serial
interface].

For typical wiring diagrams, see = 4.4 Typical wiring diagrams

2.2 Starting the program

i

BELIMO PC-Tool Y30 Click the program icon on your desktop. A start screen appears. Click Start
Belimo PC-Tool (bottom right).

2.3 Adapting PC-Tool options

When you start the program for the first time, a dialog is displayed for adapting
the user-specific settings.

Al i L Ralad ) ARV L o= LY

«r PC-Tool Options ﬁ
Project base path

Release Codes

MP channel configuration |C:"-.Users"-.|'~"|‘-"a'S.INGTES"-.DDcuments"-.Belimn"-.PCTu:u:nI
VAV Compact Manufacturer [~ Tt

Air module

Water Globe module Language

ﬁix rr:qu\:-lgzm module |Eng|ish ﬂ The new language setfting becomes active after a program

VAV VRP-M module Loa fi =L

Fire & Smoke module og s

EPIW module * Filepermonth File per week

MP-Menitor

[ Enable MP-Monitor
Simulation/Trend

I¥ Ask user if trendfiles should be saved.
[ Enable sensor reading functionality

Program update

Check for newer version

PC-Tool options

Select the desired language in the combobox here. If you change the language,
exit the program and restart it.
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2.4 Creating a new project

To work with the program, you have to create a "project". The dialog for entering
the project data is displayed. Click the radio button "New project".

MNew/Open projct

™ Existing project | & MHew project
Project | Con
EPMQ Project: I
=] ACME
Compary: I
Short-M ark: I
Commet:
[ i
IzerD: I
Szarsh. | Froject path: IE:HDatenHBeIimn\F‘ETDDI |

k. I Cancel ,L
.#

Creating a new project

The project name, company and user ID must be filled in; all other information is
optional.

2.5 Setting up the program

The project and the MP-Channel can be seen in the outline bar [C]. The bus is
scanned every 10 seconds by default.

i PCTool v3.0

2 Project: ACME
% MP-Channel: COM=4, (MP/PF, Every 10s)
b A2 MPT: Rooml, MM24-MFT 2, Inlet darper

- & MPZ FoomZ, MM24-MFT 2, Heater valve

Outline bar [C]

If no actuators are shown after 10 seconds, you should check whether the level
converter ZIP-USB-MP is connected to the right COM interface. Adjust the
settings for the serial interface if necessary [= 3.3.1].
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2.6 Displaying actuator parameters

Select the desired actuator in the outline bar [C] by clicking it with the mouse.

The current settings for the actuator are displayed in the detail area [D].

Type MM24-MFT2 S 00448-20025-062-069
Designation Inlet damper Address MP1
Position Room|

Service | Configuration | *. Simulation

Actual 5ettings 1= Test

Control functiony DC 2-10%
Senszitivitp Momal

Adaption

Nominalrange 9372° Synchronisation

Running time 20:
Angle of rotation Max 100%  [947] . . .
ol
Mire 0% (0 hid.: &0 [47°] L
Direction of rotabon cw él‘ﬁ
Synchronmsation at v'=0% 005

Torque 100%
Bus fail position Analog zetpoint
Power ON Maothing
Manual button [once] Synchronization
Manual button [wace] Adaption LI

Example of detail area [D] (damper actuator)

2.7 Further actions

Read the descriptions for the following topics in Section 3 Basic functions

= Bus scan

= Setting the bus address

= Parameterization of actuators

Read the details for the application areas of the actuators in the descriptions of
the following modules

= Damper actuators (Air module)

= VAV controllers

= Actuators for fire & smoke dampers (Fire & Smoke module)

= Valve actuators (Water module)
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3 Basic functions

3.1 Program start

Variant

=

After the program is started, a start screen is displayed. Click Start.

Determine the project with which you would like to work. You can either
= open one of the last projects listed,

= open an existing project from a file, or

= create a new project.

The defined MP-Channel is displayed and opened. A bus scan is started for each
MP-Channel.

If only one actuator is connected, it is automatically selected and displayed.

If you cancel the project selection, the program will be started without a project. In
this case, only the functions Help, File» New project and File » Open existing
project will be available.

You can also start the program by means of opening a project file: In the
Explorer, double-click a file with the extension . bptpj or on a corresponding file
link.

If you create a link to a project file on the desktop, make sure that you do not
inadvertently move or copy the file instead. You can tell when a link has been
created correctly by the small arrow in the bottom left-hand corner of the file icon.
(If the project file itself, rather than a link to it, is on the desktop then all other files
will be saved there as well.)

In a network environment, the program should be installed on your workstation
and started locally. Special authorizations are required to start the program on
network drives.
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3.2 Projects

3.2.1 Project data

All user-specific data of the program are administered in the framework of
projects. Each project has a project directory in the file system. The project files
are stored in sub-directories of the project directory.

The storage place of the project files is described in the Appendix.

3.2.2 Creating a new project

Select File », New Project in the main menu. Enter the new project data in the
dialog. The project name, company and user ID must be filled in; all other
information is optional. Click OK.

Since only one project can be active at a time, the currently displayed project will
be closed and the new project opened.

Variant ~ You can also create a new project by clicking the New Project icon on the
QI toolbar [B] or clicking the program icon in the outline bar [C] with the right mouse
button and then selecting New Project.

- PLCT ool 3.0

3.2.3 Opening a project
Select File » Open Existing Project in the main menu. A list of all project files in
the storage location is displayed.

Mark a project from the list in the dialog or open any given project file (*. bptpj)
with Find.... Click OK.

Since only one project can be active at a time, the currently displayed project will
be closed and the selected project opened instead.

Variant  You can also create a project by clicking on the New Project icon on the toolbar
|E| [B] or clicking the program icon in the outline bar [C] with the right mouse button
and then selecting Open Project.

e PCT ool W30

3.2.4 Changing project data
Click the project in the outline bar [C] to display the project data. The Edit button
(far right) displays a dialog in which you can change the data.
Variant  Click the project in the outline bar [C] with the right mouse button and select
Properties.

Project name and path cannot be changed within the program. However, you can
rename the project file (extension . bptpj) using the Windows Explorer or move
the entire project folder to another location. Afterwards, open the project again.
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The project folder and project file can have different names — for example for
backing up data. The name of the project file determines the project name.

3.2.5 Exporting a project

Copy the entire project folder in the Explorer, for example onto a floppy disk.

3.2.6 Copying a project

Copy the entire project folder to another location in the Explorer. Give the project
folder a new name. Give the project file (<project>.bptpj) the same name within
the new project folder.

3.2.7 Deleting a project

Delete the entire project folder in the Explorer. The project to be deleted must not
be currently open in the program.

3.3 MP-Channel

3.3.1 Serial interface

The ZIP level converter is connected to a serial interface (COM) for connecting
- the MP/MFT(2) actuator or the MP-Bus to the PC-Tool. On the first connection of
F MP-Stang: the ZIP level converter the Application installs automatically the necessary
drivers. To select the number of the serial interface used on your computer, click
the MP-Channel icon in the outline bar [C] and select MP-Channel settings.

For typical wiring diagrams, see = 4.4 Typical wiring diagrams

Now set the serial connection:

= |f you activate the "Serial connection" box (as shown in the screenshot), you
can select a serial connection. This list shows all ports on your computer
(between COM=1 ... COM=255).

= Option: If you activate the "Other" box, you can enter a connection ID in the
text box. Valid values are:

"COMXx" or "COM:x" or "COM=x" (x is is the port number between 1 and 255).
"Baudrate=x" (x is the baud rate 75...115200).

"Bytesize=x" (x is the number of data bits 5...8).

"Stopbits=x" (x is the number of stopbits 1, 1.5 or 2).

"Parity=x" (x is the the parity no, odd, even, mark or space).

It is only mandatory for the COM port to be specified. Separate the values with
a semicolon (;).

Example:
"COML1;Baudrate=9600;Stopbits=1".
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3.3.2 Bus scan

_iBix
—Connection
% Serial connection IEEIM=4 j
i~ Other I
—Buz scan
Scan Interval [z] I 10
Scan Mode |MP/PR -l
aF. || Cancel I

MP-Channel settings

In the bus scan section of the "MP-Channel settings" dialog, you can enter the
time interval for the periodic bus scan in seconds. Permitted values are whole
numbers between 1 and 9999.

The program can address actuators in two basic ways:

In multi-point mode (MP), up to 8 actuators of the types MP / MFT(2) can be
individually digitally addressed.

In point-to-point mode (PP) only a single actuator can be activated. In this case,
the "classic" operating modes are available with response voltage at connection
D5.

The actuators of the MF type can only be connected in PP mode, all others either
in PP or MP mode.

Select the type of bus scan in the bus scan section of the
"MP-Channel settings"dialog:

PP Only Connection of a single actuator in PP mode

MP / PP First scan address 1 to 8 or 1 to 16 in MP mode.
If there is no response in MP mode, switch to PP mode.

Periodic bus scan

The periodic bus scan is active by default. To switch this off, click the MP-
Channel with the right mouse button and select Interrupt scanning. Afterwards,
you can switch the periodic scan back on again the same way with the menu item
Scan Every xx Seconds.

Manual bus scan

Manually activate an immediate bus scan with the function button F5 ("Update™)
as needed. This is possible at any time, even when the periodic bus scan is
active.
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Variant  You can also select MP-Channel » Trigger Scan in the main menu or activate
the Trigger scan function by clicking the MP-Channel with the right mouse button.

If more than one actuator responds at the same MP address during a bus scan or
if more than one actuator is connected in PP mode, a bus jam will occur. This
situation is indicated by the program with a corresponding message.

5] PLT ool V3.0 ——
[Neues Prajekt] Projekt: ACME us Kollision
B MP-Strang: COM=1, (F| 2 oder mehr Teilnehmer antworten auf der gleichen Adesse

- il P'F: Bus Kaollision

If during the bus scan an active external master is recognized, the channel will be
closed. This situation is indicated with the according message.

[« PCToolGUI V3.10

------- [fj Project: test

- Channel: COM=3, (MP/PP, Clo

Bus Jam

External MP-Master active, PC-Tool can not be used

Saving a bus scan overview in a file

The result of a bus scan can be saved in a file for recording. Select "Channel" in
the outline bar to show an enumeration of all found MP nodes with the
corresponding data (address, position, type, description and serial number).

RPC-Tool --- BELIMO Automation AG , =10} x|

File MP-Monitor Project Channel Tools Help

D||m| 2|1 B |k |||
== PCToolGUI V3.4
[ﬁ Project: Standard

£ .:‘7‘ Channel: COM=2, (MP/Pf | | Address | Posttion | Type | Designationl Series No.
& MP1: testrig, LR24: & MP1 testig LR.. ACME 00633-20177-142-136
& MP3: testrig, LM24: gl ML Shmee 00543-10256-142-143
| Save to file. ., |

< | i

Saving the bus scan overview

Click the right mouse button to open the context menu and choose "Save to file"
for saving the information in a text file.

3.4 Setting the bus address

Each actuator with an MP-Bus interface (valid for all devices with an MP-Bus
interface, e.g. I/0 modules, etc.) can be assigned an address which it will use to
communicate on the MP-Bus.

The setting of the bus address can be disabled on certain actuators, e.g. for the
actuator types ...LON and ...ALON (for LONWORKS®).
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By default an address can be assigned between MP1 and MP8. Through a
parameter change in the configuration file "PCToolGUIl.exe.config“ the address
range can be extended up to MP16. Valid values are MP8 and MP16, all other
entries are treated as MP8.

3.4.1 Series addressing of actuators
|E| Click the Address device icon in the toolbar [B].

Variant  Click the MP-Channel with the right mouse button and select Addressing Device.
Or select MP-Channel » Addressing Device in the main menu.

Series addressing of devices

i
]

Series-MNumber of the device Type of the device L

=
=
1

=

= = = =E| =ZE| =
| W| W| W| W| W oW
Q| | | | & ] M
4 4 4 4 4 4 4

Detecting devices:

- gnter series number manually  or

- activate the actuators address button  or
- start automatic pre-addressing of devices.

| Set Address | Automatic pre-addressing Cancel

L A

Series addressing

If you want to use something other than the default order, then select the desired
addresses in the comboboxes on the right.

Reading in the serial numbers with acknowledgement on the actuator

Then press the acknowledge button on the actuator that is to receive the first
address. Depending on the type of actuator, this is the manual button, the L/R
change-over switch, the manual control or the S2 button. (If the buttons are not
accessible, enter the serial numbers directly as described below.)

Actuator family | Actuator type Acknowledge function

Actuators NM24-MFT(2) Press manual button once!
without AM24-MFT(2)
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spring return GM24-MFT(2)

Actuators with | LF24-MFT(2) Move L/R switch back and forth once

spring return AF24-MFT(2) (within 4 seconds)! L
R D

Actuators for BF(G)24TL-T-ST | Turn the manual control for about 1/6 in

fire & smoke direction "Unlock” (1 and release the crank.
dampers

(4.
Linear NV24-MFT(2) Actuate button S2 (under the housing
actuators for NVF24-MFT(2) |cover) once!
valves NVF24-MFT(2)-E iz}
Actuators of ...MP Actuate the "Address" button
the New ...MF
Generation ...ALON

The serial number of the actuator is read out after the acknowledgement and
written into the input box. The cursor jumps to the next line.

Repeat this process for all actuators that are to be addressed and then click
"Set address".

If one of the addresses is already assigned to another actuator, a message will
be displayed:

Belimo PC-Tool: Series addressing of d x|

@ Bddress MP1 is nok free, de-address ather device(s) First?

Mo | Cancel |

Message when an address is already assigned (series addressing)

Click Yes to initially release the address. The actuator that used to occupy the
address is set to PP.

If you select No, the actuator will be set to the already assigned address and a
bus jam can occur.
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Click Cancel to stop the series addressing at this point. You can now rearrange
the addresses or end the entire process.

3.4.2 PPX addressing

On this new addressing variant the program asks actively for actuators, which
support PPX and they are not MP addressed yet. First ,wins’ and will be
recognized. In order that can be recognized all actuators, the application provides
all found PP actuators automatically with a MP address. Since the “manual”
variant is the “normal case”, PPX scan doesn't start automatically but only when
the button “Automatic pre-addressing” is pressed.

-

Series addressing of devices

Series-Mumber of the device Type of the device Address
E= (0112210048 158153 [up1 ~]
| up2 -]
E= [0132430026160-167 CMV-125 =N
B [0114120033158152 [ups -]
| ups -]
| e |
| 7 -]
| ups -]

Looking for PPX enabled devices that are not addressed yet.

I

3.4.3 Addressing with known serial numbers

Each MP/MFT(2) actuator is delivered with a label containing its individual serial
number. These serial numbers can be used to assign a PP or an MP1 ... MP8
address to the actuator. An additional, removable label with an identical serial
number is supplied with the actuator. If the actuator is installed at a particular
position in the system, this additional label can be affixed at the same position in
the system diagram. This records where the actuator with the corresponding
serial number is located in the building. These serial numbers can be used to
assign the MP1 ... MP8 addresses to the actuators.

You can also fill in the input boxes manually before clicking Set Address, for
example when the buttons of the actuators are not accessible or you regularly
take the serial numbers from your documents.

3.4.4 Resetting actuator addresses

If you want to reset actuators with MP addressing to PP, click to the right of the
MP-Channel and select "De-address Device" in the pop-up menu.
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De-Addressing

[+ tP1
[~ MP2
[~ MP3
[~ wMP4
[~ MF5
[~ MPB
[~ MF7
[~ MP3

—Addreszes ta rezet to PP-Mode

4
BELIMO

De-Address

Cancel

Selection of the addresses to be reset

Mark the addresses whose actuators are to be de-addressed.
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When the bus scan is set to MP/PP, the de-addressed actuators are no longer
visible in the outline bar [C] as long as there are still actuators with addresses.

If you set several actuators to PP, a bus jam will occur with the bus setting
"PP only".

3.4.5 Addressing a single actuator

Variant

Select the actuator in the outline bar [C] and click the "Change MP Address" icon
in the toolbar [B].

Set new address

Old address:  MP1
MP3

Mew address:

Set Address I Cancel |

Setting a new address

Click the actuator with the right mouse button and select "Change MP Address"
("MP-Adresse andern").

Select the new address in the combobox. If the address is already assigned to
another actuator, a message will be displayed:

Belimo PC-Tool: Addressing of device |

@ Address MPZ is not free, de-address other devicels) first?

Yes Mo |

Message when an address is already assigned

Click Yes to initially release the address. The actuator that used to occupy the
address is set to PP.

If you select No, the actuator will be set to the already assigned address and a
bus jam can occur.
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3.5 Selecting a module

All actuators that are active and connected to an MP-Channel are displayed in

the outline bar [C]. Select the desired actuator from this display.

B r;g‘ tMP-Channel: COM=4, [MP/PP, Evern 10s]
------- ,59 FP1: Foomd, MiZ24-MF T2, [nlet damper
bl 4P WPZ FoomZ, NM24-MFT2, Heater valve

The type of actuator is indicated by the icon:

Icon Actuator type

Damper actuator

Valve actuator

Valve actuator NG

Window ventilation actuator

Actuator for fire dampers

VAV (Variable Air Volume) controller actuator

THC24-MP

UST-3 I/O module

EPIV Electronic Pressure Independent Valve

MPL-Actuator

Datapool device

Unknown actuator

SEEEEEEEEENE

When an actuator is selected for the first time, the parameters are read out and

displayed in the detail area [D].

In addition, the address for communication on the MP-Channel (MP or PP mode)

and the name of the actuator type are displayed in the outline bar [C].

The complete information for identifying the selected actuator is found in the

header of the detail area [D].

Type NM24-MFT2 Sk 00449-20025-062-069
Designation Inlet damper Address MP1
FPosition Room

Display of the actuator identification

Note the difference between the current communication mode on the MP-

Channel and the displayed address. An actuator with the address MP2 can be

activated in PP mode during a bus scan, for example.
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3.6 Actuator parameters

3.6.1 Displaying actuator parameters

The parameters of an actuator are displayed on the Service tab in the
detail area [D].

Type NM24-MFT2 Sh 00449-20025-062-069
Cesignation Inlet damper Address MP1
Position Room1

iy |

Service |Configuration| . Simulation

Actual 5ettingz = Test

Control functionY DC 2-100
Sengzitivity Momal

Adaption

Hominal range 93.72° Synchronisation

Running ime 80z

Angle of rotation Max: 1002 [947]
hdine N3 e

Mid: 50 [479] I

Example of the "Service" tab (damper actuator)

The Test, Adaptation and Synchronization functions are described for each
respective module.

3.6.2 Printing out actuator parameters

The displayed actuator parameters can be printed out. Click the printer icon in the
toolbar [B] or select Print Actuator Parameters in the pop-up menu after clicking
the actuator in the outline bar [C] with the right mouse button.

3.6.3 Deleting maintenance/error messages

When an actuator has created and saved maintenance or fault messages, these
are displayed on the Service tab.

Messages

Messages Mechanical travel increased
Reset Messages

Message display on the Service tab

Use "Reset messages", to delete the messages stored in the actuator.
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Following messages may appeatr:
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Message

Description

Mechanical travel increased

Expected end stop value for top or bottom
has been overrun.

Mechanical overload

Actuator did not reach set point because an
obstacle has reduced the operating range

Excessive utilisation

Actuator moves to often compared with the
total operating time

(typical relation of active time to operating
time is greater than 20%)

Fail-Safe failed

The Fail-Safe module is defect (e.g Super
Cap module). This message cannot be
deleted. The defect actuator has to be
replaced.

Actuators for fire & smoke dampers have provide a larger scale of messages.
The specific messages are described in the Fire & Smoke module.
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3.7 Configuring an actuator

To change the parameters of an actuator, go to the Configuration tab.

Type SN 01144-10048-158-153
Designation D3 ohne Hohenkom Address MP1
Position

Service Configuration |, Simulation

Designation |D3l:uhne Hihenkom Read
Position |
Write
Volume flow =
Store to file...
Vnom | 2000 m3h
Direction of rotafion 1= %] % cow Mode ¢ 010V ( 210V other
" cow
Reduce A
Angle of rotation |pmgmmmed ﬂ | 95-(30.959
Control type |0pen loop j Leakage Swilch off [
Control signal Y |DC 2-10V -]
Bus fail pesition |Cpse | CAV feature | Standard, 0.1V shut off |
Sensitivity |nnrrna| ﬂ
Synchronization at |Y=0% Power ON |No action j
Torque |1DD ﬂ % Gear release button |Synd1ronizatior1

Example of the "Configuration" tab (damper actuator)

The lower area with the basic settings can be displayed with the "More..." button
and hidden again with the "Less" button.

When you change a value in an input box, the box turns yellow:
Fdin
Drehwinke I 10 % [0.B1%]
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The status image on the right additionally shows whether all the displayed values

match those stored in the actuator:

v
1

v

Status Display matches Display matches | Values have been Values have been
actuator actuator changed changed
Lackbit intact Lackbit broken / | Lackbit intact Lackbit broken /
not supported not supported
Image

X
#

X

Status image
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Save the changed values in the actuator with the "Set" button underneath the
status image.

You can read out the parameters currently saved in the actuator again with the
"Read" button. Entries for values that you have not previously saved in the
actuator will be lost as a result.

3.7.1 Saving a parameter file

You can store the displayed parameters in a file (with the extension .bptpar) with
"Store to file..." on the "Configuration” tab. The suggested name for the file
consists of the project, the actuator type, the position, the serial number, the
current date and the time of day.

Since the content of the file corresponds to the values displayed on the screen,
you can change individual values and save variants in files without loading them
on the actuator.

The file can only be saved when all values on the screen are valid.

3.7.2 Loading a parameter file

The values of a saved parameter file can be read back into the input screen for
the configuration with "Load from file...".

3.7.3 Copying parameters

Read out the parameters of an actuator that you want to copy and save them in a
file. Change the actuator, load the saved parameters from the file and program
the actuator with the copied values.

3.7.4 Load factory settings

When a project is created, two folders are created in the parameter directory.
These folders contain the factory settings for all supported actuator types.

|_;lpa|ameterfiles j = £ E-

| factory settings air
| factory settings water
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| |5 factary settings water
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~| & Bk E-

] AV24LON. bptpar
] AV24LON-R. bptpar

~] GR24AMF-5.bptpar

~] GR24AMP-5.bptpar
&

) — |optpar

— Typ: Belimo PC-Tool ¥3.0 Resource File
AV Geandert am: 29.09,2006 13:10 pptpar
| AV Grafe: 1.17 KB bptpar

| AV TFFFTIR-CI05. bptoar
] AY24-MFT.bptpar

] AV24-MFT-R.bptpar

] AVY24-MFT bptpar

] AVY 24-MFT-C 105, bptpar
] AVY24-MFT-R.bptpar

-~ AVY24-MFT-R-C105.bptpar
] GM24A-MF. bptpar

] GR24ALON-5.bptpar

] GR24ALON-7.bptpar

<

= LROZ3ATF . bptpar

'~ NRU24A-MF bptpar

] My24LON. bptpar

| MY 24-MFT 2.bptpar

] Ny 24-MFT biptpar

] NV24-MFT-C 103.bptpar
] NV 244MFT-T.bptpar

| NVF24LON. bptpar

| NVF24LON-E.bptpar

| NVF24-MFT 2.bptpar

] NVF 244MFT2-E. bptpar
] NVF 24-4MFT bptpar

=] NVF 24-MFT-E. bptpar
=] NVF 24-4MFT-E-T bptpar
| NVF 24-MFT-T. bptpar
| NVG24LON.bptpar

| NVG24-MFT 2. bptpar
[~ NVG24-MFT  bptpar

=] NVG24-MFT-T.bptpar
] NVY 24-4MFT bptpar

] NVY 244MFT-C 105.bptp
=~ NVY 24-MFT-R.bptpar
| VY 24-MFT-T. bptpar
| SR24ALON.bptpar

-~ SR24A-MF-5.bptpar
»

Dateiname: |

Dateityp:

|Eelim|:| Parameterdatei {~ bptpar)

Parameter files with factory settings

ﬂ Offnen |
ﬂ Ahbrechen

Open the file which matches the actuator type. The settings are loaded into the

input screen for the configuration. Afterwards, store the parameters in the

actuator with the "Set" button.
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3.8 Parameterizing limited lots

Ed

Variant

You can parameterize several identical actuators with the function "Parameterize
Limited Lots". The number depends on the power of the voltage supply.

To parameterize limited lots, save the parameter set to be programmed in a file.

With one parameter set, you can only program actuators from the same actuator
family (e.g. MFT or NMV), i.e. the parameter set used must match the actuator

family.

Connect the devices according to the following wiring diagram (for further wiring
diagrams, see clause 4.4 Typical wiring diagrams):

. BELIMO
Belimo E g
PC-Tool - g oo Z Speisung
O e a Power Supply
- AC/DC 24V
f ZP-USBMP e
— usB GND 24V
ZK2-GEN white/weiss = GND
blue/blau = 24V
green/griin = MP
" "Qﬁ""QD:jﬁ"
MP
PY Y Py Py
....A-MP ....A-MP ....A-MP ....A-MP ....A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
MFT) || .vFTE) || MFTE) || MFT@) || - MFTE) || .MFT(2)

Select the desired MP-Channel and click the symbol "Parameterize Limited Lots".

Click with the right mouse button on the MP-Channel and select Parameterize
Limited Lots. Or select the MP-Channel » Parameterize Limited Lots in the main

menu.
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Parameterize Limited Lots

Parameter file: II:Il:l44S-EDDEE-UEE-UEEI_EDUEDEE'I_'I 340.bptpar j
Sernes Number | State

004439-20025-062-059

00329-10026-062-076

Inzert zenesz number of devices manually or by actuate manual Button, L/R switch or 52 button.

¥ Frint Label FParameterize I Cloze

Dialog for parameterizing limited lots

Select the file with the saved parameters in the dialog.

Position the cursor in the first input box for the serial number. Then press the
acknowledge button on the first actuator which should be parameterized. If the
buttons are not accessible, directly enter the serial numbers as described below.

The serial number of the actuator is read out after the acknowledgement and
written into the input box. The cursor jumps to the next line.

Repeat the process for all actuators that are to be parameterized and mark the
checkbox if you want to print labels after parameterization
(see Section 3.9 "Printing labels").

Click Parameterize.
The PC-Tool now asks for the file with the values to be written into the actuators.

The periodic bus scan is stopped for the duration of the parameterization. The
actuators are successively set to the address MP1, programmed and finally set to
PP addressing.

When the bus scan is set to MP/PP, the actuators in the outline bar [C] will not be
visible. If the bus setting PP Only is used, a bus jam will result.

If an error occurs during programming, a corresponding text is displayed in the
"State" column.
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If the address MP1 is already assigned to an actuator, a message will be
displayed:

Belimo PC-Tool: Parameterize limited lo 5[

@ Address MP1 is nok free, de-address other devicels) Firsk?

Cancel |

Message when the address MPL1 is already assigned (limited lot)

Click OK to initially release the address MP1. The actuator that used to be
assigned to this address will be set to PP.

Click Cancel to stop the parameterization at this point.

Identification with known serial numbers

You can also fill in the input boxes manually before you click "Parameterize", for
example when the buttons of the actuator are not accessible or you regularly take
the serial numbers from your documents.

Programming further series

The actuators that have been successfully programmed are deleted from the list.
You can register further serial numbers in the list and then click "Start
parameterization" again.
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3.9 Printing labels

To identify actuators, you can write self-adhesive labels with the PC-Tool
program. A special printer may be necessary, depending on the type of label.
3.9.1 Setting up a configuration file

Labels are defined per project. To print labels, set place holders (number in
brackets) in the configuration file for the information to be printed.

The structure and storage location of the configuration files are described in the
Appendix.

3.9.2 Printing labels
|EI Select an actuator and click the "Print Label" icon (with an orange background).

Variant  Click an actuator in the outline bar [C] with the right mouse button and select
"Label Printing".

E Label Printing PS__(|
Printer selection |‘\‘xL| RANOS Mirwana
Label configuration file [Avery 5162 bptls ~|

Label print oder: a) left to right b) top
to bottom.

L&)

LR

Mumber of labels per actustor 1 3:

Mext printable label on shest 13:

OO

Tagging string (41) |Number #

Start number 1E|: (To number the actuators in serial order, place the &
charactor into the tagging string).

Lable string (42) |F|.:..;.r I
Lable string (43) |
Lable string (44) |

Feset Form | Print Preview | Print | Cancel

Label printing dialog
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Select a printer and a configuration file.

Enter the number of identical labels that are to be printed for "Number of labels
per actuator”". When parameterizing limited lots, the total number of printed labels
is equal to this value times the number of actuators.

Enter the desired texts {41} — {44} that are to be printed, if necessary. A
maximum of 50 characters are available per text box. In text with consecutive
numbering, a number is entered instead of the place holder "#". This number is
increased by one for each new actuator.

If labels have already been used from a label sheet, you can specify at what label
position the printing should start (for example 4 when 3 labels have been used
from the first row).

Your entries and the selected printer are preserved from one label printing
process to the next (automatic saving). You can empty the input boxes with
Reset Form.

The texts {41} — {44} must be present in the label configuration file in the form of
place holders. Otherwise, they will not be printed out.

3.9.3 Printing labels offline

il

Variant

Labels can still be printed even if no actuator is connected. In this case, only the
information from the project data, the texts entered in the dialog and the current
date can be output. The start number is always used instead of the place

holder #.

Click the "Print label" icon (with gray background).
Click the project in the outline bar [C] with the right mouse button and select
"Label Printing". Or select Project » Print Label in the main menu.

For Number of labels per actuator, enter the number of identical labels to be
printed. The number with the placeholder "#" is NOT counted up. The further
procedure is the same for printing actuator labels.

3.10 Transformation tables

Transformation tables are for converting the sensor value into another physical
quantity, for example from resistance (in ohms) to temperature (in °C) for NTC
resistors. Several frequently used transformation tables are supplied with the
program.

Selecting a transformation table

Select a transformation table with the combobox. The corresponding converted
value is displayed underneath the sensor value.

The measured sensor variable in the table must match the selected sensor type:
volts for active sensors, ohms for sensor resistors, on/off for switches.
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L2

Variant

Adapting a transformation table
Click the transformation table icon.

Click the project in the outline bar [C] with the right mouse button and select
Transformation table. Or select Project » Transformation table in the main menu.

P N
#r Fdit Transformation table - [ = |5} HEJ
M| > Ni_1000_DIN bpttt -
From To Description:
Ohm  ~|[C  ~| |Ni-1000 Ohm to * C (DIN)
Ohm “Cp -] ;
» 743 -50 150 - 0{)
791 -40 : 00
842 -30 100 &
893 -20 ] o®
946 -10 _ o
1000 0 (S —— PR
o
1056 10 ] &
112 20 . {}65}
1141 25 0 - 00
1171 00 1 &
1230 40 1 &®
1291 50 S0 @
1353 50 T T
1417 70 L= n ] 1200 1500 1800 N
1483 80 o
R - J Close i

Dialog for editing transformation tables

Select an available transformation table using the combobox.

The sensor values and the converted values are displayed in the table on the left.
On the right, you see a corresponding diagram with the sensor values on the
horizontal axis and the converted values on the vertical axis. The table values are
linearly interpolated; in other words, the points are connected by straight lines to
calculate intermediate values.

During conversion, the first and last connection lines are extended beyond the
range of entered points (extrapolated) so that even sensor values outside of this
range are valid.

You can adapt each value in the table or add new value pairs in the last line,
which is marked with an asterisk (*). Newly added value pairs are automatically
sorted into the right place.

The following holds true for switches: Off = 0, On = 1.

Save the changes to the transformation table by clicking on the floppy disk icon.

32 /55



V. 4
PC-Tool V3.16 General part, user manual BEL'MO

When you change a transformation table in one project, the changes do not
affect corresponding tables in other projects. However, you can return to the
original project folder from all projects through the entry <Other...> in the
combobox and open the changed table.

Setting up a new transformation table

When the dialog for editing a transformation table is open, you can create a new

table with the "New" icon. Select the physical quantities for the sensor values and
the converted values in the comboboxes above the table. You can also write any
other quantities into the text boxes of the comboboxes.

For the sensor values, only volts, ohms and on/off are meaningful input
gquantities, because only these sensor types are supported.

Enter a description in the text box and add new value pairs in the last line of each
table, which is marked with an asterisk (*). A transformation table must have at
least two lines.

For switches, you can define an on/off inversion table with the assignments
0->1and1->0.

Save the new transformation table by clicking on the floppy disk icon. The name
that you enter in the "Save file as" dialog will be subsequently offered as a
selection in the combobox.

If the name of the new table does not appear in the combobox on the
"Simulation" tab, open the project again.

The new transformation table is not directly available as a selection in the
combobox in other projects. However, you can return to the original project folder
from all projects through the entry <Other...> in the combobox and open the new
table.

Deleting a transformation table

When the dialog for editing a transformation table is open, you can use the
Delete icon to delete a table that has been selected in the combobox.

If the name of the deleted table still appears on the "Simulation" tab in the
combobox, open the project again.
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3.11 Displaying recorded trend data

=]

Click the symbol Trend display.

Variant  Click the project in the outline bar [C] with the right mouse button and select
"Trend Recall". Or select Project » Trend Recall in the main menu.
#+ Trend Recall — o e S
E XS '|NMV—D3~MP_LONGUS D_01111-40074-158-159_20130627_182943_trend bpttnd ﬂ
Test PC-Tool V3.8_max, NMV-D3-MP, LONGUS D
£ 00 +
(38 ]
E
400 -
_|"'"'---~-~l o "'l...
zo0 4=l - I . T oy
Sollwert ¥ h...{ L,'_ L-.r l ! i L [_ l—l‘_, LJ_”' j"!- L_I_L.. [—
oot J e Bl ; be o
05 >]
120
=
I
60 —
- _MW
D -
= T T T T T T T T T T T T )l
15:29:49 18:31:29 183309 18:34:49 15:36:29 15:35:09 15:39:49 15141129 15:43:09 15:44:49 15:46:29 15:45:09 15:49:45
— Sollwert [m3fh] Max Einstellung [m3ih] Min Einstellung [m3fh] Yolumenstram [m3fh]  —— Klappenstellung [%:]
—&p[%]

Values to show Sollwert [m3/h] Volumenstrom [m3/h] [ Sollwertin Volt [V]

Max Einstellung [m3/h] [+] Klappenstellung [22] [ Vist NonLin [Pa]

Comments Min Einstellung [m3/h] [ Istwertin Valt [V] Ap []
SN Gerat 01111-40074-158-155 - ZOOIT‘IE Mouse wheel
Startzeit Donnerstag, 27. Juni 2013 18:25:45 M‘We-_ Scrall bar
Reset: Double click
Vnom 555mih a
Vmin 0m3h - oEe
Trend recall

=

Variant

Select a trend file with the combobox.

To zoom in use the mouse wheel. Pull the diagram to the left or right with the
mouse in order to display values for other times.

You can use the copy button to insert the diagram into other documents via the
clipboard.

Use the save button to fix the window size of the trend display.

Printing a trend

Click the Print icon or press the key combination CTRL-P.

In addition to the Print button, you can open a menu with the "down" key. In

addition to printing, this allows you to display a preview or select several files for
printing with "Print multiple”.
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With “Print multiple (without comments)“ the comments will only be showed in the
comment list, not inside the trend graphic.

Graphs

On the bottom of the trend window different curves can enabled and disabled.
The selected curve is drawn directly into a new or existing coordinate system
(depends on the necessary units).PC-Tool options

35 /55



V. 4
PC-Tool V3.16 General part, user manual BEL.MO

3.12 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options...

«r PC-Tool Options ﬁ
General Project base path

Release Codes

MP channel corfiguration |C:"'-.Users"-.M‘.".l'S.INGTES"-.Dncumerrts"-.BeIimo"-.PCTnnl
VAV Compact Manufacturer [~ |2z default

Air module

Water Globe module Language

VAV NMV-DIM module |En lish j The new language setting becomes active after a program

VAW module g restart

VAV VRP-M module Log fi ’

Fire & Smoke module og e

EPIV module @ Filepermonth  { File perweek

MP-Maonitor

[ Enable MP-Monitor
SimulationsTrend

I¥ Ask user if trendfiles should be saved.
[ Enable sensor reading functionality

Program update

Check for newer version

0K | Cancel
—— T ————

Dialog for basic settings (general)

"Project base path" sets the default directory in the file system, in which the new
project folder will be saved. You can override this information when creating new
projects, however.

When you mark the "Use default”", checkbox, new projects will be saved in your
user profile under "My Documents". With the operating system Microsoft
Windows XP (English), this folder is located under

C:¥Documents and Settings¥<Name>¥My Documents.
You can open the folder "My Documents" with the "My Computer" icon.

The language that you select in the combobox will be used the next time that you
start the program.

Under "Log file", you can define whether a separate log file should be created
each month or each week.

Mark the "Activate MP-Monitor" checkbox to monitor the communication with the
actuators with the diagnostic tool.

To check manually for a new program version there is an update function
available. The program compares the current version with the Belimo update
server. On each program start, if there is an internet connection available, the
current version will be checked automatically.

In addition to "General”, the names of the supported modules (actuator families)
are displayed on the left side. Further information on the module-specific settings
is found in the corresponding sections of this manual.
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3.13 Log file

Variants

All activities with the PC-Tool software that influence the data stored in the
actuator are recorded in a separate log file for every project. The time of each
action is logged.

Configuring the log file

You can create a separate log file for each week or month of a project (default:
File per month). To change this setting, select ToolsPPC-Tool options in the main
menu. You can select either ‘File per week' or ‘File per month' under ‘General'.

Reading the log file

Click the "Read log file" icon in the toolbar.

Click the project icon in the outline bar [C] with the right mouse button and select
Read log file. Or select Project PRead log file in the main menu.

Using the combo box ‘Log file', you determine the file to read. The contents of the
log file are displayed in a table in the top section (each action starts a new row).

By clicking a column title, you can sort the table according to the selected
column. By clicking again on the same column title, the sorting direction is
reversed: increasing (A-Z) or decreasing (Z-A).

Details
Click a table row to display details of this action in the bottom section.

You can print the text in the detail area ("Print..." button) or copy it to the
clipboard ("Copy" button) and then paste it into another document.
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Read logfile

Logfile |M-2006-02 bptlag -

Logevents:

Date Time Ewvent Pozition string Type Sernes no. PAP-Ag -
0202 2006 09.42:31 Read all parameter  F-10001 LF24-+FT2 00404-100597-080-03 PP
0202 2006 09.42: 31 Wwirite all parameter  P-10001 LF24-+FT2 00404-100597-080-03 PP
0202 200611.27:08  Read all parameter  P-10001 LF24-FT2 00404-100597-080-03 PP
02022006 11.31:20  Read all parameter MNbdw-Di2-bdP 00B03-30024-146-13  MP4
0202200614 4216 Read all parameter MNiW-D2-MP 00B03-30024-146-13  MP4 2
02022006 14.43:09 Read all parameter by pozition Sk2448-MP 00534-00026-14212 PP
02022006 16.05:21 Read all parameter My pozition Sh248-MP 00534-00026-14212 PP
02022006 16.05:31 Read all parameter  kMy pozition Sh244-b P 00534-00026-14212 PP
02022006 16.09:04  Read all parameter My position Skl 240w P Q0534-00026-14212 PP
0202 2006 16.05:10 Fead all parameter by pozition Sk 2448-MP 00534-00026-14212 PP
M2 072 2NNR 1R 3R-10 Fead all narameber AF2Al MM nna13-1nm 9-n=a-nq MF'LIj
4 3
K.ey W alue ~
Date/Time 02022006 14,4216

Event Fead all parameter

Position string

Type Wi -D2-MP

Sefies no. 00B03-30024-146-139

MP-Adresze MPa

Project name testprop_tmp

SM 00B03-30024-146-139

Type M -D2-bP

Dezignation

Fozition

Address MP4

Contral type A

Calibration walue 2628

Yaolumetric flow setting W'nom: 3303 m3/h, Wmid: 1652 m3dh

Wrnir: O rm3dh, W maw 3303 m3dh

Cay feature Standard

Control function ' DC 210

Semaitivito rinrrnAl b’
< >

Copy Frint... Cloze
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4 Attachment

4.1 Storage locations of files

4.1.1 Project data

The default project is stored as a "Default project” sub-directory in the installation
directory of the program.

The projects are user-specific and are stored as a sub-directory in the user
profile. For an English-language version of Windows, this is

C:¥Documents and Settings¥<Name>¥My Documents¥Bel imo¥PCTool

This directory contains sub-directories with the project names.

4.1.2 Configuration files

The user-specific settings are stored in the user profile under "Application data".
For an English-language version of Windows, this is

C:¥Documents and Settings¥<Name>¥Application Data¥Bel imo¥PCTool

This directory can be "hidden" under Windows. If it is not present, the settings will
be queried upon starting.
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4.2 Configuration files for printing labels

4.2.1 Storage location

The filenames have the extension *. bpt |b. They are saved in the "label

definition’

" directory for each project. For an English-language version of

Windows, this is

C:\Documents and Settings\<Name>\My Documents\Belimo\PCTool\ <Project>\label definition

4.2.2 Format

The configuration files for label printing are stored in XML format. You can edit
these files with an editor program, for example "Notepad".

Configuration files for common Avery and Zweckform labels are supplied with the

program.

Example of a configuration file

<?xml version="1.0" encoding="utf-8"?>

<LabelDefinition xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<PageSize Height="278" Width="214" />
<PageBorder Top="18" Left="5" />
<LabelSize Height="33" Width="100" />
<LabelBorder Top="5" Left="5" />

<LabellLogo Path="Logo.bmp" Top="0.5" Left="2" Height="15.8" Width="41"/>

<Lines>
<Line Text="" />
<Line Text="{0} / {1}1" />
<Line Text="{20}" /> <Line Text="{21}" />
<Line Text="{23}" />
<Line Text="{41} / {42}" />

</Lines>

</LabelDefinition>
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You can adapt the values for the page layout (values in millimeters) for new label

formats.

PageSize Page size (height and width)

PageBorder Border width (top and left) = distance from the top left corner of
the first label to the page border

LabelSize Size of an individual label

LabelBorder

Label border width (top and left) = distance of the lettering from
the label border

LabelLogo

It is possible to print a Logo (picture) on the label.

Path: Here the path relative or absolute is entered for the Logo
File: (Logo.bmp) or (C:\pictures\Logo.bmp)

Position (upper and left) = Positon of the bitmap relative to the
upper left corner of the label (border not included)

The bitmap will be printed over the <Lines>. Therefore optionally
some blank lines must be inserted.

In every line element <Line>, you can insert place holders where certain project
and actuator characteristics will be added during printing.
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{0} Company name (from project data)
{1} Project name

{10} Actuator type

{11} OEM designation

{12} Position

{13} Serial number

{14} MP address

{20} Control type Y

{21} Feedback signal U5

{22} Range of rotation min — mid — max
{23} Running time

{24} Direction of rotation (cw /ccw)
{25} Bus fail position

{26} Sensitivity

{27} Synchronization at

{28} Torque

{29} Nominal range

{30} Conductance

{31} Vhom

{32} Vmax

{34} Vmin

{36} Control fct.

{37} Mode

{39} Feedbackparameter U5 (Damper Position / Volumetric flow / Ap)
{40} Printing date

{41} Text with consecutive numbering
{42} Freely definable text 1

{43} Freely definable text 2

{44} Freely definable text 3

{50} Switching point S1 in degrees (°)
{51} Switching point S2 in degrees (°)
{52} Setting damper free running test
{63} Valve Size (EPIV-Modul)

{54} Power Fail Delay (Super Cap)
{55} Power Fail Position / Power off Position (Super Cap)
{56} Ap@Vnom (VAV-Compact D3)
{57} Boxtype Comment

{58} Boxtype Comment1

{59} Boxtype Comment2

{60} Boxtype Comment3

{61} Range of rotation min

{62} Range of rotation mid

{63} Range of rotation max
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{64} Altitude of plant
{65} Altitude of calibration
{66} Nominal pressure

You can define up to 50 lines. The program does not check whether the lines fit
on a label.

When you define a new configuration file in a project, this configuration will not be
directly available in other projects. However, you can return to the original project
folder from all projects by using the entry <Other...> in the combobox, and then
use the file.

4.2.4 Example of a label

The following example results in a label having the dimensions width x height =
50 mm x 20 mm. The example is intended for an endless label printer that prints
labels of the size 50 mm x 20 mm.

The company name, the project name, the actuator type, the type of control
signal and the running time are printed on the label.

This data yields the following configuration file and the subsequently displayed
label:

<?xml version="1.0" encoding="utf-8"?>
<LabelDefinition
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<PageSize Height="20" Width="50" />
<PageBorder Top="0" Left="0" />
<LabelSize Height="20" Width="50" />
<LabelBorder Top="5" Left="5" />
<Lines>
<Line Text="{0}" />
<Line Text="{1}" />
<Line Text="Type: {10}"/>
<Line Text="{20} Running time: {23}"/>
</Lines>
</LabelDefinition>

Label: (0}

/

Belimo Automation AG {1}
Sample

Type: LM24A-Mp 4 {10}
Y: Open/Close Running time: 40s

\ T

{20} {23}
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4.2.5 Example of a label with Logo

The following example results in a label having the dimensions width x height =
65 mm x 45 mm. The example is intended for an endless label printer that prints
labels of the size 65 mm x 45 mm. In the sample the "Belimo" logo has been
inserted.

<?xml version="1.0" encoding="utf-8"?>
<LabelDefinition
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<PageSize Height="278" Width="214" />
<PageBorder Top="10" Left="5" />
<LabelSize Height="45" Width="65" />
<LabelBorder Top="5" Left="3" />
<LabellLogo Path ="Belimo Logo 5 rgb.bmp" Top="0.5"
Left="2" Height="15.8" Width="41"/>
<Lines>
<Line Text=""/>
<Line Text=""/>
<Line Text=""/>
<Line Text=""/>
<Line Text="{0}" />
<Line Text="{1}" />
<Line Text="{11}" />

<Line Text="V'nom:{31,10} ; ({30})"™ />
<Line Text="Ap@V'nom:{56}" />
<Line Text="V'max:{32,10} ; V'min:{34,10}" />

<Line Text="Datum:{40,10:dd/MM/yyyy}" />
<Line Text="{10}" />
<Line Text="{12}" />
<Line Text="Mode:{37}" />
<Line Text="{41}" />
</Lines>
</LabelDefinition>

The yellow highlighted text line shows, how a bitmap as logo can be inserted. One
have to enter the path and file name of the bitmap (logo), the origin of the bitmap
upper left and the size of the logo (height, width).

In this way several logos can be inserted in the label.
Label:

yV / 4
BELIMO

Eelimo
Test PC-Tool V3.9

V'nom: &00 m2/h ; (400 Pa)
ApE&Y " nom: 400 Pa

V'max: 600 m2/h ; V'min: 0 m2/h
Datum: 29.08. 2013

LMV-DIN-MPF LTG

Mode:DC O-10 V
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4.3 Troubleshooting and error messages

4.3.1 General

Problem After the program starts, an MP-Channel is not opened but displayed with the

MP-Channel icon.

Solution The MP-Channel cannot be opened, for example because the selected serial
interface is assigned to another application. Check whether a modem or a
communication program is using this interface.

4.3.2 Error messages

Error message

Description

Start adaptation failed.

Communication failure on the MP-Channel or faulty actuator.

Actuator locked for PC-Tool.

The drive has been configured so that it can be neither read
out nor programmed with the PC-Tool.

Summary: Actuator not reachable

Communication failure on the MP-Channel or faulty actuator.

Summary: Actuator run into timeout.

The drive did not respond within the specified time.

Answer has too much data.

Conflict between the actuator and program. The program
library (belipp.dil) may not be up-to-date.

Answer doesn't have enough data.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Command has not enough parameters.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Command parameters out of range.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Belimo library error code = ....

Internal fault.

Description is missing

A transformation table must have a description.

Bus Jam

Two or more devices respond to the same address. Re-
address the actuators.

This field is required!

This field must have an entry. It is not allowed to remain empty.

There is already an instance running!

The program cannot be started on a computer where it is
already running.

Error while creating the project!

Check whether it is possible to write to the storage location of
the project.

Error while copying default project.

When a new project is created, configuration files and sub-
directories are normally copied from the default project in the
installation directory of PC-Tool. The default project has
probably been accidentally deleted, moved or renamed.

Default project directory '..." does not
exist! Please reinstall the application.

When a new project is created, configuration files and sub-
directories are normally copied from the default project in the
installation directory of PC-Tool. The default project has
probably been accidentally deleted, moved or renamed.
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Error message

Description

Command ... unknown by the device

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

The value must be between ... and ....

The entry is not in the permitted range of values.

Invalid data answer from the device.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

The difference is smaller than ....

A rule for the minimum difference between two values has
been violated.

The length of the string must not
exceed ... characters.

Shorten your entry.

MP-command ... unknown by
PP_Function

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

A transformation table must have at
least 2 points.

A transformation table must have at least 2 lines to be able to
calculate intermediate values.

Not all parameters written to device

(Note the detailed instructions with the message regarding the
reason for the error.)

Label print failed.

(Note the detailed instructions with the message regarding the
reason for the error.)

Wrong device family ... instead of ...

When setting the parameters of small batches, an actuator
from another actuator family was connected and does not
match the parameter file.

Wrong transformation table for this
sensor type. It cannot transform from
unit ...

The transformation table does not have the measuring quantity
of the sensor in the first column. Resistance sensors must
convert 'ohm' into the target parameter, for example.

Wrong device connected!

This fault occurs when actuators are changed during
parameterization. Read the parameters out again.

Wrong MP channel: "...".

The MP-Channel has changed.

Error starting testscript

The test script is invalid.

Label printing error

(Note the detailed instructions with the message regarding the
reason for the error.)

Error loading transformation table

(Note the detailed instructions with the message regarding the
reason for the error.)

Error while loading project file: ...

(Note the detailed instructions with the message regarding the
reason for the error.)

Error reading parameter file

(Note the detailed instructions with the message regarding the
reason for the error.)

Error opening Channel ....

(Note the detailed instructions with the message regarding the
reason for the error.)

Error opening file explorer

File Explorer could not be started when displaying MP-Monitor
files.

Error opening MP-Monitor

(Note the detailed instructions with the message regarding the
reason for the error.)
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Error message

Description

Error while saving test report!

(Note the detailed instructions with the message regarding the
reason for the error.)

Error while processing line ... of the
trend file ...

The trend file could not be interpreted. It was probably written
manually.

Error: Invalid code for the module
release.

Relates to the entry of the activation code. Please check your
entry. All boxes must be filled-out according to the
requirements.

Error: There is another device on MP1

Address conflict.

Error: Unable to change address to
MP1

Address conflict.

Error: no answer from actuator

Communication failure on the MP-Channel or faulty actuator.

Address ... already set to this device!

Re-addressing re-assigns an already existing address.

Module release code expired!

Please contact your representative for a replacement of the
code.

Character '..." is not allowed (not ISO-
8859-1)!

Only characters from the Western European character set are
permitted for Description and Position of an actuator (see table
in Section 4.3.3).

No answer (possible bus jam).

Communication problem on the MP-Channel or faulty actuator.

No answer from device.

Communication failure on the MP-Channel or faulty actuator.

No label configuration file chosen.

Please choose a valid label configuration file and print a test
label or uncheck print label after write.

No or empty setup string.

"Other" was selected when setting the communication
parameters, but no connection was specified.

Could not deaddress other device

Address problem. (Note the detailed instructions with the
message regarding the reason for the error.)

Couldn't write to the device!

Communication failure on the MP-Channel or faulty actuator.

Could not find the VRP-M Tool
executable. Would you search for it
now?

Concerns VRP-M controller. The corresponding program could
not be found at the location specified in the PC-Tool options.

Configure the path in the options (menu Tools/PC-Tool options
in VRP-M).

Could not find PC-Tool V2.1. Would
you search for it now?

Affects VAV actuators. The old version of the program could
not be found at the location specified in the PC-Tool options.

Error while loading project.

(Note the detailed instructions with the message regarding the
reason for the error.)

MP-Command ... failed.

Conflict between actuator and program. The program library
(belipp.dll) may not be up-to-date. MP command could be
password-protected.

MP-Channel was closed

The MP-Channel was closed during an asynchronously
running function.

Not all data written to the device.

Communication problem during writing of the parameter data,
possibly due to bus jam. Check the connection and addressing
of the actuators. An MP command is password-protected or
the actuator is not familiar with the command.
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Error message

Description

Could not read all data from the device.

Communication problem while the parameter data was read,
possibly due to bus jam. Check the connection and addressing
of the actuators.

Not all fields have valid values! Can't
write data

One or more input values in the "Configuration” tab is not valid.
Look for a flashing exclamation mark. If you move the mouse
pointer to the exclamation mark, an explanatory text (tooltip)
with the valid range of values will usually appear.

OEM or BELIMO password necessary.
Please contact OEM-Manufacturer

Parameters on the actuator can be protected with a password
against changes. A password is necessary to overwrite them.

Parameter file contains no series
number

When setting the parameters of small batches, the actuator
family is checked by means of the serial number. The
parameter file is old or has been changed manually.

Error opening configuration file

(Note the detailed instructions with the message regarding the
reason for the error.)

Error storing configuration file

(Note the detailed instructions with the message regarding the
reason for the error.)

Plausibility check: Failed. Please check
the configuration dialog for further
information.

Testing is not started if there are errors in the configuration.

Problems opening the MP-Channel "...".

Error at the interface. Check the communication parameters
and the cabling.

Sending ... to ... returned error ...

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Wrong format of serial number

You have made a typing error while manually entering the
serial number. Check the notation of the serial number.

Series number has a wrong format!

You have made a typing error while manually entering the
serial number. Check the notation of the serial number.

Reset alarm messages failed

Communication failure on the MP-Channel or faulty actuator.

Synchronization failed

Communication failure on the MP-Channel or faulty actuator.

The test script cannot be started because
some conditions are not complied.

A certain minimum air flow or system pressure is necessary for
the test. Please check fan and VAV box.

Start test run failed

Communication failure on the MP-Channel or faulty actuator.

New address could not be verified

The serial number is read before and after an actuator is re-
addressed. These two numbers do not match. Another
actuator probably answers to the programmed address.

Unknown MP-Channel '...".

The MP-Channel could not be identified.

Invalid or corrupted parameter file "..."

The contents of the file could not be correctly interpreted. The
format may no longer be valid. If possible, read out the
parameters again and save them in a new file.

Invalid Series Number

The entered serial number was not found in any connected
actuator.

Invalid value entered

Refer to the notes about the valid range of values.

Invalid value!

Refer to the notes about the valid range of values.
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Error message

Description

Unspecific Belimo-Lib error

Internal fault.

Must be greater than zero.

Refer to the notes about the valid range of values.

Must be an integer.

Refer to the notes about the valid range of values.

Summary: Test cannot be executed
due to active forced control

Remove the Y connection with the control signal for the
duration of the test.

Two or more devices respond to the
same address.

Bus jam Re-address the actuators.
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Only characters from the ISO 8859-1/ANSI character set are permitted in the "Description" and "Position"

box

Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char
32 64 | @ 9 |° 128 | € 160 | 7 192 | A 224 | a
33 |! 65 |A 97 |a 129 | » 161 | i 193 | A 225 | &
34 |" 66 |B 98 |b 130 |,V 162 | ¢ 194 | A 226 | &
35 |# 67 |C 99 |c 131 | f 163 | £ 195 | A 227 | &
36 |$ 68 |D 100 | d 132 |, 2 164 | o 196 | A 228 | &
37 | % 69 |E 101 | e 133 | ... 165 | ¥ 197 | A 229 | &
38 |& 70 |F 102 | f 134 | t 166 | ! 198 | £ 230 | e
39 | 71 |G 103 | g 135 | t 167 | § 199 | C 231 (¢
40 | ( 72 |H 104 | h 136 |~ 168 | - 200 | E 232 | &
41 |) 73 |1 105 | i 137 | %o 169 | © 201 | E 233 | é
42 | * 74 | 106 | j 138 | S 170 | @ 202 | E 234 | é
43 | + 75 |K 107 | k 139 | « 171 | « 203 | E 235 | &
44 |, 76 | L 108 | | 140 | CE 172 | = 204 |1 236 | i
45 | - 77 |M 109 | m 141 |« 173 | -9 205 | | 237 | i
46 | . 78 |N 110 | n 142 | Z 174 | ® 206 |1 238 |1
47 |/ 79 | O 111 | o 143 | » 175 | 207 |1 239 | i
48 |0 80 [P 112 | p 144 | » 176 | ° 208 | B 240 | &
49 |1 81 |Q 113 | q 145 | © 9 177 | + 209 | N 241 | i
50 |2 82 |R 114 |r 146 | 'Y 178 | 2 210 | O 242 | o
51 |3 83 |S 115 | s 147 | "9 179 |3 211 | O 243 | 6
52 |4 84 |T 116 |t 148 | "9 180 |~ 212 | O 244 | 6
53 |5 85 |U 117 | u 149 | - 181 | 213 | O 245 | 6
54 |6 86 |V 118 | v 150 | — 182 | 1 214 | O 246 | 6
55 |7 87 |W 119 | w 151 | — 183 215 | x 247 | +
56 |8 88 | X 120 | x 152 |~ 184 | | 216 | @ 248 | g
57 |9 89 |Y 121 |y 153 | ™ 185 |t 217 | U 249 | U
58 |: 90 |z 122 | z 154 | § 186 | © 218 | U 250 |G
59 |; 91 |[ 123 | { 155 |» 187 | » 219 (U 251 | G
60 |< 92 |\ 124 || 156 | e 188 | Y4 220 | U 252 | i
61 |= 93 |] 125 |} 157 | » 189 | ¥ 221 | Y 253 |y
62 |> 94 |~ 126 | ~ 158 | z 190 | ¥ 222 | b 254 | p
63 |2 95 | 127 159 | Y 191 | ¢ 223 | R 255 |y

The character positions marked with « are vacant.

1)
2)
3)
4)
5)
6)
7
8)

Single speech mark, low
Double speech marks, low
Single left speech mark
Single right speech mark
Double left speech marks
Double right speech marks
Non-breaking space
Breaking hyphen
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No)

Cable MP level converters and devices Drawing Page
ZK1-GEN
; = ‘f/\/ ZIP-USB-MP | Typical wiring diagram 1 | 52
ZK2-GEN
_ — Typical wiring diagram 2 52
 \ ~> ZIP-USB-MP
Ax ' Typical wiring diagram 3 53
ZK6-GEN
w - 4 ZIP-USB-MP Typical wiring diagram 4 | 2>
ZKS-MP
" N .:\TI,',’ P _ _ . . .
;‘\;, ;'..%} = ZIP-USB-MP | Typical wiring diagram 5 | 54
ZK1-VAV
— Typical wiring diagram 6 54
D = ZIP-USB-MP
{A ‘ 7 Typical wiring diagram 7 55
Direct connection N J ZIP-RS232 | Typical wiring diagram 8 | 55

For further wiring examples with miscellaneous connection cables und level converters see
www.belimo.eu | Documentation | Bus- and System-Integration | "Tool connection guide"
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4.4.2 Typical wiring diagrams

Typical wiring diagram 1

e
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. BELIS RJ11 (6/4)
Belimo A g
PC-Tool 2 o "
E Q Initialized g
2 =
> — gy ————4
/ \ ZIP-USB-MP e ZK1-GEN GND
.A-MF N
...A-MP @ ©°° F
...D2-MP c ‘
...ALON ﬁ
...D2LON 7
Typical wiring diagram 2
1l ~ AC24V
— + DC24V
RJ11 (6/4)
. 4
) < SELINICE ZK2-GEN
Belimo n g
PC-Tool g Qtmen o MP —
@ O Initialized g‘
1\ g E GND
| )\ S ZIP-USB-MP Ce 30
[ ] white/weiss = GND DO

blue/blau = not connected/nicht angeschlossen

green/griin = MP ]l_ l

= >
--MFT(2) .LON L~ usmp
...A-MF ALON - F
...A-MP D2LON
...D2-MP
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Typical wiring diagram 3

MP-Master

DDC Controller

RJ11 (6/4) UK...Gateway
V4
. BELIMO
Belimo E g ZK2-GEN
PC-Tool g Ot @
[e] - § GND 24V MP
[\ y E E
/—\ ZIP-USB-MP <3 . j}—@—@
| ! UsB white/weiss = GND @@f
blue/blau = not connected/nicht angeschlossen
greenlgri]n=l\:IP t teng MP
®
®
....A-MP
...D2-MP
.MFT(2)
Typical wiring diagram 4
. BELINTG RJ11 (6/4
g O Enable %‘
8 o E ZK6-GEN
ZIP-USB-MP _ Cg|
RJ11 (6/4
[C[O[C]H[O]O[O] [el[el[e)[e][e][e][e][e)
BELIMO
Optimizer .
COU24-A-MP
lolojolojojolololo] [o]ololojolololo]o] [o]olololo]o]
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Typical wiring diagram 5

UK24LON/EIB BELIMO

o o|o| g oo

MFE

[:I?ﬁ@@@@

MP-Monitoring

Pos. ,MO*
LonTalk MP-Com. Power
a_b OV 24V Y U/MP 0V 24V n.c.
USB g @09 neg

= - BELIMO L
Belimo 5
PC'TOOI E O Enable
O 3 pol
e | r §
 \ ZPUSBMP e nCaay L

]

o

&
MPZ78Us

| USB
DC24V — +
ZKS-MP |
--------- _—
..A-MP
...D2-MP
..MFT(2)
Typical wiring diagram 6
. BELINTS RJ11 (6/4
Belimo E - "
PC-Tool g Qo @
E O Initialized E\l
y 8 =
@ N
/ \ ZIP-USB-MP Ce NMV-D2M BELIMO
ZK1-VAV
N B
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Typical wiring diagram 7
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1 Introduction

The "Air module" user manual describes the detail area [D] of the Air module.
The documentation is divided according to the three index tabs "Service",
"Configuration” and "Simulation”.
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the actuator.

Type LM24A-MP SN 00826-40170-142-130

Designation
Position

Service | Configuration | ©. Simulation

Actual setiings

Control function Y
Sensitivity

Nominal range
Running time
Angle of rotation

Direction of rotabion
Synchronization at

Torgue

Bus fail position
Power ON
Manual button jonce]

Actuator information
Firmware
Config table ID
Datalog
O perating ime
Active ime
Stop & Go ratio
Messages

Messages

DC 2-10V
normal

95" adapted

150s

Masc: 100%  [357]

Min: 0% [07]
W= é

cow 100%

Y=0%

100%

Last value
Mo action
Synchronization

01 %01.30-0003
(106D

Oh
Oh
0%

Mid.: 50%

Address MPG

Test

Adaption

Synchronization

[477]

Feset Messages

Service tab for full-rotation damper actuators

For linear actuators the stroke is displayed instead of the angle of rotation, and
the torque instead of the positioning force.

Mominal mnge 100 mm adapted
Running ime 150s
Stroke Max: 100%  [100mm] . Cres
Min: 0% [Omm] Mid.: B0%  [50mm]

:;D%‘ﬁl

Direction of siroke up
Synchronization at =03

Force 100%
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Service tab for linear actuators (excpert)
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Meaning of the settings

e
BELIMO

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

Feedback U5

Type of feedback signal

Range

Position range within the mechanical limits

Running time

related to operating range or a fixed angle/stroke of
95°/100mm (with annotation)

Angle of rotation

Programmed rotation range: Min / Mid / Max
(for full-rotation actuators)

Stroke

Programmed stroke range: Min / Mid / Max
(for linear actuators)

Direction of rotation

Clockwise/counterclockwise (for full-rotation
actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque (for full-rotation
actuators)

Actuating force

In percent of maximum positioning force (for linear
actuators)

Piggy back device

Status Piggy back active / inactive

Power fail-/Power off Pos.

Actuator position in case of power fail (exists only on
actuators with Electronic Fail Safe modules)

Power Fail Delay

Time delay until actuator drives to power fail
position. (exists only on actuators with Electronic
Fail Safe modules)

Power Fail Count

Number of power Fail counts (exists only on
actuators with Electronic Fail Safe modules)

Manual button [once]

Function when pressed once

Manual button [twice]

Function when pressed twice
(not present in "New Generation" actuators)

Function table

Assignment of override setting and override function

(only for certain actuators)

Firmware

Software version on the actuator

Config table ID

Identification of the configuration table

Operating time

Number of hours during which the actuator was
connected to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power

supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high
Stop & Go ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain

actuators.
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2.2 Adaptation

Variant

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

Click the "Adaptation" button on the Service tab.

You can also trigger the adaptation directly on the actuator. The necessary
buttons for this can be programmed. For example, "Manual button [twice]" can be
assigned the adaptation function.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop at the full angle of rotation.

Next, the absolute values for a programmed limited angle of rotation range
(minimum, mid-position, and maximum) as well as the feedback signal U5 are
recalculated and displayed.

The adaptation can be blocked in certain actuators.

2.3 Synchronization

Variant

In the case of synchronization, a mechanical limit is moved to in order to
determine the absolute range.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or at the full angle of rotation/stroke (100%).

Click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator. The necessary
buttons for this can be programmed. For example, "Manual button [once]" can be
assigned the synchronization function.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop at the full angle of rotation/stroke.

The synchronization can be blocked in certain actuators.
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2.4 Function test

The function test checks for opening and closing.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the angle of rotation (or stroke) is set to "adapted”,
movement takes place to the other stop; with "programmed"”, on the other hand,
to the programmed range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

r— Test progress: —Current pozition: —
pieg P Start Test
- Plauzablility test 41% 47
- Meszages deleted
- Actuator runz OPEM Test stater Abort Test
- Actuator runs CLOSE Eal state:
Testrunning
[Close Tiest

—Test repart;

B 8|

Display of test progress and test report

Click the "Start Test" button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the actuator,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current actuator settings.

If the test reports an invalid actuator configuration, go to the "Configuration” tab
after ending the test. The values that are not allowed are marked with a flashing
exclamation point.
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You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the "Close Test" button. The program asks whether you
want to save an unsaved test report now.

Save testreport? |
@ Wiould you like to save the kestreport?
Yes Mo |

If you cancel the test early, the actuator will be reset to its original state. No test
report will be created.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator,
change them and save them back to the actuator. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

Type LM24A-MP SN 00826-40170-142-130
Designaticn Address MP6
Position

Service Configuration |©, Simulation

Designation | Read
Position |
Wnite
Control signal Y |DC 210V |

Store to file___

Load from file. ..

Min Mid Max
Angle of rotation 0 % (0.68%) 50 % (D..100%) 100 % (32..100%)
’_ﬂ = 47 - g5 =
Runningtime | 150 5 (35 458s)
Reduce F Y
Angle of rotation |adapted - 595 -

Direction ofrotaion 1305 (7 1 -
Bus fail position |Last value |
Sensiivity m
Synchronization at ’m
Torgue ’m %

Power ON | Mo action -

Manual button fonce]: | Synchronization -

"Configuration” tab for full-rotation damper actuators

Note: Running time, range, direction of rotation and stroke cannot be
programmed on certain actuators and are therefore not displayed.
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For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

Min Mid [z
Stroke % (0.80%) | B0 3% (0..100%) 100 % (10..100%)
0 mm | 5 mm 1000 mim
Running time 150 s (B7.275s)
Reduce &
Stroke |adapte-:| j | 100 mm
. ) = " 0 up
Direction of stroke 1003 1t C down

"Configuration" tab for linear actuators (excerpt)

Synchronization at |Y=1DD‘I$

Torgue | 100 | %
Power ON |N|:| action L} j
Power Fail-/Power off Pos._ i

Power Fail Delay 10 s
Manual button joncel: |5'_.rru:hn:|nizati|:|n ﬂ

"Configuration" tab for Electronic Fail Safe (excerpt)

Actuator number?!

Description 16 characters of any text

Position 16 characters of any text

Control signal Y

3-point AC voltage, positions: Open / neutral / closed
Open / closed DC or AC voltage, 2-point
DC 0-10 V (DC voltage)
Fixed operating range DC 0-10 V
DC 2-10V (DC voltage)
modulating Fixed operating range DC 2-10 V

1 Only characters from the Western European character set are permitted for Description
and Position (see General part, table in Section 4.3.3).
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DC variable Start (Y=0%) 0.5 ... 30 V
Stop (Y=100%) 2.5 ... 32V
Range between start and stop at least 2 V
PWM 0.02-5 s Duration of the control pulse (pulse width modulation),

fixed operating range

PWM 0.1-25.5s

Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s

Duration of the control pulse, fixed operating range

PWM variable

Start (Y=0%) minimum 0.02 seconds
Stop (Y=100%) maximum 50 seconds

VAV 4 +/-6 V

When this function is selected, the actuator is
parameterized as a VAV actuator and can therefore be
controlled by the VAV controllers VR.. .

Note:

When VAV (6 + 4 V) is selected, the values for minimum,
maximum, intermediate value, running time and angle of
rotation/stroke are reset to the default values.

4-20 mA

(Direct current)
Fixed operating range DC 4-20 mA

Note:
This selection is only available for certain drives (e.g.
"SunYeh")

mA variable

(Direct current)
The values for start and stop are specified in the actuator
and cannot be changed with the PC-Tool.

Note:
This selection is only available for certain drives (e.g.
"SunYeh")

Feedback U5 (only active when the actuator address is set to PP)

Damper position,
2-10V

DC voltage measurement signal, fixed range

Damper position,
0.5-10V

DC voltage measurement signal, fixed range

Damper position,
variable

DC voltage measurement signal
Start 0.5...8.0V/Stop 2.5... 10.0 V
Range between start and stop at least 2 V

Damper position,
4-20 mA

Direct current measurement signal, fixed range

Certain actuators can define further feedbacks, which
you cannot change, however.

U5 scaling (only with "New Generation" actuator, MF or MP types)

Start Position in percent, corresponds to the start value of the
feedback signal

Stop Position in percent which corresponds to the stop value
of the feedback signal

Angle of rotation (for full-rotation actuators)
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Stroke (for linear actuators)

Min

Programmed lower limit of the range

Mid

Mid-position of range

Max

Programmed lower limit of the range

An existing value for Mid is automatically adapted when Min and Max are
entered: If you enter Min, Mid is always larger than or equal to this input value. If
you enter Max on the other hand, Mid is always less than or equal to this value.

Examples of settings for control signal Y / feedback U5

Control signal Y:

Feedback U5 :

3...8 V min: 30%, max : 70%
2...7 V start: 20%, stop: 90%

Position
A
Open 100%  —fmboobocbodecde b b oo e g
1 1 1 1 1 1 1 1 1 |
1 1 1 1
41" -T--T--r -
1 1 1 1
R L _ 1L 1 1.
T I I i
1 1 1 1
U IR SN PR R - -
1 1 1
1 1 1
—] A== = ——tm——k——p—--
1 1 1
500 Y o i AL
1 1 1 1 1 1 1
L DL/ o SRR S B S S
1 1 1 1 1 1 1 1
— 1 N N IR DU NV I S
i i 1 i I i I
1 1 1 1 1 1 |
—] | RN U Y N
1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 I
B i S A S A A
Closed 0% L _ Y/US
T 1 1 T 1 = [V]
0 5 10

Running time

In seconds

Time needed to pass through the range limited by Min and
Max (the valid range of values for the running time
depends on the actuator type and the passed-through
range).

Note: For actuators with the "constant speed” operating mode, the speed does
not depend on the range passed through. The running time refers to a fixed angle
of 95° for rotary actuators or a fixed stroke of 100 mm for linear actuators.
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Angle of rotation (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal
setting range of the actuator

Direction of rotation (for full-rotation actuators)

cw

Damper opening in the clockwise direction

ccw

Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)
down Downward-opening damper

Power Fail-/Power off Position (only with Electronic Fail Safe module)

in %

emergency Position at Power Fail (can only be changed
when poti is in "Tool" position)

Power Fail Delay (only with Electronic Fail Safe module)

in seconds

time delay until actuator drives to emergency position in
power fail case.

Behavior in the event of bus failure

Last setpoint Position according to control signal Y

Open Move to full angle of rotation/stroke (100 %)
Close Move to zero stop

Close quickly Close with maximum speed

Mid / V'mid Move to Mid position
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Sensitivity
Sensitivity Actuators without | Actuators with | Actuators of the
spring-return: spring return: new generation
NM24-MFT(2) | LF24-MFT(2) |2 linear:
AM24-MFT(2) AF24-MFT(2) |..MF
GM24-MFT(2) ..MP
..LON
Normal
— Response sensitivity: 1° angle of 1° angle of 1%
rotation rotation @ operating range
(SY = 2%)
— Reversal hysteresis 2.5° angle of 2.5° angle of 2.5%
rotation rotation @ operating range
(SY = 3%)
Reduced
— Response sensitivity: 2° angle of 2° angle of 2%
rotation rotation @ operating range
(SY = 5%)
— Reversal hysteresis 5° angle of 5° angle of 5%
rotation rotation @ operating range
(SY > 6%)
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Synchronization at

Y = 0% Moves to the mechanical limit at zero stop (depending on
the direction of rotation / stroke direction)

Y =100% Moves to the mechanical limit at full angle of rotation
(depending on direction of rotation / stroke direction)

Note: When the nominal setting range is set to "programmed”, then the
synchronization MUST be carried out at Y=0%.

Torque (for full-rotation actuators) / Positioning force (for linear actuators)

25% ... 100% Can be set in increments of 25%. 100% corresponds to the
maximum torque / the maximum positioning force for the
actuator type (see nameplate)

Power ON
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Nothing (This option is not available for actuators of the "TOP"

performance class. When switched on, they must always be
adapted or synchronized)

You can programmatically limit the rotation and stroke range at one end by only
changing the minimum or the maximum. If the value of Power ON is set to
"Nothing", then the following holds true:

The mechanical limit that can still be attained within a rotation range
limited at one end will be used for synchronization.

If you set the minimum to a value greater than 0%, the zero stop will no longer be
in the range. In this case, synchronization will take place at the end stop of the
full damper opening (Y = 100%). If, on the other hand, you set the maximum to a
value smaller than 100%, synchronization will take place at the zero stop (Y =
0%).

This is also valid for the case that the nominal setting range is set to
"programmed" and the minimum is equal to 0%: The setting "Power ON: Nothing"
is allowed.

Synchronization when the angle of rotation/stroke is limited at both ends

If the minimum is greater than 0% AND the maximum is smaller than 100%, then
you can select where the synchronization will take place. In this case, it is
necessary to perform synchronization or adaptation when you switch the device
on (the setting "Power ON: Nothing" is considered an error).

If the nominal setting range is set to "programmed" and the minimum is greater
than 0%, then the same rule applies: At least one synchronization must be
programmed.
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Manual button [once]/[twice]

Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at") when the manual button is pressed
once or twice respectively

Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters when the manual button is pressed
once or twice respectively

Note: For "New Generation" actuators (types MF, MP), the function
Manual button [twice] is not available.

Only in case of a SY- actuators: Function table for behavior when Y-control
signal is missing

Condition Y Reaction
No Y-signal: No fct Cable disc. None
Earthing (GND) | CLOSED
No Y-signal: OPEN Cable disc. OPEN
Earthing (GND) OPEN
No Y-signal: CLOSED | Cable disc. CLOSED
Earthing (GND) | CLOSED
No Y-signal: STOP Cable disc. STOP
Earthing (GND) STOP

Activate the "Show function table" checkbox in order to show the function table.
For addressed MP actuators only "No fct" is possible.
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4 Controller simulation

Go to the "Simulation" tab.

e
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Type LM24A-MP
Designation
Position

Address MP6

Service | Configuration & Simulation

Actuator Sensor
" Simulation off Setpoint  Actual position * None
c | 400z | 1M6% | 138° £ Active (0.3

~ ]
* Setpoint Tool 520y 317 v Passive (850...1.6kOhm)
" Motor stop Trendview (% " Passive (200...60kOhm)

j " Switch

Test » |Testle |<No testscript>

SN 00826-40170-142-130

Transformation
|<No table> J

Interval 10 Stop Record ] Comment... H |ast AG_LM24A-MP__D0826-40170-142-130_20130814_154020_trend bpttnd
Trend
Belimo Test AG, LM24A-MP,
120
=S
100
80
60 -
40 -
20 - -
Set point Toal
A
o - [ N
T T T T T T T T T T T T
15:40:20  15:40:22 15040024 1540026 15:40:258 1540030 15400352 1540034 15:40:36 0 15400358 15:40:40 1540042 15:40:44
|— Sk Point [%:] Actual angle [%:] IMax Position [%:] IMin Position [%]

Set Point [%:]
Actual angle [3%]
Max Position [%4]

Values to show Min Pasition [%a]

Comments

Simulation tab for damper actuators

The controller simulation is not possible while the actuator is performing an

adaptation or synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y
according to selected control type (DC, PWM, open/close, 3-point).
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Setpoint Tool (not available with control type open/close or 3-point): The setpoint
is entered in % of the programmed range. 0% is the minimum, 100% the
maximum. The input values are converted and displayed in the units of the
corresponding control signal (volts, milliamps or seconds).

The control is switched off when you click "Motor stop”. This function is not
available with the control types open/close and 3-point.
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Measurement values

During the simulation, the current angle of rotation or stroke is displayed in % of
the absolute (mechanically limited) range and — converted according to the scale
setting — as a feedback value in volts or milliamps.

4.2 Test

The test function is available for the structured testing of the Air actuator.

A number of commands which follow one another in sequence are defined in a
test script file. A trend record is triggered at the start of the function.

Select test file

At the moment there aren’t any predefined test scripts available. Custom test
scripts can be produced any time and be selected through the Combobox.

Select the desired script with the Combobox test file. Only test scripts for Air
modules are displayed in the Combobox.

Start test script

Click on the test » button. The tests will begin at once.
Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "Air".

4.3 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function,
however, must be activated in advance in the PC-Tool options under "General".
Select Tools » Options in the main menu.
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LI L = LR

#r PC-Tool Options

S|

Project base path

Release Codes

VAV Compact Manufacturer [~ e deat

[ Enable MP-Manitor
Simulation/Trend

¥ Ask user if trendfiles should be saved.
I Enable sensor reading functionality

Program update

Check for newer version

MP channel configuration |C\Users\MW S ING TES \Documents'\Belimo\PC Tool

Air module
Water Globe module Language
VAV NMV-DZM module |En lish j The new language setting becomes active after a program
WVAY module g restart
VAY VRP-M module Lo fi i
Fire & Smoke module e JullS
EPIV module {* File permonth 1 File per week
MP-Monitor

Ok | Cancel

|

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of

the actuator control.

—Sensor
" Mone Value
' Active [0___ 32V I 0o v
" Pagzive [850...1_6k0hm]
I 0.0 v :
¢ Passive [200...60kDhm) Tranzformation
= Switch I{Nu table> j

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).
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The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc.). (See the
"Transformation table" section in the General User Manual)

4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

=] On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat"
Trend Record e | button. The recording stops when you click again.

The Trend View radio buttons allow you to set whether the display is given in
Stop Record B percent of the full range (%) or in volts (V).

The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Interval 10 Trend Record - ‘ ‘ n |ast AG_LM24A-MP__DDB26-40170-142-130_20130814_154020_trend bpttnc
Trend

Belimo Test AG, LM24A-MP,
120 -

%

100

g0

60

0w — e

20

et point Tool |

—

&
0 | efmeneit

T
1S4020 154050 1540040 15:40:50 1541000 15:41:10  15:41:20 15:41:30 15:41:40 1541350 15:42:00 1542010

|— Sek Poink [%%] Actual angle [%:] Max Position [%] Min Position [<&]

Values to show Set Point [%%] Min Position [%]
Actual angle [2&]
Comments Max Position [%:]

Trend plot
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The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select Tools » Options in the main menu.

Variant  Click the right mouse button on the program icon in the outline bar and select
"Options".

= PC-Tool Options

General b ain wigw
Releaze Codes Detfault tab:
P ch | configurati -
channel configuration |Serwce ﬂ

“Wwater Globe module
WAl MbY-D 20 module
Wil Compact module
Wav VRP-M module
Fire & Smoke module
EPIM miodule

Cancel

Dialog for basic settings (Air module)
Select "Air module” on the left.

Using the combo box "Default tab", you can select the index tab you want to open
by default when starting the program PC-Tool.
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1 Introduction

The "Fire & Smoke module" user manual describes the detail area [D] of the fire
& smoke module. The documentation is structured according to the three tabs
"Service", "Configuration” and "Simulation".
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2 Service

2.1 Displaying settings

The "Service" tab gives an overview of the current actuator settings.

Position

Type BF24TL-T-ST SN 00514-40118-104-098 \/
Designation BF24TL-T-ST_01 Address PP E =
a.. EI

Service | Configuration| *. Simulation

Actual setings

Test
Nominal range 20° adapted
Running ime 140s
Adaption
Switch 51 Z° (10%)
Switch 52 13° (88%)
Minimal adaption range 10° (2%)

Damper free running test Deactivated

Actuator information

Firmware (x0027 (Dw04)
Config table ID (<0032

Data log
Operating ime £00h
Active time 43732h
Messages

Messages Excessive utilisation
Mechanical overload Reset Messages

"Service" tab for BF-TopLine fire damper actuators

No settings are displayed for motorization solutions with conventional fire damper
actuators and a BKN230-24-1MP gateway. Please refer to the actuator data
sheets for more information.

Meaning of the settings

Nominal range Range of rotation within the mechanical end stops
Running time Time needed to cover the full range of rotation
Switch S1 Switching point for the safety position (in ° and %)
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Switch S2 Switching point for the operating position (in ° and %)

Minimal adaption range Safety limit to prevent adaptations if dampers are
blocked (in ° and %)

Damper free running test Values for the automatic test in the operating posi-
tion (values for 180° types in parentheses)

Firmware Software version installed on the actuator

Config table ID Identifies the configuration table

Operating time Number of hours for which the actuator was con-
nected to the power supply

Active time Number of hours for which the actuator was me-
chanically in motion and connected to the power
supply

2.2 Damper free running test

2.3 Adaptation

The damper free running test checks the actuator's ability to turn from the operat-
ing position toward the safety position. Only the configured range is tested, to
prevent complete closure of the damper. The test is repeated after 24 hours.

The damper free running test is suitable for all applications in which the ventila-
tion system is not allowed to be switched off in order to carry out a full damper
test.

Click the "Damper free running test" button on the "Service" tab to start the test
manually.

The damper must be in the operating position and the damper free running test
must not be deactivated.

Adaptation is when the actuator determines the 0% ... 100% range by approach-
ing the mechanical end stops.

Click the "Adaption" button on the "Service" tab.

The progress of the adaptation is displayed in the status bar. The actuator starts
by moving into the safety position, then approaches the stop in the operating po-
sition. The maximum angle of rotation reached is stored in the actuator.

The absolute values for switching points S1 and S2 are then recalculated.

It is important to ensure that the damper blade reaches the mechanical end stops
during the adaptation (visual monitoring of the damper).
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2.4 Function test

Test progress:

- Plausibility test

- Messages deleted
- Actuator closes Abort Test
- Actuator opens

The function test checks the opening and closing of the actuator.

The actuator starts by moving into the safety position, then approaches the oper-
ating position.

Click the "Test" button on the "Service" tab. The standard display is hidden by the
test window.

Current position:

2247 217

Test state:
Testrunning

Test report:
==
A
Belimo Testreport
Project: Standard
Conpany: BELIMO
Date: 14.08.2008
Time: 10:37
Type: BFZ4TL-T-8T
OEM: BFZ4TL-T-ST
Position: Eld &, Floor €
Serialnumber: 00515-00005-104-100
User ID: Mya
List of error messages before Testrun:
- Mechanical overload
Test activities:
1. Plausibility test
v

Test progress and test report display

Click the "Start test" button.
The progress and the current position are continuously displayed.

The test report contains

= |nformation on the project,

the actuator ID,

a list of error messages pending before the start of the test,
the test steps and the test result, and

the current actuator settings.

If the test reports an invalid actuator configuration, switch to the "Configuration”
tab after ending the test. All values that are not permitted are marked there by a
flashing exclamation point.
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2.5 Deleting maintenance/error messages

e
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Any maintenance or error messages that are generated and stored by the actua-
tor are displayed on the "Service" tab.

Messages

Messages Mechanical travel increased

Reset Messages

Message display on the "Service tab"

Click "Reset messages" to delete all messages stored in the actuator.

The following messages are displayed:

Message

Description

Mechanical travel increased

Expected end stop value for top or bottom
has been overrun (adapted range)

Mechanical overload

Actuator did not reach setpoint because an
obstacle has reduced the adjustment travel

Excessive utilization

Actuator moves too often compared to the
total operating time

Safety relevant fault [Details]

Safety relevant fault in the actuator (e.g.
ambient temperature too high). Actuator
moves into the safety position

Damper test error

Damper free running test revealed an error

Duct temperature too high

Thermoelectrical tripping device has
detected a duct temperature that is too high.
Actuator moves into the safety position

Smoke detector tripped

Contact for connecting a smoke detector is
open. The actuator moves into the safety
position.

The message "Safety relevant fault" refers to an actuator fault that could interfere
with the safety function. This message cannot be deleted. The actuator must be

replaced.
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3 Configuration

3.1 Basic configuration

On the "Configuration” tab, you can read the parameter values stored in the ac-
tuator, change them, and re-store them in the actuator. The valid ranges for the

e
BELIMO

parameter values are shown in parentheses next to the input fields.

Type BF24TL-T-ST
Designaticn BF24TL-T-5T_01
Position

Service Configuration |, Simulationl

SN 00514-40118-104-098

Address PP EL \/
il

Designation |BF24TL-T-5T_D1

Read

Position |

Damper free running test |Deactivated

"Configuration” tab

Actuator identification®

j Write

Store to file___

Designation

Any 16 characters

Position

Any 16 characters

Damper free running test

Deactivated

Automatic test function deactivated

5°/7 s (10°/7 S)

10°/10 s (20°/10 s)

20°/20 s (40°/20 s)

A damper free running test is carried out every 24 hours
with the specified test criteria (range of rotation, time
limit).

The values shown in parentheses apply to actuators with
a 180° angle of rotation.

The "Damper free running test" setting is not supported by the BKN230-24-1MP

gateway.

1 Only characters in the Western European character set are allowed in the designation

and location (see General part).
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3.2 Advanced configuration (manufacturer view)

Additional configuration parameters (protected by a release code) are
available for fire damper manufacturers and authorized partners.

3.2.1 Settings

Service Configuration |%. Slmulatlonl =
Designation | Read |
Position |
Damper free running test | 20°/20s (40°/20s) -]
OEM Extension Store to file. . |
Nominal range |al:|a|:|tel:| ﬂ | 96 ©
Switch S1 24 °[1.74% 25 %
Switch 52 84 = (34.947) 28 %
Load parameter file (F2) |LTG-HK bptpar |
[v with adaption
Program (F9)
State of programming ) ok
"Configuration" tab with manufacturer view
The following additional settings are possible:
Nominal range (rotation angle)
Adapted Range of rotation is determined by the fire damper's me-
chanical end stops (adaptation)
Programmed Rotation angle range can be selected within the limits
defined by the maximum nominal setting range

Switching points

Switch S1 Switching point for the safety position in degrees (°); this
value is stored in the actuator as a percentage (%) and
recalculated if the range (angle of rotation) is changed

Switch S2 Switching point for the operating position in degrees (°);
this value is stored in the actuator as a percentage (%)
and recalculated if the range (angle of rotation) is changed

Click the "Read" button to reload the actuator data.

9 /17



V. 4
PC-Tool V3.16 Fire & Smoke module, user manual BEL'MO

3.2.2 Program

Alternative

[V with adaption

Click the "Program" button to store the new settings in the actuator.

Alternatively, you can press function key F9.

The rotation angle range of the actuator is normally determined by adaptation
(Range: Adapted). If the "With adaption” checkbox is selected, the final pro-
gramming step is to start the adaptation.

If the actuator has already been adapted and you simply want to change a set-
ting, this checkbox can be deselected.

The programming status is indicated by a traffic light (yellow, green, red) and an
explanatory text.

()

Programming sequence:

® Connect the actuator

@ Set the parameters
©) Press "Program" (F9)

...Wait until programming has finished (including adaptation)...

®

Check the programming status

® Print labels (optional)

®

Remove the actuator

For factory programming, refer to Section 3.2.4

3.2.3 Parameter file

Alternative

The fixed configuration settings for each damper type can be saved to a parame-
ter file to speed up the programming of several actuators.

The respective input fields will have a yellow background when you load these
values by clicking the "Load parameter file (F2)" button.

Alternatively, you can press function key F2.

The individual values (e.g. Position) can be changed before you start programming.
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Example:

// BELIMO PC-Tool

// Company: Damper Manufacturer XY

//

OEMString

PositionString

MP Set Switch

MP Set Operating Range

MP Set Extended Functions
MinMaxOperatingRange

; Product XY ;

; 1000; 9000;
; 0;
; 11;
H 8800; 9200;

The easiest way to create a parameter file is to select the required settings in PC-
Tool, then save them with "Store to file". The file can be subsequently modified in
a text editor program (e.g. Notepad).

Keywords
OEMString Designation, any 16 characters
PositionString Position, any 16 characters

MP Set Switch

Switching points S1 and S2 in percent with two dec-
imal places (1000 - 10.00%)

MP Set Operating Range

Programmed range (angle of rotation) in degrees
with two decimal places (9000 - 90.00°);
0 corresponds to the adapted range

MP Set Extended Functions

Extended functions, possible values:

0: Damper free running test deactivated

11: Damper free running test 5°/7 s (10°/7 s)

26: Damper free running test 10°/10 s (20°/10 s)
42: Damper free running test 20°/20 s (40°/20 s)

MinMaxOperatingRange

Limit values (angle of rotation) after programming
(adaptation) in degrees with two decimal places
(8800 > 88.00°)

These values are not stored in the actuator but are
used by PC-Tool to evaluate the programming sta-
tus.

After defining a parameter file, you should save it with the "Write protected" at-
tribute to prevent it from being inadvertently modified.
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3.2.4 Factory programming

Factory programming is carried out for several dampers, which is why an opti-
mized sequence is recommended.

Preparatory steps (required only once):

= Create a project

= Create parameter files (with overwrite protection)

= Create a configuration file for printing labels

Set the PC-Tool options

= MP channel settings: Scan type = "PP only"
= Fire & Smoke module: Default tab = "Configuration"
= Fire & Smoke module: Select the parameter file

Save a shortcut to the project on your desktop

The PC-Tool is opened by double-clicking the project shortcut. The project is
opened directly and a bus scan starts immediately. Only one actuator at a time is
allowed to be connected to PC-Tool. As soon as PC-Tool detects an actuator, it
scans it and automatically opens the "Configuration” tab.

Before programming a batch of dampers please make sure the right parameter
file is open and the "With adaption" checkbox is selected correctly.

Programming sequence

@

Connect the actuator

Click "Load parameter file (F2)"

Check the parameters (e.g. Position) and change them if necessary

@
®
®

Click "Program (F9)"

...Wait until programming has finished (including adaptation)...

©

Check the programming status

®

Print labels (optional)

@

Remove the actuator

The adaptation process can take a few minutes. It is therefore best to program a
group of actuators in two stages:
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= After starting the adaptation, carry out steps 1 to 4 for the other actuators (PC-
Tool does not need to be connected in order to finish the adaptation).

= Reconnect all programmed actuators when the adaptation has finished and
carry out steps 5to 7.

PC-Tool has no way of knowing whether an actuator is already programmed. You
are therefore advised to test the operating range with the narrowest possible limit
values (MinMaxOperatingRange, refer to Section 3.2.3).
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4 Controller simulation

Open the "Simulation” tab.

Type BF24TL-T-ST SN 00514-40118-104-098 J
Designation BF24TL-T-5T_01 Address PP %
Position “E

Service\ Configuration B Simulation

Actuator
Set Point Current position Switches
* Set Point 20 ° 0-° 5127
" Close €3 s2(189
" Open Sn
st Self Test |
" Motor Stop |
Messages

Messages Excessive utilisation
Mechanical overload Feset Messages

"Simulation" tab

The "Simulation" tab allows you to simulate the controller by selecting predefined
setpoints. In addition to the setpoint and the current position, you also see the
switch positions.

The actuator's internal self-test and the damper free running test can be run in
order to diagnose a fault.

The bottom half of the window shows any messages that are pending. These
messages can be reset by clicking the button.

4.1 Actuator control

Select the setpoint definition method with the radio buttons.

= Set point: The setpoint is not defined by the program. The last stored actuator
setpoint is used.

= CLOSE: The actuator moves into the safety position.
= OPEN: The actuator moves into the operating position.

= S1: The actuator moves to switching point S1, which is used to indicate the
safety position.

= Motor stop: The actuator is stopped in the current position.

"S1" and "Motor stop" are not supported by the BKN230-24-1MP gateway.
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4.2 Self-test

Current position

In addition to the setpoint, you also see the current position. Both values are
shown in degrees (°).

Switch position display

The switch positions S1 (safety position) and S2 (operating position) are visual-
ized by means of lamp icons. The switching points for S1 and S2 are configured
by the damper manufacturer.

Sn is the mechanical zero position switch for the fire damper actuator and is used
to check the end position.

An error message is generated if the actuator is unable to close the zero position
switch in the safety position. The actuator remains in the safety position until the
end position is indicated by Sn.

The zero position switch is not supported by the BKN230-24-1MP gateway.

The self-test is an internal fire damper actuator test that checks all actuator test
functions over the full range of rotation.

In the first test step, all stored messages are deleted. If a safety-relevant fault is
still present (e.g. if a duct temperature is too high), it cannot be deleted and will
cause the self-test to be canceled.

Click the "Self-test" button to start the test.

If the setpoint definition method selected for the actuator is CLOSE, the self-test
is stored in the actuator but does not start. The test is not run until you change
the setpoint definition to OPEN or S1.

4.3 Damper free running test

The damper free running test is described in Section 2.2.

Click the "Damper free running test" button to start the test manually. The damper
must be in the operating position.
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5 PC-Tool options

Alternative

Select Tools » PC-Tool options in the main menu.

Click the program icon in the outline bar with the right mouse button and select
PC-Tool options.

Select "Fire & Smoke module" from the list on the left.

5.1 Basic options

%4 PC-Tool Options

General
Release Codes

Air module

MP channel configuration

Water Globe module
Wl NMY-D2M module
WAl Compact module
YVl VRP-M module

Fire & Smoke module

Main view
Default tab:

l Service

#

Cancel

Dialog for basic settings (fire protection module)

Depending on the most frequent usage of the program’s PC-Tool, use the “De-
fault tab” combobox to select which tab will open by default when the program is

started.
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5.2 Advanced options (manufacturer view)
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Additional options (protected by a release code) are available for fire damper

manufacturers and authorized partners.

%4 PC-Tool Options @

General Main view

Release Codes Default tab:

MP channel configuration : 7

Air module . IConhguranon __V_]
Water Globe module After write

Way NMY-D2M module

VAY Compact module [V Start adaption after write

VAV VRP-M module

Fire & Smoke module Parameter file

lc:\dalen\BeIimo\PCTooI\BF-Top Produktiontparameter files\OEM Dampe E

oK Cancel '

Advanced settings dialog (fire protection module)

Start adaption after write

This value determines the basic setting of the "With adaption” option on the "Con-

figuration" tab.

Parameter file

The specified file is selected by default as the "Parameter file" whenever the

"Configuration" tab is opened.
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1 Introduction

The VAV module user manual describes the detail area [D] of the module for
VAV-Compact controllers. The documentation is divided according to the three
index tabs "Service", "Configuration" and "Simulation".

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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2 Service

2.1

Displaying settings

e
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The Service tab gives an overview of the current settings of the VAV-Compact
controller.

Paosition

Actual setlings

Control function Y

Nominal range
Calibration value
Volumetnc flow setting

Direction of rotation
Synchronization at
Torque

Bus fail posibon
Power ON
Gear release button

CAV feature
Actuator information
Firmware
Config table ID
Data log

Operating time
Active time
Stop & Go ratio
Meszages

Messages

Type LMV-D2-MP
Designation Belimo

Control type VAV-CAY

DC 210V

e
Ynom: 0 m3'h

Y= L ]
oo 1003
Y=0%
100%
Last value

No action
Synchronization

Standard

0119
D 104B

224h
Oh

Service | Configuration | . Simulation

adapted

Vmax: 0 m3h

SN 00831-20103-146-153
Address MP2

WVmin: 0 m3th

YWmid: 0 m3'h

Reset Messages

Test

Adaption

Synchronization

Service tab for full-rotation VAV controllers

The general part of this manual describes how you can print out the controller
parameters [Section 3.6.2.] or delete maintenance and fault messages [Section
3.6.3].

For linear actuators the stroke is displayed instead of the angle of rotation, and

the torque instead of the positioning force.

NMominal range 55 mm programmed
Calibration value
Volumetnc flow sethng “/nom: 0 m3/h Wmax: 0 m3th

Direction of stroke up
Synchronzabion at vY=0%

Force 100%

foox 53]
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Service tab for linear actuators (excerpt)
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Meaning of the settings
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Control function

VAV-CAV (volume control equipment) or open loop
operation (operation with external VAV controller, actuator
and sensor function)

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control signal (only for control function "Open Loop")

Feedback U5

Type of feedback signal (conventional operation)

Range Position range within the mechanical
limits
Conductance Box-specific parameter, set by the manufacturer

Volumetric flow
settings

Operating volumetric flow settings: V'nom / V'max / V'min /
V'mid
(only V'nom in open loop operation)

Direction of rotation

Clockwise/counterclockwise opening dampers (for full-
rotation actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque

Actuating force

In percent of maximum positioning force (for linear
actuators)

Behavior in the event of
bus failure

Behavior in the event of a communication failure

Power ON

Behavior when system is switched on
or after voltage interruption

Manual button [once]

Function when gearing latch button is pressed

CAV function

Mechanical stops: Standard or compatible with NMV-D2M

Firmware

Software version of the VAV-Compact

Config table ID

Identification of the configuration table of the VAV-
Compact

Operating time

Number of hours during which the actuator was connected
to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates unstable control
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2.2 Convert units for volumetric flow

2.3 Adaptation

Select Tools » PC-Tool options... in the main menu.

Click the "VAV-Compact module" on the left.

With the Volume display combobox, you determine the physical units for the
volumetric flow

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute).

This setting is for all displays, printouts, labels and writing to the log file [see
General part of this manual].

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

To start, click the "Adaptation” button on the Service tab.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop for a completely opened damper.

The actuators can be configured so that when the supply voltage is switched on
the adaptation is automatically triggered.

The adaptation can be blocked in certain actuators.

2.4 Synchronization

Variant

In the case of synchronization, a mechanical limit is approached in order to
calibrate the position calculation.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or when the damper is completely opened (100%).

To start, click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator by pressing the
gearing latch button.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop where damper is completely opened.

The actuators can be configured so that when the system is switched on, the
synchronization is automatically triggered.

The synchronization can be blocked in certain actuators.
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2.5 Function test

The function test checks for opening and closing of the damper.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the range is set to "adapted”, movement takes place
to the other stop; with "programmed", on the other hand, to the programmed
range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

Test progress: Current position; e Tl
- Plauzabliity test
- Meszages deleted
- Actuator clozes
- Actuator opens
- Teﬁrepnrt completed Test successiu

Test state;

Cloze Test

Test report:
Testprojekt V3 1_2 3 WNMV-D2-MP_00541-30002-146-099_20060221_1258_testreport = =)

[ ~
Belimo Testreport

Project: Testprojekt_V_3_1_Z 3
Compaty: EBelimo

Date: £1.02._ Z00&

Time: lz:-58

Type: NMV-Dz-HFP
Designation: WNMYV-DEZ-MP

Position: VAW 1

Serialmimber: 00541-30002-146-099
T=ser ID: [ats s

List of error messages before Testrun:

Test activities:

1. Plausablilitcy test
2. Messages deleted

Display of test progress and test report

Click the Start test button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the VAV-Compact controller,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current controller settings.
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If the test reports an invalid controller configuration, change to the "Configuration”
tab after ending the test. The values that are not allowed are marked with a
flashing exclamation point.

You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the Close Test button. The program asks whether you
want to save an unsaved test report now.

Save testreport? [%|

9 ) -
\““:l‘/ Would you like to save the kestreport?

Ja | Mein |

If you cancel the test early, no test report is created.
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3 Configuration

In the "Configuration" box, parameter values can be read out from the VAV-
Compact controller, changed and stored in a text file. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

Type LMV-D2-MP SN 00831-20103-146-153
Designation Belimo Address MP2
Position
Service Configuration |1, Simulation l
Designation |Be|imo Read
Position |
V'nom V'min V'max V'mid Write
0 mah 0 m3h 0 m3h 0 mah i
¥ Shut-offoper.  0.0m3h 0.0 m3h 0.0 m3h Storetofile...
Control type |VAV-CAV > Mede 010V & 210V €
v= [ * cow
Direction of rotation 1%°% = cw
Reduce '
Angle of rotation |adapted j | 94 -
Control signal Y |DC 210V |
Bus fail position |Last value j CAV feature |Standard j
Synchronization at |Y=D3'; j Power ON |Nu:| action j
Torque |1DD ﬂ % Gear release button |S‘,'nd1ronization

"Configuration" tab for full-rotation VAV controllers

The extended input boxes in the bottom area become visible when you click
"Expand".

For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

T=

n 'y up
Direction of stroke100% 11

" down

Reduce Y

Stroke |programmed ﬂ | 55 mm (30..95 mm)
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"Configuration” tab for linear actuators (excerpt)
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3.1 Settings

Controller identifier*

e
BELIMO

Designation

16 characters of any text

Position

16 characters of any text

Volumetric flow, nominal

V'nom

Nominal volumetric flow (is set by the manufacturer of the

VAV box)

Volumetric flow range for control function "VAV-CAV"

V'min

Lower limit of operating volumetric flow setting

V'max

Upper limit of operating volumetric flow setting

V'mid

CAV level between V'min and V'max

Shut-off device

sets V'min permanently to 0 m3/h
(shut-off operation — closed damper)

You can convert the physical units for the volumetric flow via Tools » PC-Tool
options in the main menu [see Section 2.2.].

In the options, you can also define whether the input of the volumetric flow for
V'min and V'max in percent is possible.

An existing value for V'mid is automatically adapted when V'min and V'Max are

entered: If you enter V'min, V'mid is always larger than or equal to this input

value. If you enter V'max on the other hand, V'mid is always less than or equal to

this value.

Control function

VAV-CAV

Constant (CAV) or variable (VAV)
volume control

Open loop

Operation with external VAV controller (actuator and
sensor function)

Mode (positioning signal Y / feedback U5)

Sets positioning signal Y =0 ... 10V,
feedback U5 = volumetric flow, 0 ... 10 V

Sets positioning signal Y =2 ... 10V,
feedback U5 = volumetric flow, 2 ... 10 V

0..10V
2...10V
others

Positioning signal Y and feedback U5 are defined
separately
(see below)

1 Only characters from the Western European character set are permitted for
"Description" and "Position" (see General part, table in Section 4.3.3).
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Control signal Y

e
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0..10V Fixed operating range 0 ... 10 V
2...10V Fixed operatingrange 2 ... 10V
Variable Start (Y=0%) 0 ... 8 V

Stop (Y=100%) 4 ... 32V
Range between start and stop at least 2 V

Feedback U5 (only active when the actuator address is set to PP)

Damper position

Damper position 0 ... 10 V

0..10V
Damper position Damper position 2 ... 10V
2...10V

Damper position
variable

Feedback, damper position
Start0...8.0V/Stop2...10.0V
Range between start and stop at least 2 V

Volumetric flow

Feedback, volumetric flow

0..10V 0...100% V'nom=0...10V

Volumetric flow Feedback, volumetric flow

2...10V 0...100% V'nom=2...10V

Volumetric flow Feedback, volumetric flow 0 ... 100% V'nom
variable Start0...8.0V/Stop2...10.0V

Range between start and stop at least 2 V

Direction of rotation (for full-rotation actuators)

cw

Damper opening in the clockwise direction

Cccw

Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)
down Downward-opening damper

Range (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal setting
range of the actuator

Behavior in the event of bus failure

Last setpoint

Volumetric flow according to the last received setpoint
from the MP master

Open Move to full angle of rotation/stroke (100%)
Close Move to zero stop

Min / V'min V'min volume

Max / V'max V'max volume
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Sensitivity (for "open loop" control function only)

Normal Normal response sensitivity and reversal hysteresis
(values depend on the actuator type)

reduced Reduced response sensitivity and increased
reversal hysteresis (values depend on the actuator type)

Synchronization at

Y =0% Approach of mechanical limit at zero stop
(damper closed)

Y = 100% Approach of the mechanical limit with damper
completely opened

Torque (for full-rotation actuators) / Positioning force (for linear actuators)

25% ... 100% Can be set in increments of 25%. 100% corresponds to
the

maximum torque / the maximum positioning force for the
actuator type (see nameplate)

CAV function
Standard Mechanical stops:
e Damper closed
e V'min
e V'max
e Damper open

NMV-D2M compatible | The CAV levels correspond to the predecessors
NMV-D2M:

Damper closed

V'min

V'mid

V'max

Damper open

Power ON
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Nothing (This option is not available for actuators of the "TOP"

performance class. When switched on, they must always
be adapted or synchronized)

Gearing latch

Synchronization (fix for VAV-Compact actuators)

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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3.2 Seal bit

In each actuator, volumetric flow settings are pre-programmed and are protected
with an electronic seal, the so-called "seal bit".

Symbol for intact seal bit

As soon as the value V'min, V'mid or V'max is changed on the system, the seal
bit is "broken". In this case, the status screen no longer displays the symbol for
the seal bit.

The specified values from the manufacturer can be reactivated at any time with
the function "Resetting to basic OEM settings ..." (see below). The seal bit
remains broken, however.

3.3 Reset to basic manufacturer settings

In order to reactivate the values for V'min, V'max and V'mid pre-programmed by
the manufacturer, select File » Reset to basic OEM settings... in the main menu.

Variant  You can also trigger this function with the F6 function key or by clicking on the
@ "Reset to basic OEM settings..." icon on the toolbar.
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4 Controller simulation

Go to the "Simulation" tab.

Type LMV-D2-MP SN 00831-20103-146-153
Designation Belimo Address MP2
Paosition

Service | Configuration & Simulation

ot Set point Actual flow  Damper —

" Simulatonoff  Close | 40 | = | = * None Value
" SetpointY " V'nom | * | = | = " Active (0...32V) =
; ; 0 m3/h 0 m3/h 8= A
o - m m
SetpointTool ¢ V'min " Passive (850...1.6kOhm) —
" Motor stop " V'max 52y 20vy - )
. Dpen  Vmid Passive (200...60k0hm) Tran=sfomabon
Test » | Testile [<No testscript> ] | ¢ Switch | <No table> =]
Interval 105 Stop Record ] Comment ... |3st AG_LMV-D2-MP__D0831-20103-146-153_20130814_164941_trend bpttnd
Trend
Belimo Test AG, LMV-D2-MP,
120
=
100 +
50
60
40
e
| Set point Tool |
T
o -
T T T T T T T T T T T T
16:49:41 16:49:42 1649043 1604944 16:49:45 16:49:146 16:49:47  16:49:48 16:49:49 16:49:50  16:49:51 16:49:52
|— Set Point [%s] Max Position [96] Min Position [%s] Actual Yolumetric Flow [%%] —— Lower Conkral Limit [%] —— Actual angle [%]
Values to show Set Point [%6] Actual Volumetric Flow [%] [] Actual Voltage [V]
Max Position [%4] Lower Control Limit [3%] [ ] Set Voltage [V]
Comments Min Position [%%] Actual angle [3%]

"Simulation" tab for VAV controllers

The controller simulation is influenced when the actuator is currently carrying out
an adaptation or synchronization. The function "Motor stop" overrides a running

adaption or synchronization.
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4.1 Actuator control

4.2 Test

Select the type of setpoint definition with the radio buttons.
= Setpoint Y: Positioning signal at the connection Y.

= Setpoint Tool: The setpoint is entered in % of the volumetric flow (0%
corresponds to V'min, 100% V'max), as volumetric flow value or as positioning
signal (volts).

The control is switched off when you click Motor stop.

The following overrides can be specified via radio button.
= OPEN:  Damper completely opened

CLOSED: Damper completely closed

= V'nom: Nominal volumetric flow

= V'min: Volumetric flow V'min (0%)

V'max:  Volumetric flow V'max (100%)

V'mid: CAV volumetric flow V'mid

Measurement values

The following are displayed:

» The actual volumetric flow 0 ... 100% of V'nom

= The actual volumetric flow in m3/h, I/s or cfm

= The feedback voltage in V (U5 signal)

= The damper opening in %

= The current angle of rotation in degrees / stroke in mm.

= An active override is displayed as text, independent of whether they were
specified by the PC-Tool or externally (positioning signal Y).

The trend lines can be fade in or out by selecting the corresponding checkbox.

The function test is available for the structured test of the VAV boxes.

Several consecutive commands [see 4.2.1] are defined in a test script file. When
the function is started, a trend recording is triggered.

Select test file

Select the desired script with the test file combobox.

Start test script
Click the test button * .

Important note

Before starting the actual script, the application checks whether the air
flow/system pressure is sufficient for the actuator test. (If the system pressure is
insufficient, this test can last up to 3 minutes.)
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The following test scripts are available.
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Name of the test file

Functions

Basic_VAV_Test Max-Min 5m.bptts

V'max — 2 minutes
V'min — 2 minutes

Test_VAV_0 CAV (Open-Max-Min-Close)
8m.bptts

Open — 1 % minutes
V'max — 2 minutes

V'mid — 2 minutes
V'min — 2 minutes
Close — 1 % minutes

Test VAV_Max-75-50-25-Min-Close 3h.bptts Open — 2 minutes
V'max — ¥ hour
SetPoint 75% — Y2 hour
SetPoint 50% — Y2 hour
SetPoint 25% — Y2 hour

V'min — % hour

Test_VAV_Max-Auto-Min 9m.bptts V'max — 3 minutes
Auto — 3 minutes

V'min — 3 minutes

V'max — 3 minutes
Auto — 3 minutes

Test VAV_Max-Auto 6m.bptts

Test_VAV_Max-Mid-Min 9m.bptts V'max — 3 minutes
V'mid — 3 minutes

V'min — 3 minutes

Test_VAV_Max-Min-Max[ 1_Percent ]
37m.bptts

SetPoint 100% - 2 minutes
(afterwards in steps of 1%)
SetPoint 99%...0% - every 10
seconds

SetPoint 1%...100% - every 10
seconds

Test_VAV_Max 3m.bptts VMax — 3 minutes

Test_VAV_Open-Max-75-50-25-Min-
Close22m.bptts

Open — 3 minutes
V'max — 3 minutes
SetPoint 75% — 3 minutes
SetPoint 50% — 3 minutes
SetPoint 25% — 3 minutes
V'min — 3 minutes
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4.3 Reading out sensors and switches

The values of integrated sensors and switches can be read out in MP mode. This function, however,
must be activated in the PC-Tool options "General" in advance. Select Tools » PC-Tool options... in the
main menu.

#r PC-Tool Options [
F{EBE'Ielgalsde Codes Project base path:

MP channel configuration |C MUsers'dbaDocuments*Belimo \PCTool
:_AV Cgunl'lpact Manufacturer [~ |se default

r module

Water Globe module

VAY NMV-DZM module Language:

VAV Compact module - Th I etting beco ctin

Enalish - e new language setting mes active

Eﬁev&vgnfu;wemn?:iﬁe | g J after a program restart.

EPIV module Log file:

" Fileperweek  * File per month

[ Enable MP-Monitor
Simulation/Trend
v Ask user if trendfiles should be saved.

e sensor reading functionality

Corce

k.

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Senzor

" Mone Yalue

* Active (0... 32V) | 02y

" Passive [850...1.6kDhm) | 02y %

" Paszszive [200.. 60k0hm) Transformabon

" Switch |<No table> |

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)
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4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

=] On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Trend Recod # | Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

Stop Record B The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.

Interval 10 = Stop Record ] Comment... m |ast AG_LMV-D2-MP__0D0831-20103-146-153_20130814_164941_trend bpttnd
Trend

Belimo Test AG, LMV-D2-MP,
120 —

%

100~
g0

60 —

40 -
o ////

et poink Tool |

_//’_'____,.———__'_-_
[
T T T T T T T T T T T T
16:49:41 16:49:46 16:49:51 164956 16:50:01 16:50006 16:50:11 16:50:16 16:50:21 16:50:26  16:50:31 16:50:36

|— Set Poink [%] Max Position [%s] Min Posikion [946] Actual Yolurmetric Flow [%] Lower Conkral Limit [%6:] —— Actual angle [%:]
Values to show Set Point [%6] Actual Volumetric Flow [%6] [ Actual Voltage [v]
Max Position [%4] Lower Contral Limit [26] [ | Set Voltage [V]
Comments Min Position [%G] Actual angle [%%]

Trend plot for "VAV-CAV" control function
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Interval 105 Stop Record ] Comment_.. |3st AG_LMV-D2-MP__00831-20103-146-153_20130814_164941_trend bpttnd

Trend
Belimo Test AG, LMV-D2-MP,
120
F
100 —
80 - \
a0
40
- _—\'//
et point Tool
—.
o It
T T T T T T T T T T T T
16:49:41 16:50:01 16:50:21 16:50:41 16:51:01 16:51:21 1605141 16:52:01 16:52:21 16:52:41 16:53:01 16:53:21
|— Set Poink [94] Max Position [9%] IMin Position [%] Actual Yolumetric Flow [%%] —— Lower Control Limit [%:] —— Actual angle [%:]
Values to show Set Point [%] Actual Volumetric Flow [%6] [ Actual voltage [V]
Max Position [%4] Lower Control Limit [%] [ Set voltage [V]
Comments Min Position [%4] Actual angle [%&]

Trend plot for "open loop" control function

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select Tools » PC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.
## PC-Tool Options g — I&
General Main view
Felease Codes Default tab: Flow Unit: Pressure nit:
MP channel corfiguration -
VAY Compact Manufacturer |Sen-'||:e ﬂ |'T'3"1" j |PE' ﬂ
Air module [ Flow input: Option [%] field
Water Globe module ow input: Option [%]fields
WVAY NMY-D2M module Calibration
VAN module . TR
VAV VEP-M module [ Set adaption after the calibration process.
Eﬁ& Smle'liE module Calibration Compact D3
moddE [v Passive calibration with Vref and ApE\ref
Pretime to Calibrate: | 0 [0-9999s]
TypeList Compact D3
OEM No.: | 11233
Altitude compensation
| Enable Altitude Compensation

Height a.5.1. unit: m ﬂ

0K Cancel

L% I s I A

Dialog for basic settings (VAV-Compact module)
Click the "VAV-Compact module" on the left.

Main window

Depending on the most common application, set which tab should be opened by
default when the program is started with the "Default tab" combobox.

With the Volume display combobox, you determine the physical units for the
volumetric flow.

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute)

If you would like to have the option of entering the volumetric flow as a

percentage, activate the "volumetric flow input: Option [%] boxes" checkbox.
Percentage values are only possible when V’'Nom=0.

Calibration options will only be used in manufacturer tool.
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1 Introduction

The VAV D3-module user manual describes the detail area [D] of the module for
VAV-Compact D3-controllers. The documentation is divided according to the
three index tabs "Service", "Configuration" and "Simulation".

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the VAV-Compact D3
controller.

SN 01347-00195-158-159
Address PP

Type LMV-D3IW-MP LTG
Designation VRE-W 250_D3_ccw
Position 5592138

Service | Configuration | ©. Simulation

Actual settings
Control type VAV-CAY

Test

Control funcionY DOC 0-10V

Feedback U5

MNominal range
Volumetric flow setiing
Ap&V nom

Angle comection curve

Direction of rotation
Synchronization at

Torque

Bus fail position
Power ON

Gear release button

CAV feature

Actuator information
Firmware
Config table ID
Lifecycle Byte
Diata log
Operating ime
Active time
Stop & Goratio
Meszages

Messages

Volumetric flow 0-10 V

Min: 0% Max: 1007
BR" adapted
Vnom: 1739 m3'h Wmax: 900 m3/h
102 Pa

Vmin: 0 m3/h

On

= L ]
oow 100%
Y=100%
100%
Last value

Synchronization
Synchronization

CLOSENV min\V'max; shut off level CLOSED.1V

15 V02.06-0004
Dx10CC
22T not customized: field parametrization passed

700h

0Oh
0%

Mechanical travel increased

Service tab for full-rotation VAV controllers

Adaption

Synchronization

Vmid: 870 m3'h

Reset Messages

The general part of this manual describes how you can print out the controller
parameters [Section 3.6.2.] or delete maintenance and fault messages [Section
3.6.3].

For linear actuators the stroke is displayed instead of the angle of rotation, and

the torque instead of the positioning force.
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NMominal range 55 mm programmed
Calibration value
Volumetnc flow sethng “/nom: 0 m3/h Wmax: 0 m3th

Direction of stroke up E”“:"}—l
Synchronzabion at vY=0%

Force 100%

Service tab for linear actuators (excerpt)

4
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Control type

VAV-CAV (volume control equipment) or open loop
operation (operation with external VAV controller, actuator
and sensor function)

Control signal Y

Type of control

Feedback U5

Type of feedback signal (conventional operation)

Range

Position range within the mechanical
limits

Volumetric flow
settings

Operating volumetric flow settings: V'nom / V'max / V'min
(only V'nom in open loop operation)

Ap@V’nom

Box-specific parameter, set by the manufacturer (Ap when
V’nom is applied to the VAV-Box)

Altitude of plant

Operating altitude of the plant

Direction of rotation

Clockwise/counterclockwise opening dampers (for full-
rotation actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque

Actuating force

In percent of maximum positioning force (for linear
actuators)

Behavior in the event of

bus failure

Behavior in the event of a communication failure

Power ON

Behavior when system is switched on
or after voltage interruption

Gear release button
[once]

Function when gearing latch button is pressed

CAV function

Mechanical stops: Standard 0.1V Shut off, Standard 0.5V
Shut off, old generation (NMV-D2M)

NFC Interace

NFC mode (read/write)

Firmware

Software version of the VAV-Compact D3

Config table ID

Identification of the configuration table of the VAV-
Compact D3

Operating time

Number of hours during which the actuator was connected
to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates unstable control
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2.2 Convert units for volumetric flow

2.3 Adaptation

Select Tools » PC-Tool options... in the main menu.

Click the "VAV-Compact module" on the left.

With the Volume display combobox, you determine the physical units for the
volumetric flow

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute).

This setting is for all displays, printouts, labels and writing to the log file [see
General part of this manual].

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

To start, click the "Adaptation” button on the Service tab.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop for a completely opened damper.

The actuators can be configured so that when the supply voltage is switched on
the adaptation is automatically triggered.

The adaptation can be blocked in certain actuators.

2.4 Synchronization

Variant

In the case of synchronization, a mechanical limit is approached in order to
calibrate the position calculation.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or when the damper is completely opened (100%).

To start, click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator by pressing the
gearing latch button.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop where damper is completely opened.

The actuators can be configured so that when the system is switched on, the
synchronization is automatically triggered.

The synchronization can be blocked in certain actuators.
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2.5 Function test

The function test checks for opening and closing of the damper.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the range is set to "adapted”, movement takes place
to the other stop; with "programmed"”, on the other hand, to the programmed
range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

Test progress: Current position; e Tl
- Plauzabliity test
- Meszages deleted
- Actuator clozes
- Actuator opens
- Teﬁrepnrt completed Test successiu

Test state;

Cloze Test

Test report:
Testprojekt V3 1_2 3 WNMV-D2-MP_00541-30002-146-099_20060221_1258_testreport = =)

[ ~
Belimo Testreport

Project: Testprojekt_V_3_1_Z 3
Compaty: EBelimo

Date: £1.02._ Z00&

Time: lz:-58

Type: NMV-Dz-HFP
Designation: WNMYV-DEZ-MP

Position: VAW 1

Serialmimber: 00541-30002-146-099
T=ser ID: [ats s

List of error messages before Testrun:

Test activities:

1. Plausablilitcy test
2. Messages deleted

Display of test progress and test report

Click the Start test button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the VAV-Compact D3 controller,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current controller settings.

8 /23



V. 4
PC-Tool V3.16 VAV-Compact D3 module, user manual BEL'MO

If the test reports an invalid controller configuration, change to the "Configuration”
tab after ending the test. The values that are not allowed are marked with a
flashing exclamation point.

You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the Close Test button. The program asks whether you
want to save an unsaved test report now.

Save testreport? [%|

.t) Would you like to save the kestreport?

\_&
Ja | Mein |

If you cancel the test early, no test report is created.
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3 Configuration

In the "Configuration" box, parameter values can be read out from the VAV-
Compact D3 controller, changed and stored in a text file. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

Type LMV-D3W-MPLTG SN 01347-00195-158-159
Designation VRE-W 250_D3 ccw Address PP

Posijtion 5592138
LTG, VRE-W 250_D3_ccw|

Service Configuration |:, Simulation

Designation |VRE-W 250_D3_ccw

Read
Position |5552138
Write
Velume flow Store tofile..
Vnom | 1735 m2/h
V'max 500 m3h 348.1733 m3'h
V'mid 270 m3h 0..900 m3h
V' min 0 m¥h 0..500 m3'h
Direction of rotation ™= %] % cow Mode & 010V 210V
1003 i ow
Reduce F Y
Angle of rotation |adapted j | 66
Control type |VAVCAV |
Control signal Y [DC 0-10V ~|
Feedback U5 |Volumetic flow 0-10V |
Bus fail position || 5t value | (o8 A\ 7ot TS O] OSE/V imin/\Vmax; shut off level CLOSE:D.1V |4
Synchronization at |"f=1|.'.'[l"r'= j Power ON |S1_.'n-:hronizatinn ﬂ
Torque |1DD ﬂ %  Gearrelease bution |5ynd1ronization

"Configuration" tab for full-rotation VAV controllers

The extended input boxes in the bottom area become visible when you click
"More".

For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

= . e up
Direction of stroke 00 £¢|  ~ o

Reduce Y

Stroke |programmed ~|| 95 mm(30.95mm)

"Configuration" tab for linear actuators (excerpt)
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3.1 Settings
Controller identifier!
Designation 16 characters of any text
Position 16 characters of any text

Volumetric flow, nominal

V'nom Nominal volumetric flow (is set by the manufacturer of the
VAV box)

Volumetric flow range for control function "VAV-CAV"

V'min Lower limit of operating volumetric flow setting

V'max Upper limit of operating volumetric flow setting

You can convert the physical units for the volumetric flow via Tools » PC-Tool
options in the main menu [see Section 2.2.].

In the options, you can also define whether the input of the volumetric flow for
V'min and V'max in percent is possible.

Altitude compensation
Altitude of plant Operating altitude of the plant

You can convert the physical units for the Altitude of plant via Tools » PC-Tool
options in the main menu [see Section 2.2.].

Mode (positioning signal Y / feedback U5)

0..10V Sets positioning signal Y =0 ... 10V,
feedback U5 = volumetric flow, 0 ... 10V
2.10V Sets positioning signal Y =2 ... 10V,
feedback U5 = volumetric flow, 2 ... 10V
others Positioning signal Y and feedback U5 are defined
separately
(see below)

Control signal Y

DCO0...10V Fixed operating range 0 ... 10V
DC2...10V Fixed operating range 2 ... 10V
DC variable Start (Y=0%) 0 ... 8V

Stop (Y=100%) 4 ... 32 V
Range between start and stop at least 2 V

1 Only characters from the Western European character set are permitted for
"Description" and "Position" (see General part, table in Section 4.3.3).
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Feedback U5 (only active when the actuator address is set to PP)

Damper position Damper position 0 ... 10V
0..10V
Damper position Damper position 2 ... 10V
2..10V
Damper position Feedback, damper position
variable Start0...8.0V/Stop2...10.0V
Range between start and stop at least 2 V
Volumetric flow Feedback, volumetric flow
0...10V 0...100% V'nom=0...10V
Volumetric flow Feedback, volumetric flow
2..10V 0...100% V'nom=2...10V
Volumetric flow Feedback, volumetric flow 0 ... 100% V'nom
variable Start0...8.0V/Stop2...10.0V
Range between start and stop at least 2 V
Ap, 0-10 V Feedback pressure difference Ap
0...100% V'nom=0...10V
Ap, 2-10 V Feedback pressure difference Ap
0...100% V'nom=2...10V
Ap, variabel Feedback pressure difference Ap 0...100% V'nom

Start 0 ... 8.0 Volt/ Stop 2 ... 10.0 V
Range between start and stop at least 2 V

Direction of rotation (for full-rotation actuators)

cw Damper opening in the clockwise direction

ccw Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)

down Downward-opening damper

Range (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal setting
range of the actuator

Control type

VAV-CAV Constant (CAV) or variable (VAV)
volume control

Open loop Operation with external VAV controller (actuator and
sensor function)
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Behavior in the event

4
BELIMO

of bus failure

Last setpoint

Volumetric flow according to the last received setpoint
from the MP master

Open Move to full angle of rotation/stroke (100%)
Close Move to zero stop

Min / V'min V'min volume

Max / V'max V'max volume

Synchronization at

Y = 0% Approach of mechanical limit at zero stop
(damper closed)

Y =100% Approach of the mechanical limit with damper
completely opened

Torque (for full-rotatio

n actuators) / Positioning force (for linear actuators)

25% ... 100%

Can be set in increments of 25%. 100% corresponds to
the

maximum torque / the maximum positioning force for the
actuator type (see nameplate)

CAV function

CLOSE/N'min/V'max;

shut off level ) _ :

CLOSE:0.1V Y-signal (Mode=2-10V) Function
Y<01V Close
Y=Gnd Close
Y not connected (open) None (V'min)
Y = 24 VAC neg. half- Close
wave
Y =24 VAC full-wave V'max
Y = 24 VAC pos. half- Open
wave

CLOSE/N'min/V'max;

shut off level ) ~ )

CLOSE:0.5V Y-signal (Mode=2-10V) Function
Y<05V Close
Y=Gnd Close
Y not connected (open) Close
Y = 24 VAC neg. half- Close
wave
Y =24 VAC full-wave V'max
Y = 24 VAC pos. half- Open
wave
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V'min / V'mid/ V'max
(NMV-D2M comp.) ) )
Y-signal (Mode=2-10V) Function
Y<0.1V Close
Y=Gnd Close
Y not connected (open) None (V'min)
Y = 24 VAC neg. half- V'mid
wave
Y = 24 VAC full-wave V'max
Y = 24 VAC pos. half- Open
wave
Power ON
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Nothing (This option is not available for actuators of the "TOP"
performance class. When switched on, they must always
be adapted or synchronized)

Gear release button

Synchronization (fix for VAV-Compact D3 actuators)

Note
For function and wiring, see VAV-Compact D3 product information
LMV-D3-MP, NMV-D3-MP, SMV-D3-MP
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3.2 Seal bit

In each actuator, volumetric flow settings are pre-programmed and are protected
with an electronic seal, the so-called "seal bit".

Symbol for intact seal bit

As soon as the value V'min or V'max is changed on the system, the seal bit is
"broken". In this case, the status screen no longer displays the symbol for the
seal bit.

The specified values from the manufacturer can be reactivated at any time with
the function "Resetting to basic OEM settings ..." (see below). The seal bit
remains broken, however.

3.3 Reset to basic manufacturer settings

In order to reactivate the values for V'min and V'max pre-programmed by the
manufacturer, select File » Reset to basic OEM settings... in the main menu.

Variant  You can also trigger this function with the F6 function key or by clicking on the
@J "Reset to basic OEM settings..." icon on the toolbar.

15 /23



V. 4
PC-Tool V3.16 VAV-Compact D3 module, user manual BEL'MO

4 Controller simulation

Go to the "Simulation" tab.

Service| Configuration B Simulation

Type SN 01141-20033-158-152
Designation v120d95h1400cw Address MP4
Position LONGUS D DD

Actuator = Sensor
Set point Actual flow A D
" Simulabonoff * Close | I:::]I | “I] | = g | ampl]er * None Value
" SetpointY " V'nom = = * * " Active (0...32V) N
¢ SetpointTod ¢ Vmin | Oman| Opa | O - =
" Motor stop " Vmax 00y -
" Open " W'mid | Active ovemde step: Close Transformation
Test » | Testle |<No testscript> =] | ¢ Switch |<No table> =
Interval 1.0 5 Stop Record ] Comment . |est AG__LONGUS D DD_01141-20033-158-152_20130815_050345_trend bpttnd
Trend
Belimo Test AG, , LONGUS D DD
E-. 2000 —
(a2}
E
1500
1000
300 —Hactive override step..,
o -
120
=S
90+
60 —
30+
o -
T T T T T T T T T T T T T T
09:03:45 09:03:46 09:03:47 0990345 09:03:49 09:03:50 09:03:51 09:03:52 09:03:53 09:03:54 09:03:55 09:03:5%6 09:03:57 09:03:55
|— Set Paoint [m3fh] Max Position [m3fh] Min Position [m3h] Actual Yolumetric Flow [m3fh]  —— Ackual angle [%]
Values to show Set Point [m3/h] Actual Volumetric Flow [m3/h] [ Set Voltage [v]
Max Position [m3/h] Actual angle [4] [] ap [=6]
Comments Min Position [m3h] [ Actual voltage [v]

"Simulation" tab for VAV controllers

The controller simulation is influenced when the actuator is currently carrying out
an adaptation or synchronization. The function "Motor stop" overrides a running
adaption or synchronization.
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4.1 Actuator control

4.2 Test

Select the type of setpoint definition with the radio buttons.
= Setpoint Y (only available in PP mode): Positioning signal at the connection Y.

= Setpoint Tool: The setpoint is entered in % of the volumetric flow (0%
corresponds to V'min, 100% V'max), as volumetric flow value or as positioning
signal (volts).

The control is switched off when you click Motor stop.

The following mechanical stops can be specified via radio button.
= OPEN:  Damper completely opened

CLOSED: Damper completely closed

= V'nom: Nominal volumetric flow

= V'min: Volumetric flow V'min (0%)
= V'max:  Volumetric flow V'max (100%)
= V'mid: Volumetric flow V'mid

Measurement values

The following are displayed:

= The momentary volumetric flow O ... 100% of V'nom

= The actual volumetric flow in m3/h, I/s or cfm

= The feedback voltage in V (U5 signal)

= the current pressure difference (Ap) 0 ... 100% of Ap@V'nom,
= the current pressure difference (Ap) in Pa,

= The damper opening in %

= The current angle of rotation in degrees / stroke in mm.

= An active mechanical stop is displayed as text, independent of whether they
were specified by the PC-Tool or externally (positioning signal Y).

The function test is available for the structured test of the VAV-CAV boxes.

Several consecutive commands [see 4.2.1] are defined in a test script file. When
the function is started, a trend recording is triggered.

Select test file
Select the desired script with the test file combobox.

Start test script
Click the test button .

Important note

Before starting the actual script, the application checks whether the air
flow/system pressure is sufficient for the actuator test. (If the system pressure is
insufficient, this test can last up to 3 minutes.)
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4.2.1 Test scripts

The following test scripts are available.

Name of the test file Functions
Basic_VAV_Test Max-Min 5m.bptts V'max — 2 minutes
V'min — 2 minutes
Test_VAV_0 CAV (Open-Max-Min-Close) Open — 1 % minutes
8m.bptts V'max — 2 minutes

V'mid — 2 minutes
V'min — 2 minutes
Close — 1 % minutes

Test_ VAV_Max-75-50-25-Min-Close 3h.bptts Open — 2 minutes
V'max — Y2 hour
SetPoint 75% — Y2 hour
SetPoint 50% — Y2 hour
SetPoint 25% — Y2 hour
V'min — % hour

Test_VAV_Max-Auto-Min 9m.bptts V'max — 3 minutes
Auto — 3 minutes
V'min — 3 minutes

Test_VAV_Max-Auto 6m.bptts V'max — 3 minutes
Auto — 3 minutes
Test_VAV_Max-Mid-Min 9m.bptts V'max — 3 minutes

V'mid — 3 minutes
V'min — 3 minutes

Test_VAV_Max-Min-Max[ 1_Percent ] SetPoint 100% - 2 minutes
37m.bptts (afterwards in steps of 1%)
SetPoint 99%...0% - every 10
seconds
SetPoint 1%...100% - every 10
seconds
Test_VAV_Max 3m.bptts VMax — 3 minutes
Test_VAV_Open-Max-75-50-25-Min- Open — 3 minutes
Close22m.bptts V'max — 3 minutes

SetPoint 75% — 3 minutes
SetPoint 50% — 3 minutes
SetPoint 25% — 3 minutes
V'min — 3 minutes
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4.3 Reading out sensors and switches

The values of integrated sensors and switches can be read out in MP mode. This function, however,
must be activated in advance in the PC-Tool options under "General". Select Tools » PC-Tool options...
in the main menu.

«+ PC-Toal Options ﬁ
Project base path

Releasze Codes

MP channel configuration |C:"-.Llsers"-.l't"l‘.".n'S.INGTES"-.Dcu:uments"-.BeIirno"-—.PCTu:uoI
WAV Compact Manufacturer [~ Use default

Air module

Water Globe module Language

VAV NMV-D2M module |En lish j The new language setting becomes active after a program

WAV module gd restart |
WAV VRP-M module Lo fi ’

Fire: & Smolke module og e

EPIV module + Filepermonth File per week

MP-Monitor

I Enabla MP-Manitor
Simulation/Trend

= er if trendfiles should be saved.

ensor reading functionality

Program update

Check for newer version

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Sensor

" Mone Value

+ Active [0... 32¥) |02y

" Passive [850...1.6kDhm) | 02y %

" Paszszive [200.. 60k0hm) Transformabon

" Switch |<Nu table> ﬂ

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)
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4.4 Trend recording

Trend Record

Stop Record

m3h a0

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.

PCToolGUI 3.6, LMY-D3-MP.LONGUS D

|- 120 2

700
E00

\‘\"‘—\ i

500

- 80

400

/

- &0

300

- 40

200
100

_Fan

\

\

\

-

133335

133340 133345 13:3%50 13:3l3:55 13:3l4:DE|

Tirne

Set Paint [m3/h]
Actual Yolumetric Flow [m3/h]

Max Pozition [m3sh]
Actual angle [%]

kin Pogition [m3dh]

Trend plot for "Closed-Loop" control function
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PCToolGUI 3.6, LMY-D3-MP, LONGUS D

- 500

- 700

- 600

.

\ —-—-.__\_\ - 300

¥ 200

\ - 100

134810 134815 13:48:201' 124B0E 134230 134838 -0
Zeit
Sollwert [%] Klappenstelung [%] Wolumenztrom [m3/h]

Trend plot for "Open-Loop" control function

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

m3h

If you want to record a trend for more than one hour (long-term trend), enter a

value of at least 2 seconds for the interval. If the interval is shorter, too many data

points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select Tools » PC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.
»r PC-Tool Dptioan - 1 ﬁ
General Main view
Release Codes Default tab: Flow Unit: Pressure Unit:
MP channel configuration
Air module | j |m3ﬂ1 ﬂ | Pa j
Water Globe module ¥ FElow input Option [%] field
VAV NMV-D2M module o input: Option [ fields
YAV module Calibration
VAV VRP-M module " : a—
Fire & Smoke module [ Set adaption after the calibration process. l
EPIV module Calibration Compact D3
[ Passive calibration with Vref and Ap@Wref
Pretime to Calibrate: | 0 [0-9999s]
Altitude compensation
[ Enable Altitude Compensation
Height a.5.1. unit: |m j
S
]

Dialog for basic settings (VAV-module)
Click the "VAV-module" on the left.

Main window

Depending on the most common application, set which tab should be opened by
default when the program is started with the "Default tab" combobox.

With the Volume display combobox, you determine the physical units for the
volumetric flow.

= m3/h (cubic meters per hour)
= |/s (liters per second)
= cfm (cubic feet per minute)

If you would like to have the option of entering the volumetric flow as a
percentage, activate the "volumetric flow input: Option [%] boxes" checkbox.

With the Pressure Unit combobox, you can determine the physical units for the
pressure display

= Pa (Pascal)

= inWC (inch water column, 1 inWC is approx. 249 pascals at 0 °C)

Altitude compensation

The altitude compensation can be activated through the checkbox. The actuator
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is then able to supply, on the basis of the entered altitude of installation in the
configuration tab, the altitude compensated differential pressure and the altitude
compensated flow rate values.

With the Height a.s.I(above sea level) unit combobox you can determine the
physical units for the operating altitude of the plant

= m (Meter)

= ft (Feet)
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1 Introduction

The "Water module" user manual describes the detail area [D] of the Water
module for globe valve actuators. The documentation is divided according to the
three tabs "Service", "Configuration” and "Simulation".
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2 Service

2.1 Displaying settings

e
BELIMO

The Service tab gives an overview of the current settings of the actuator.

Actual seltings

Control function Y
Sensibvity

Nominal range
Running time
Stroke

Direction of stroke

Faorce
Bus fail position

Actuator information

Service l Configuration

DC 0510V
variable

20 mm

60s

Ma: 100%  [20mm]
Min: 0% [Omm]

ar

direct BDFF
531

100%
Last value

L, Simulation

Firmware (0036 (0x01)
Configtable ID (0084
Datalog
Operating ime 616h
Active ime Oh
Stop & Goratio 0%
Messages

Messages

Service tab for globe valve actuators

Meaning of the settings

- gA

adapted

Mid.: 50%  [10mm]

Closing point up

MNe o
il
b

Reset Mezsages

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

Feedback U5

Type of feedback signal

Range

Position range within the mechanical
limits

Running time

Time needed to pass through the position range

Stroke

Programmed stroke range: Max / Mid / Min

Direction of rotation

Direction of stroke

inverted (in acc. with switch S3.1)

Switching point

Top / bottom (in acc. with switch S3.2)

Clockwise/counterclockwise (for full-rotation actuators)

Plot of stroke direction to the positioning signal: Direct /
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2.2 Adaptation

Variant

Actuating force In percent of the maximum positioning force

Behavior in the event of Behavior when communication fails

bus failure

Firmware Software version on the actuator

Config table ID Identification of the configuration table

Operating time Number of hours during which the actuator was
connected to the power supply

Active time Number of hours during which the actuator was
mechanically in motion and connected to the power
supply

Stop & Go ratio Ratio of active time/operating time in percent. A high Stop

& Go ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain
actuators.

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

Click the "Adaptation" button on the Service tab.
You can also trigger the adaptation directly on the actuator. To do this, you have

to remove the cover from the actuator. To trigger the adaptation, press the S2
button on the electronic PCB.

H1 31 s2

WY,
{Tm

[1][2] [3][4][5]

1 7 YLz Ui

Control element diagram with open linear actuator

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop at full stroke.

Next, the absolute values for a programmatically limited angle of rotation range
(minimum, mid-position, and maximum) as well as the feedback signal U5 are
recalculated and displayed.

The adaptation can be blocked in certain actuators.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator,

change them and save them back to the actuator. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

- - - - 1
Service Configuration |t, Simulation | |- R
Designation |NVZ4-MFT2 Read
Position |
Start Stop Write
Contral signal Y |P\WM variable ~| | 100 s(002.435) 7.00 s (1.02.50s)
Store to file...
Feedback Us |Valve position 2-10 W ﬂ
Base span U5 0% 100 % Load from file___
Min Mid Max
Stroke 0 % (0.61%) 50 % (0..100%) 100 % (39..100%)
0 mm 7 mm 13 mm
Running ime 140 s (20..390s)
Reduce F Y
Stroke |programmed - 13 mm (5..23 mm)
- - |;|E'N X . . [11¥]
Direction of stroke e direct Closing point o oFE up
Bus fail position |Last value -
Sensitivity |nomal -
Force | 100 w | %
"Configuration" tab for globe valve actuators
Actuator number?
Designation 16 characters of any text
Position 16 characters of any text

1 Only characters from the Western European character set are permitted for Description

and Position (see General part, table in Section 4.3.3).

6/14



PC-Tool V3.16 Water stroke module, user manual

Control signal Y
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3-point

AC voltage, positions: Open / neutral / closed

Open / closed

DC or AC voltage, 2-point

DCO0.5-10V

(DC voltage)

fixed operating range DC 0.5-10 V

DC2-10V
modulating

(DC voltage)

fixed operating range DC 2-10 V

DC variable

Start (Y=0%) 0.5 ... 30 Volt
Stop (Y=100%) 2.5 ... 32 Volt
Range between start and stop at least 2 V

PWM 0.02-5 s

Duration of the control impulse (pulse width modulation),
fixed operating range

PWM 0.1-255s

Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s

Duration of the control pulse, fixed operating range

PWM variable

Start (Y=0%) minimum 0.02 seconds
Stop (Y=100%) maximum 50 seconds

Feedback U5 (only active when the actuator address is set to PP)

Valve setting 2 -10V

DC voltage measurement signal, fixed range

Valve setting 0.5 -10V

DC voltage measurement signal, fixed range

Variable valve setting

DC voltage measuring signal
Start 0.5...8.0 Volt / Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Scaling U5 (with "New Generation" actuator only)

Start

Position in percent, corresponds to the start value of the
feedback signal

Stop

Position in percent which corresponds to the stop value
of the feedback signal

Stroke

Min

Programmed lower limit of the range (cannot be changed)

Mid

Mid-position of range

Max

Programmed lower limit of the range

An existing value for Mid is automatically adapted when Max is entered: Mid is
always less than or equal to this input value.
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Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V. min: 30%, max : 70%
Feedback U5 : 2...7 V start: 20%, stop: 90%

Position

Open 100%

50%
i
T 1 1
1 1 |
4 -
] 1 1 1 1 |
1 1 1 1 1 1
v : YTobToEoAmgeT
Close 0% I I Y Y | . Y/US
1 T T 1 1T T T "~ V]
0 5 10
Running time
In seconds Time needed to pass through the range limited by
Min and Max (the valid range of values for the running
time depends on the actuator type and the passed-
through range)
Stroke
Adapted from the mechanical limits of certain stroke
Programmed The valid values depend on the maximum nominal
positioning range of the actuator

Stroke direction (in acc. with switch S3.1)

Direct 0% positioning signal is equivalent to 0% position
feedback.

inverted 0% positioning signal is equivalent to 100% position
feedback.
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Closing point (in acc. with switch S3.2)

top

The linear spindle is moved into the actuator with the
valve closed and the stem is moved out of the fitting.

bottom

The linear spindle is moved out of the actuator with the
valve closed and the stem is moved into the fitting.

Behavior in the event of bus failure (currently cannot be changed)

Last setpoint

Position according to control signal Y

Sensitivity
Normal
— Response sensitivity: 1%
@ Operating range
— Reversal hysteresis 2.5%

@ Operating range

Damped
— Response sensitivity: 2%

@ Operating range
— Reversal hysteresis 5%

@ Operating range

Actuating force

25% ... 100%

Can be set in increments of 25%. 100% corresponds to
the maximum positioning force for the actuator type (see
nameplate)
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4 Controller simulation

Go to the "Simulation" tab.

Type NVF24-MFT2 E SN 00415-30015-130-050
Designation Belimo Address MP1
Position Water

Service | Configuration & Simulation

Actuator Sensor

" Simulation off Set point Actual position {* None Value

. | 40.0 % | 213 % | 49 mm " Active (0_..32V) ,—_

{+ Setpoint Tool lﬁ v lﬁ v o l_—

£ Motor stop Trendview & =% L Transformation

Test » |Testile |<No testscript> o] || & Switch |<No table> |

Interval 105 Stop Record ] Comment... H |.|'F24—MI-—I'2 E_Water_00415-30015-130-050_20121214_104520_trend bpttnd
Trend

Belimo Test AG. NVF24-MFT2 E. Water

0 T ™ T 1 1 T |I T T I| T T T |I T T T T T T T T
10:45:210:45:230:49: 220:49:230:49:250:49: 260:45:2T0:45:280:45: 780:45: 300:49: 310:49: 320:49: 330:45: 380:45: 350:45:260:49: 370:49: 380:45:380:45:40
Time

— Set Point [%] Valve Position [%] Max Position [3] Min Position [%]

"Simulation” tab for globe valve actuators

The controller simulation is not possible while the actuator is performing an
adaptation or synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y
according to selected control type (DC, PWM, open/close, 3-point).

= Setpoint Tool (not available with control type open/close or 3-point): The
setpoint is entered in % of the programmed range. 0% is the minimum, 100%
the maximum. The input values are converted and displayed in the units of the
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corresponding control signal (volts or seconds).

The control is switched off when you click Motor stop. This function is not
available with the control types open/close and 3-point.

Measurement values

During the simulation, the stroke is displayed in % of the absolute (mechanically
limited) range in millimeters and — converted according to the scale setting — as a
feedback voltage in volts.

4.2 Test

The test function is available for the structured testing of the Water actuator.

A number of commands which follow one another in sequence are defined in a
test script file. A trend record is triggered at the start of the function.

Select test file

At the moment there aren’t any predefined test scripts available. Custom test
scripts can be produced any time and be selected through the Combobox.

Select the desired script with the Combobox test file. Only test scripts for Water
modules are displayed in the Combobox.

Start test script

Click on the test » button. The tests will begin at once.
Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "Water".

4.3 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function,
however, must be activated in advance in the PC-Tool options under "General".
Select ToolsPPC-Tool options... in the main menu.

11 /14



PC-Tool V3.16 Water stroke module, user manual

e
BELIMO

L

x|

: :

Release Codes Project base path:

MP channel configuration |C:"-.Dc|kumer|te und Einstelungen* ACME"\Eigene Dateien*Belimo"PCTool
Air module ™ Use default

Water Globe module S¢ oelau

WAV NMV-D2M module

WAV Compact module Language:

VAV WYRP-M madule |Eng|ish j The new language setting becomes

after a program restart.
Log file:
" File per week 1+ File per month

[ Enable MP-Maonitor

Simulation/Trend

[ Enable sensor reading functionality

[ Ask user if trendfiles should be saved (if not check save them always).

Care

Settings for reading out sensors

|

active

On the Simulation tab, a section with the sensor values is displayed to the right of

the actuator control.

Sensor

" None Value

+ Active (0__.32V) | Ev

" Passive (850...1.6kOhm) | 03v

" Passive (200._.60kDhm) Transformation

" Switch | =]

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the

"Transformation table" section in the General User Manual)

4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would

like.

i On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name

and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the

new file name (ask user if trend files should be saved). The

suggested file name
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can be modified before saving the file.

Trend Record . Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

Stop Record B The Trend View radio buttons allow you to set whether the display is given in
percent of the full rotation range (%) or in volts (V).

The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Intenrdl 1.0 ‘ Trend | | Kommentar.. | |imiled_|ut_-::unf_l]l]439-1 0093-
—Trend

ACME. AM24-MFT2. Limited_lot_conf

o 100
90
80
70
60
50
40

{
.'
30- /
[
' |

20
10

T T T T T T
15:42-50 15:43:00 15:43-10 15:43:20 15:43:30 15:43:40
Zeit

Sollwert [%] Aktueller' Winkel [%]
Max Position [%] Min Position [%]

Trend plot

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

e
BELIMO

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.

#x PC-Tool Options ﬁ
General Main view

Felease Codes Default tab:

MP channel configuration -

WAV Compact Manufacturer |SEW":E j

Air module
Sfer vrite

WAV NMV-D2M module . i

VAV module [ Start adaption after write

VAV VRP-M madule
Fire & Smalee module
EPIV module

OK | Cancel

L8

Dialog for basic settings (Water module)

Select "Water/globe module" on the left.

Using the combobox "Default tab", you can select the index tab you want to open

by default when starting the program PC-Tool.

If an adaptation is to be performed after every programming operation, select

"Start adaption after write".

Activate the ,Show actuator characteristics on/off* checkbox to show, in the
Service and Configuration tabs, the actuator characteristics. This function is only

available on new generation water modules.
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PC-Tool V3.16 Water globe module
For new gen globe valve actuators
User Manual

English
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1 Introduction

The "Water module" user manual describes the detail area [D] of the Water mod-
ule for globe valve actuators of new generation. The documentation is divided

non

according to the three tabs "Service", "Configuration" and "Simulation”.
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the actuator.

Designation Meine
Position

Service | Configuration

Actual setings
Control function Y DC 2-10V

down
Sensitivity normal

Running time 150s

Force 100%

Bus fail posibon Close
Power Fail-/Power off Pos. 757%
Power Fail Delay 3=
Power Fail Count 144
Power ON Mo action
Manual button Jonce] Synchronization

Actuator information

Firmware 01%01.31-0003
Configtable D (x1110

Data log
Operating ime 3ZEh
Activeime (Oh
Stop & Goratio 0%
Messages

Messages

Type NVK24A-MP-TPC

ot Simulationl

Closing point o E Adaption

Stroke Max: 100%  [25.6mm]
Min: 0% [0.0mm]

SN 01243-10007-145-110
Address MP8

Test

Synchronization

refers to 20 mm
25.6 mm adapted

Feset Messages

Service tab for globe valve actuators of new generation

Meaning of the settings

Control signal Y

Type of control. If the control signal is inverted this will be
displayed.

Closing point

.up / down (according to direction switch)

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

4/16




PC-Tool V3.16 Water globe module new generation, user manual

2.2 Adaptation
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Feedback U5

Type of feedback signal. If feedback U5 is inverted this
will be displayed.

Running time

Time needed to pass through the position range

Stroke

Programmed/Adapted stroke range : Max / Min

Actuating force

In percent of the maximum positioning force

Behavior in the event of
bus failure

Behavior when communication fails

Power Fail-/Power off Pos.

Actuator position in case of power fail (exists only on
actuators with Electronic Fail Safe modules)

Power Fail Delay

Time delay until actuator drives to power fail position.
(exists only on actuators with Electronic Fail Safe mod-
ules)

Power Fail Count

Number of power Fail counts (exists only on actuators
with Electronic Fail Safe modules)

Power On

Behavior at Power On of the actuator or after a power
fails.

Manual button (once)

Behavior when manual button (gear release button is
pressed once)

Firmware

Software version on the actuator

Configtable 1D

Identification of the configuration table

Operating time

Number of hours during which the actuator was connect-
ed to the power supply

Active time

Number of hours during which the actuator was mechani-
cally in motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates an unstable control.

In the adaptation, the actuator determines the range 0% ... 100% by approaching

the mechanical limits.

Click the "Adaptation" button on the Service tab.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end

stop at full stroke.

The actuators can be configured that an adaptation automatically is triggered at

Power On.

The adaptation can be blocked in certain actuators.

2.3 Synchronisation

In the case of synchronization, a mechanical limit is moved to in order to deter-

mine the absolute range.
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Variant

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or at the full angle of rotation/stroke (100%).

Click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator. The necessary
buttons for this can be programmed. For example, "Manual button [once]" can be
assigned the synchronization function.

The progress of the synchronization is displayed in the status line. With the set-
ting Synchronization at: Y=0%, the actuator moves against the programmed di-
rection to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop at the fully open valve.

The actuators can be configured that an synchronization automatically is trig-
gered at Power On.

The synchronization can be blocked in certain actuators.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator,
change them and save them back to the actuator. The valid ranges for the pa-
rameter values are displayed in parentheses next to the input boxes.

Type NVK24A-MP-TPC SN 01243-10007-145-110
Designation Meine Address MP3
Positicn

Service Configuration |t Simulation\

Designation |Meine Read
Posifion |
Write
Control signal Y |DC 2-10V ~]
[ inverted Store to file___
Closing point )
up ¥ E Load from file. ..
down
Mz Min
Stroke | 100 % (20.100%) 0% |adapted ~| | 28
256 mm 00 mm
Running time 180 5 (88.160s) refers to 20 mm
2.50 s/mm
Reduce A

Bus fail posibon |Cloze -
Sensitvity (nomal -

Force |100 %
Power ON |Mo action -

Power Fail-/Power off Fos. 75 %
Power Fail Delay is=
Manual button foncel: | Synchronization

"Configuration" tab for globe valve actuators

Actuator number?!

Designation 16 characters of any text

Position 16 characters of any text

1 Only characters from the Western European character set are permitted for Description
and Position (see General part, table in Section 4.3.3).
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Control signal Y
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3-point

AC voltage, positions: Open / neutral / closed

Open / closed

DC or AC voltage, 2-point

DC0-10V

(DC voltage)
Fixed operating range DC 0-10 V

DC 2-10 V modulat-
ing

(DC voltage)
Fixed operating range DC 2-10 V

DC variable

Start (Y=0%) 0.5 ... 30 V
Stop (Y=100%) 2.5 ... 32V
Range between start and stop at least 2 V

PWM 0.02-5 s

Duration of the control pulse (pulse width modulation),
fixed operating range

PWM 0.1-255s

Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s

Duration of the control pulse, fixed operating range

PWM variable

Start (Y=0%) minimum 0.02 seconds
Stop (Y=100%) maximum 50 seconds

Control signal Y inverted

On (checked)

Control signal Y will be inverted
(smallest voltage = Max)

Off (not checked)

Stellsignal Y normal
(highest voltage = Max)

Closing point (according to switch position)

up

In the closed valve position, the actuator spindle is re-

tracted, and the valve stem is extended from the valve.

down

In the closed valve position, the actuator spindle is ex-
tended, and the valve stem is retracted into the valve.

Feedback U5 (only active when the actuator address is set to PP)

Valve setting 2 -10V

DC voltage measurement signal, fixed range

Valve setting 0.5 -10V

DC voltage measurement signal, fixed range

Variable valve setting

DC voltage measuring signal
Start 0.5...8.0 Volt / Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Feedback U5 inverted

on

Feedback U5 is inverted
(smallest voltage = Max Position)

off

Feedback U5 normal
(highest voltage = Max Position)

8/16



V. 4
PC-Tool V3.16 Water globe module new generation, user manual BEL'MO

Scaling U5 (with "New Generation" actuator only)

Start Position in percent, corresponds to the start value of the
feedback signal

Stop Position in percent which corresponds to the stop value
of the feedback signal

Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V min: 30%, max : 70%

Feedback U5 : 2...7 V start: 20%, stop: 90%
Position
A
Open 100%  —f-4-bobodo oot ob oo
Lo

1 1 1
1 1 1
—f Lo -
1 1 1
1 1 1 1
— e ml = === -+ -
0 Lo L
50% b i e Kl Ko b e e ek -
1 1 1 1 1 1
~+ - A b
1 1 1 1 1 1 1
1 1 [ N I M RN A [
T T 1 1 1 1 1 1
1 | 1 1 1 1 1 1
—] I
1 1 1 1 1 1 1 1
1 | 1 1 1 1 | 1 | 1
B it i i i A e o e A e
Close 0% [ T I T I Y/U5
T T T T 1T T T T T 7 [V]
0 5
Stroke
Min Programmed lower limit of the range (cannot be
changed)
Max Programmed lower limit of the range
Stroke
Adapted from the mechanical limits of certain stroke
Programmed The valid values depend on the maximum nominal
positioning range of the actuator
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Running time (Actuating Time)

In seconds

The running time in seconds refers always to the nominal
stroke of the actuator independent of the range between
Min and Max setting. When changing Min and Max the
running time will change.

(The valid range of running time depends on actuator type
and the adjusted range.)

In seconds/mm

The actuating time (running time/nominal range) in s/mm
is constant. When changing Min and Max value the actu-
ating time keeps constant.

In case of constant speed the value is calculated accord-
ing to the formula running time/reference distance.

Behavior in the event of bus failure

Last value Position according to control signal Y
Open Move to full angle of rotation/stroke (100 %)
Close Move to zero stop
Fast Close Close with maximum speed
Sensitivity
normal

— Response sensitivity:

1% @ Operating range

— Reversal hysteresis

2.5% @ Operating range

reduced

— Response sensitivity:

2% @ Operating range

— Reversal hysteresis

5% @ Operating range

Actuating force

100%

value can't be adjusted, it's read only

Power ON

Synchronization

Moves to a mechanical limit (according to the setting "Syn-
chronization at")

Adaptation

Moves to both mechanical limits and recalculates angle-
dependent parameters

Nothing

10/16




PC-Tool V3.16 Water globe module new generation, user manual

e
BELIMO

Power Fail-/Power off Position (only with Electronic Fail Safe module)

in %

Emergency Position at Power Fail (can only be changed
when poti is in "Tool" position)

Power Fail Delay (only with Electronic Fail Safe module)

in seconds

Time delay until actuator drives to emergency position in
power fail case.

Manual button [once]

Synchronization

Moves to a mechanical limit (according to the setting
"Synchronization at") when the manual button is pressed
once or twice respectively

Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters when the manual button is pressed
once or twice respectively

Note: For "New Generation" actuators (types MF, MP), the function Manu-

al button [twice] is not available.
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4 Controller Simulation

Go to the "Simulation" tab.

Type NVK24A-MP-TPC SN 01243-10007-145-110
Designation Address PP
Position

Service | Configuration & Simulation
Actuator

" Simulation off Set point Actual position
40.0 249 51
(” SetpointY | % | % | mm

& Setpoint Tool ZLUIE ==V

" Motor stop Trendview {= @)

Test » |Testle |<No testscript> ~|

Interval | 105 | StopRecord ] Comment... [ | [fles'\Belimo Test AG_NVK24A-MP-TPC__01243-10007-145-110_20121214_18(0
Trend

Belimo Test AG, NVK24A-MP-TPC,

%120

I 4+ttt
18:05:04:05:0%:05:08:05:08:05:08:05:08:05: 18:05: 18:05: 1B:05: 18:05: 18:05: 18:05: 18:05: MB:05: 18:05: 18:05:38:05:38:05:28:05:38:05:38:05:25
Time

— Set Point [%] Valve Position [%] Max Position [%] Min Position [%]

"Simulation" tab for globe valve actuators

The controller simulation is not possible while the actuator is performing an adap-
tation or synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y accord-
ing to selected control type (DC, PWM, open/close, 3-point).

= Setpoint Tool (not available with control type open/close or 3-point): The set-
point is entered in % of the programmed range. 0% is the minimum, 100% the
maximum. The input values are converted and displayed in the units of the cor-
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responding control signal (volts or seconds).
The control is switched off when you click Motor stop. This function is not availa-
ble with the control types open/close and 3-point.
Measurement values

During the simulation, the stroke is displayed in % of the absolute (mechanically
limited) range in millimeters and — converted according to the scale setting — as a
feedback voltage in volts.

4.2 Test

The test function is available for the structured testing of the Water NG actuator.

A number of commands which follow one another in sequence are defined in a
test script file. A trend record is triggered at the start of the function.

Select test file

At the moment there aren’t any predefined test scripts available. Custom test
scripts can be produced any time and selected through the Combobox.

Select the desired script with the Combobox test file. Only test scripts for Water
NG modules are displayed in the Combobox.

Start test script

Click on the test » button. The tests will begin at once.
Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "Water".

4.3 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function,
however, must be activated in advance in the PC-Tool options under "General".
Select ToolsPPC-Tool options... in the main menu.
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# PC-Tool Options ﬂ
Project base path

Release Codes

MP channel corfiguration |C:"-.Users"-.M‘."a'S.INGTES"-.Du:u:umerds"-.EeIimD"-.PCTDDI
VAV Compact Manufacturer [~ laedecadt

Air module

Water Globe module Language

VAV NMV-DZM module |En lish ﬂ The new language setting becomes active after a program

VAV module g i |
VAV VRP-M module Log il ’

Fire & Smoke module el

EPIV module * Filepermonth  © File per week

MP-Meonitor

[ Enable MP-Monitor
Simulation/Trend

i : aved.
I¥ Enable sensor reading functionality

Program update

Check for newer version

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Sensor

{+ None Value

" Active (0_..32V) -

s e

e Transformation

" Switch | <No table> ]

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)

4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

=] On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be
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saved). The suggested file name can be modified before saving the file.

Trend Record . | Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

Stop Record B The Trend View radio buttons allow you to set whether the display is given in
percent of the full rotation range (%) or in volts (V).

The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Interval 103z Stop Record [} Comment... |t AG_NVKZ4A-MP-TPC__01243-10007-145-110_20130815_094800_trend bpttnd
Trend

Belimo Test AG, NVK24A-MP-TPC,
120

%

100

B e

6
40

20

et point Tool |
-
'

o -

T T T T T T T T T T T T T T T 1
09:453:00 09:45:3009:49:00 09:49:30 09:50:00 09:50: 30 09:51:00 09, 51: 30 09 52:0009: 52: 30 09:53:00 09:53: 30 09:54:00 09:54: 30 09:55: 00 09:55: 30 09:56: 00

|— Set Point [%] Valve Position [%] Max Position [%] Min Position [%s]

Values to show Set Point [%h] Min Position [%%]

Valve Position [4]
Comments Max Position [%g]

Trend plot

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

-

## PC-Tool Options . @

General Main view
Felease Codes Default tab:
MP channel corfiguration | J
Air module ~

.

VAV NMV-D2M module After write

VAV module . .
VAV VRP-M module [ Start adaption after write
Fire & Smolee module

EPIV module

0K | Cancel

[

Dialog for basic settings (Water Globe module)

Select "Water/globe module" on the left.

Using the combobox "Default tab", you can select the index tab you want to open
by default when starting the program PC-Tool.

If an adaptation is to be performed after every programming operation, select
"Start adaption after write".
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1 Introduction

The EPIV Module User Manual describes the detail area [D] of the module for the
EPIV controller (Electronic Pressure Independent Valve, pressure-independent
flow controller). The documentation is divided up in accordance with the tabs for
"Service", "Configuration" and "Simulation".

Note
For function and wiring, see Product Information.
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2 Service

2.1 Show Settings

e
BELIMO

The Service tab offers an overview of the current settings of the EPIV controller.

Position

Actual seilings
Control mode
Control signal Y

Sensitivity
Feedback U5

U5-Charactenstics
Nominal range
Valve Size

Synchronization at

Bus fail posibon
Power ON
Gear release button

Actuator informabion
Firmware
Config table ID

Datalog
Operating ime
Active time
Stop & Go ratio
Messages
Messages

Type SR24A-CF
Designation ePIV_01

Service | Configuration | {. Simulation

Pos. Control
DC 2-10V

normal
Flow DC 2-10V

Min: 0% Maze: 100%

U5 Characteristics on [equal percentage]
96" adapted

DN 65/ 23"

Vnom: 480 lmin

¥=0%

Last value
Mo action
Synchronization

01 v01.24-0005
(1049

416h
12h
2%

SN 00444-30039-157-089
Address PP

,?

Test

Adaption

Synchronization

Reset Messages

Service tab for EPIV

controller

In the general section of this user manual, a description is given as to how you
can print out the control parameters [chapter 3.6.2.] or delete the maintenance

and error messages [chapter 3.6.3].
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Meaning of the settings

e
BELIMO

Control mode

Flow control or pos. control operation

Control signal Y

Type of control. If the control signal is interpreted as in-
verted, then this will be displayed.

Y-Characteristics

The EPIV controller works with either an equal-percentage
or a linear characteristic curve.

Characteristic curve off means "linear", characteristic curve
on means "equal percentage".

Feedback U5

Type of feedback signal (conventional operation)

U5-Characteristics

Characteristic curve off means "linear", characteristic curve
on means "equal percentage".

Nominal range

Nominal position range within the mechanical
limits

Valve size

Size of the valve; is set by Belimo. If the specified volumet-
ric flow scale with respect to the valve size has been
changed from the factory setting, then the label marked
"Scaling adjusted" will appear.

Volumetric flow settings

Operating volumetric flow settings: V'nom / V'max
(only V'nom in open loop operation)

Synchronisation at

Stop position 0% or 100%

Bus fail position

Position in the event of MP communications failure

Power ON

Behaviour/Function when switching on the device
or after a voltage interruption, respectively

Gear release button

Function when the gear release button is pressed

Firmware

Software version of the EPIV controller

Config table ID

Identification of the configuration table of the EPIV

Operating time

Number of hours during which the actuator was connected
to the supply

Active time

Number of hours during which the actuator was mechani-
cally moving and connected to the supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio (red) indicates that the control is unstable.

The following additional settings appear when EPIV is combined with Super Cap:

Power Fail-/Power off
Pos.

Actuator position after failure of the supply voltage

Power fail Delay

Time after the failure of the supply voltage and before the
actuator begins to move to the emergency setting position.

Power fail Count

Number of voltage interruptions
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2.2 Adaption

Converting units for volumetric flow

Select Tools » PC-Tool Options in the main menu.

Click on "EPIV Module" at the left.

You can determine the physical units for the volumetric flow with the Combobox
volume display

= |/min (litres per minute)

m3/h (cubic metres per hour)

I/s (litres per second)

I/h (litres per hour)

gpm (gallons per minute)

This setting applies for all displays, printouts, labels and writing into the log file
[see general section of this user manual].

With adaption, the actuator determines the available range 0% ... 100% by ap-
proaching the mechanical limits.

To start, click the "Adaption" button in the Service tab.

The progress of the adaption is displayed in the status bar. The actuator first
moves against the programmed direction to the zero end stop and then to the
end stop with complete valve opening.

The actuators can be configured in such a way that an adaption will be triggered
automatically when the supply voltage is switched on.

2.3 Synchronisation

Variant

During synchronisation, one mechanical limit is approached in order to compare
the position calculation.

Each actuator can be programmed to determine whether synchronisation is to be
carried out at the zero end stop (0%) or with full valve opening (100%).

To start, click the "Synchronisation” button in the Service tab.
You can also trigger the synchronisation directly at the actuator by pressing the
gear release button.

The progress of the synchronisation is displayed in the status bar. If synchronisa-
tion at: is set to Y=0%, the actuator will move against the programmed direction
to the zero end stop; if on the other hand synchronisation at: is set to Y=100%,
then it will move to the end stop with full valve opening.

The actuators can be configured in such a way that a synchronisation will be trig-
gered automatically when the plant is switched on.
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2.4 Function Test

The opening and closing of the valve is checked during the
function test.

The actuator first moves in accordance with the synchronisation position to the
mechanical end stop. If the range is set to "adapted", then the other end stop will
be approached; if it is set to "programmed"”, on the other hand, then it will move to
the programmed range limit.

Click on the "Test" button in the Service tab. The normal display will then be cov-
ered over by the test window.

Test progress:
- Flausibility test

- Actuator closes
- Actuator opens

Test repart;

- Messages deleted

Current position;
TTEL T4

Test state: Abort Test

i

=1=]

Project:

Comp ary:
Date:

Time:

Type:

OEM:
Position:
Serialnumber:
U=er ID:

List of error

Eelimo Testreport

3

Demo
Belimo
Z&_01_Z010
10:2&
SRE4L-CF

00951-30118-1&7-127
ooE

messages before Testrun:

Lo

Test activities:

Plansibility test

Messages deleted

Aotuator closes

Actuator opens w

Display of test progress and test report

Click on the "Start Test" button.
The progress and the current position will be displayed continuously.

The test report contains

= information concerning the project,

the identification of the EPIV controller,

a list of the error messages in effect before the start of the test,
the test steps and the test result,

= the current controller settings.
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If the test reports an invalid controller configuration, switch over to the "Configura-
tion" tab after the test has been completed. There you will find the non-permitted
values marked with a flashing exclamation mark.

You can save the test report as a file by clicking on the floppy disk symbol or print
it out by pressing on the printer symbol.

End the function test by pressing on the "Close Test" button. The program will
ask whether you would now like to save a test report that has not yet been saved.

Save testreport? [%|

?l‘) Wiould you like to save the kestrepaort?
N

If you abort the test prematurely, then no test report will be compiled.
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3 Configuration

In the "Configuration” tab, you can read out the parameter values from the EPIV
controller, modify them and save them as a text file.

Type SR24A-CF SN 00444-30039-157-089

Designation ePIV_01 Address PP
Position "@

Service Configuration |1, Simulation\

Designation |=FIV_01 Read
Position |
Write
Valve Size |DN 65 / 214" V'nom | 4300 I'min  V'max 480.0 limin | 100 %
144 420 limin Store to file_
U5 Flow Range: 100 %
Control mode |F|.;.w contral ﬂ
Control signal Y |DC 210V ~| i’
[ invert 10V = Vmax Y-Characteristics off [linear] [
Feedback U5 |Flow DC 2-10V ~] —
Hode A US Characteristics on [equal percentage] W
Bus fail position |Last value |
Synchronization at |Y=E'3"= j
Power ON |N|:u action j

Gear release buiton |5‘,'nd1ror1izaﬁon
"Configuration" tab for EPIV controller

The extended configuration in the lower area will become visible when you click
on "Expand".
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3.1 Settings

Controller ID?

e
BELIMO

Designation

16 characters of any text

Position

16 characters of any text

Valve size

Selection list with valve
sizes

Sets the valve size and thus also the nominal volumetric
flow specified by the manufacturer (default nominal volu-
metric flow, if a release code is available, can be modified.
See below: "Display scaling").

Volumetric flow, nominal

V'nom

Nominal volumetric flow (is set by the manufacturer)

Volumetric flow range for the the control function "Flow control"

V'max

Upper limit of the operating volumetric flow setting (in
selected unit or in %)

The possible range is displayed under the box, it lies be-
tween 30% - 100% of V’nom.

U5 volumetric flow
range

Upper limit for the U5 volumetric flow range.
This value is typically the same as V'max[%].

The value only has an influence on the U5 feedback volt-
age value.

You can change the physical units for the volumetric flow in "Tools » PC-Tool Op-

tions" in the main menu [see chapter 2.2.].

An existing value for U5 volumetric flow range will automatically adjust itself to

the V'max when the latter is entered. On the other hand, the V'max will not
change if you change the U5 volumetric flow range yourself.

Control mode

Flow control

Pressure independant operation

Pos. control
(Open Loop)

Pressure dependant operation

Control signal Y

DCO0.5... 10V

Fixed operating range 0.5 ... 10V

DC2...10V

Fixed operating range 2 ... 10V

DC variable

Start (Y=0%) 0.5 ... 8V
Stop (Y=100%) 2.0 ... 32V

1 Only characters from the Western European character set are permitted to be used for

designation and position (see general section, table chap. 4.3.3).
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e
BELIMO

Range between start and stop at least 2V

Control signal Y inverted

on Inverts the control signal Y
(lowest voltage = V'max)
off Control signal Y normal

(highest voltage = V'max)

Feedback U5 (active only if actuator address is set to PP)

Volumetric flow

Volumetric flow feedback

0.5...10V 0...100%, V'nom=0.5... 10V

Volumetric flow Volumetric flow feedback

2...10V 0...100%, V'nom=2 ... 10V

Volumetric flow Volumetric flow feedback 0 ... 100%, V'nom
variable Start 0.5 ... 8.0 volt / stop 2.0 ... 10.0V

Range between start and stop at least 2V

Valve position

feedback Valve position

0.5... 10V 0 ... 100%, Nominal range = 0.5 ... 10V
Valve position feedback Valve position

2..10V 0 ... 100%, Nominal range = 2 ... 10V
Valve position feedback Valve position 0 ... 100%, Bereich
variable Start 0.5 ... 8.0 Volt/ Stop 2.0 ... 10.0 V

Nominal range between start and stop at least 2V

Y-Characteristic curve

on Characteristic curves for control function Y switched on
(input signal to volume equal percentage)
off Characteristic curves off (input signal to volume linear)

U5 Characteristic curve

on Characteristic curves for feedback U5 switched on (input
signal to volume equal percentage)
off Characteristic curves off (input signal to volume linear)

Bus fail position

Last setpoint

Volumetric flow in accordance with the last setpoint of the
MP master received

Open Open valve (100%, valve completely open)
Close Close valve
Max / V’max V’max volumetric flow

Sensitivity (only with "Open Loop" control function)

normal

Normal reaction sensitivity and inversion hysteresis (val-
ues are dependent on actuator type)
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e
BELIMO

reduced

Reduced reaction sensitivity and increased
inversion hysteresis (values are dependent on actuator

type)

Synchronisation at

Y = 0%

Approaching the mechanical limit with
zero end stop (valve closed)

Y =100%

Approaching the mechanical limit with full valve opening

With Power ON

Adaption

Approaching both mechanical limits and recalculation of
angle-dependent parameters

Synchronisation

Approaching one mechanical limit (in accordance with the
setting "Synchronisation at")

No action

Gear release button

Synchronisation

(preset for EPIV actuators)
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4 Controller Simulation

Switch over to the "Simulation" tab.

Type SR24A-CF SN 00444-30039-157-089 \/

Designation ePIV_01 Address PP
Position ’?

Service| Configuration B Simulation

Actuator =
Set point Actual flow  Valve
" Simulaionoff  Close | 23 | 1M l“ =
¢ SetpointY ¢ * * *
* SetpointTed 113 1/min 13- 4
" Motor stop 2y 6.4y
" Open
Test » | Testile |Test_EPIV_Max 3mbpits |
Interval 1.0 5 Stop Record ] Comment . |n1-:: Test AG_SR24A-CF__00444-30035-157-085_20130814_173715_trend bpttnd
Trend
Belimo Test AG, SR24A-CF,
= 120 A
E
-
— a0 o
&0 +
30__ | Set point Tool ]
D | /
120
E
90+
£0 -
30 4
o4
T T T T T T T T T T T T T T
1723715 17237016 103717 1753008 175019 LASRz20 VR302l 1REnz22 V5023 VA3hzd VhE02s \hEn2e 1AShz? 175728
|— Sk Point [%:] Ackual Yolumetric Flov [Ifmin] - —— ‘talve Position [%]
Values to show Set Point [%a] [] actual voltage [v]
Actual Volumetric Flow [ljmin] [ | Set Voltage [V]
Comments Valve Position [%]

"Simulation" tab for VAV controllers

Control simulation will be influenced if the actuator is currently carrying out an
adaption or a synchronisation. The "Motor Stop" function overrides any ongoing

adaption or synchronisation.
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4.1 Actuator Control (Actuator)

4.2 Test

Use the radio buttons to select the setpoint specification.
= Setpoint Y: Control function at connection Y.

= Setpoint tool: Input of the setpoint in % of the volumetric flow (100% corre-
sponds to V'max), as volumetric flow value (e.g. I/min) or as control function
(volts).

Clicking on "Motor Stop" stops the actuator.

The following override steps can be specified per radio button.
= Open: Valve completely opened

= Close: Valve completely closed

= V'nom: Nominal volumetric flow

* V'max:  Volumetric flow V’max (100%)

Measured values

The following are displayed:

= The current volumetric flow 0 ... 100% of the V'nom

= The actual flow of the volumetric flow in I/min or the selected unit
= The feedback voltage in volt (U5 signal)

= The valve opening in %

= The current angle of rotation in angular degrees

= An active override step is displayed as text, independently of whether it was
specified by the PC-Tool or externally (control function Y)

= Fault indication of flow sensor: Following messages will be displayed in case of
malfunction flow measurement:

a) "Sensor not ok": Flow sensor is defect or not connected

b) "Air bubbles": The medium contains air bubbles that disturbs the
measurement.

The test function is available for the structured testing of the EPIV actuator.

A number of commands which follow one another in sequence [see 4.2.1] are de-
fined in a test script file. A trend record is triggered at the start of the function.

Select test file

Select the desired scrip with the Combobox test file. Only test scripts for EPIV
modules are displayed in the Combobox.

Start test script

Click on the test » button. The tests will begin at once.

Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "EPIV".
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4.2.1 Test scripts
The following test scripts are available as templates.

Name of the test file Functions
Test_EPIV_Max 3m.bptts V'max — 3 minutes
Test_ EPIV_Max-Auto-Min 9m.bptts V'max — 3 minutes

Auto — 3 minutes

V'min — 3 minutes
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4.3 Reading out Sensors and Switches

The values from the integrated sensors and switches can be read out in MP
mode. This function must however be activated in advance under "General" in
the PC-Tool Options. Select Tools » PC-Tool Options in the main menu.

-

+# PC-Tool Options 53
Project base path

Release Codes

MF channel configuration |C:"-.Llsers"-.l't"l‘-"a'S.INGTES"-.Dcu:uments"-.BeIirno"-—.PCTu:uoI
WAV Compact Manufacturer [~ Use default

Air module

Water Globe module Language

ﬁiﬁ E?;ﬂ]gm modie |Eng|ish j The new language setting becomes active after a program I
WAV VRP-M module restart.

Log file

Fire & Smolce module
EPIV module

< I¥ Enable sensor reading functionality >

+ Filepermonth File per week
MP-Maonitor

I Enabla MP-Manitor
Simulation/Trend

I¥ Ask user if trendfiles should be saved.

Program update

Check for newer version

Settings for reading out sensors

A region with the sensor values will be shown on the Simulation tab, to the right
next to the actuator control.

Senzor
* Mone VYalue
" Active [0... 32V)
' -—-

& Tranzformahon
" Switch

[~

Sensor display in MP mode

Use the radio buttons to select the type of the connected sensor. The value is
displayed accordingly in either volts (active), ohm (passive) or as on/off (switch).

The raw value of the sensor can still be converted into the corresponding meas-
ured variable (temperature, etc.) with the help of the transformation table (see
chapter "Transformation table" from the general user manual).
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4.4 Recording Trends

=]

Trend Record ]

Stop Record [ |

Interval 10 s

Trend

The progression over time of the setpoint and actual values can be displayed in a
diagram during the simulation. The values are saved to a trend file and can be
displayed again at a later date. In addition, commentary texts of one's choosing
can be added.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

During the simulation, click on the "Trend Record" button. The display changes to
a "flat" button. Clicking once more will interrupt the recording.

According to the presettings, measured values are queried at one-second inter-
vals. You can change the querying interval in the interval input box. The permit-
ted values range from 0 to 9999 seconds, for which the value "0" means "no wait-
ing time" (querying as rapidly as possible).

If you wish to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. Shorter intervals cause too many data
points to be created and the time for plotting the curve between the queries could
become too short.

Stop Record || Comment... = |n'|c| Test AG_SR24A-CF__00444-30039-157-083_20130814_173715_trend bpttnd

Belimo Test AG, SR24A-CF,

100 st paint Tool |

D _ /
120
F
90
60 -
30
D ] '_‘—_'_’__—/-_’-_
T T T T T T T T T T
17:37:15 17:37:25 17:37:35 17:37:45 17:37:55 17:38:05 17:38:15 17:38:25 17:38:35 17:38:45
|— Set Poink [94] Actual Yolumetric Flow [[fmin]  —— ‘alve Position [%%]
Values to show Set Point [%&] [] Actual Voltage [V]
Actual Volumetric Flow [fmin] [ ] Set Voltage [V]
Comments Valve Position [3g]

Trend diagram for the control function "Flow control"
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Interval 1.0 5 Stop Record ] Comment_.. m |mo Test AG_SR24A-CF_ D0444-30035-157-085_20130814_173715_trend bpttnd
Trend

Belimo Test AG, SR24A-CF,

100 ek point Tool

&

D_/

%

60

30—//" RS

T T
17:37:15 173735 17:37:55 173815 17:38:35 17:38:55 173915 173335 17:3355 17:40:15 1740035 174055 17:41:15 17:41:35 17:41:55

|— Set Poink [%:] Actual Volumetric Flow [Ifmin]  —— Valve Position [%%]

Values to show Set Paoint [%a] [] actual voltage [V]

Actual Volumetric Flow [jmin] [ Set voltage [V]
Comments Valve Position [%4]

Trend diagram for the control function "Open loop"

You can use the comment button to enter a text at a defined point in time, which
is then saved in the trend file.
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5 PC-Tool Options for EPIV Module

Variant

Select Tools » PC-Tool Options in the main menu.

Right-hand mouse click on the program symbol in the overview bar and select

#+ PC-Tool Options

PC-Tool Options.

General

Release Codes

MP channel corfiguration
WA Compact Manufacturer
Air module

Water Globe module
WAV NMY-D2ZM module
VAV module

WAV VEP-M module

Fire & Smoke module
EPIV module

Main view

Default tab: Flow Unit:

|/min - |

=

Cancel ||

Dialogue for basic settings (EPIV Module)

Click on "EPIV Module" at the left.

Main window

In accordance with the most frequent usage, use the "Default Register" Com-
bobox to determine which tab is to be opened in the default settings when the
program is started up.

You can select the physical units for the volumetric flow with the Combobox vol-
ume display

I/min (litres per minute)

m3/h (cubic metres per hour)

I/s (litres per second)

I/h (litres per hour)

gpm (gallons per minute)
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1 Actuators for VAV controllers NMV-D2M

The current program version of PC-Tool V3.x does not support this type of

actuator. If you have installed the previous version (PC-Tool 2.1), you can use
this instead.

This device is not supported bythe currentversion of PCTool.
You canuse PC-ToolV2.1towork withthis device. Run PC-Tool ¥2.1

In order to rn PC-Tool %2.1 the current channel to the MP-bus has to be closed.
To continue warking with this wersion of PC-Toal:
11 Close external tool

&) Choose 'Open' in the context menu of the channel in the tree

Switch-over option for non-supported actuators

To enter the storage location of the program PC-Tool V2.1, select Tools » PC-
Tool options in the main menu. Mark the NMV-D2M module.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

= PC-Tool Options

General -
Fielenss Codes PC-Tool 2.1 path zetting:

MP charnel configuration | C-\Program FilesBelimoPC-T oo_47\BelmoPCT ool exe -]
Air module

water Globe module
Wk My -D 2 module
W' Compact module
Wak WERP-M module
Fire & Smoke module
EFP module

ak Cancel

PC-Tool settings for VAV NMV-D2M module

If you have stored the start path for PC-Tool V2.1 in the options, the tool starts
automatically as soon as a VAV NVM-D2M actuator is connected. To work with
PC-Tool V3.x again, you need to disconnect the connection to the drive.
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The current version of the program (PC-Tool 3.x) does not support this type of
actuator. If you have installed the VRP-M, you can use this instead.

The VRP-M controller is not supported by the PC-Tool V3 x.
You can start nowthe VRP-M Tool towork with this device.

The MP-Strang gets closed during the start fram the YRP-M Toal.

To continue PC-Toal V3x
1} close the YRP-M Tool
&) 'open' the MP-Strang (A right on the MP-Channel icon opens the menu).

Switch-over option for non-supported actuators

Run YRP-M Tool

To enter the storage location of the VRP-M tool, select Tools » Options in the

main menu. Mark the VAV VRP-M module.

Variant ~ Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.

= PC-Tool Options

General :
Fielenss Codes Path for VRP-M Tool:

MP channel configuration |E:'\F'mgram FileshBelimo'\WRP-M-Tool\WRPMT ool exe
Air odule

‘whater Globe module

WaY MMY-DZEM module

WaAY Compact module

".,.",.'l. VEP-M module

Fire & Smoke module

EFIN module

Cancel

PC-Tool settings for VAV VRP-M module

To prevent a conflict from occurring at the serial interface of the computer, the
MP-Channel is closed during the switch-over.

You have to open the MP-Channel again if you want to continue working with PC-
Tool 3.x. To do this, click the right mouse button on the MP-Channel in the
overview bar and select Open in the pop-up menu.
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1 Introduction

The User Manual of MPL-Module describes the detail area [D] of the MPL mod-
ule. The documentation describes the only available tab "service".

This module handles all Belimo manufactured MPL actuators.
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2 Service

2.1 Shows settings and provides a simple Simulation

The Service tab offers an overview of the current settings of the actuator as well
as a simple possibility to enter a set point and check the actual position (simula-

tion).
Type MPL-Actuator SN 01246-40046-000-200 |
Designation Address MP2
Position <
MPL
Service
Actual settings

Actuator settings (running time.....) are according to the specification.

Actuator information Adaption

Firmware 13%01.01-0000 Synchronization

Simulation

Set Point D% Actual Value 0%

State: Stop motor active

Service tab for MPL-Module

Meaning of the settings

Actual settings Actual settings (running time...) of a specific MPL actua-
tor can be taken from the specification sheet.

Firmware Actual version of the software in the MPL actuator.

Set Point Field to enter a Set Point in percent of the actual working

range (programmed range). 0% means Minimum, 100%
means Maximum.

Actual Value Shows the actual position of the actuator.
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2.2 Adaptation

Variant

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits (end stops).

Click the "Adaption" button on the Service tab to execute an adaptation.
The progress of the adaptation is displayed in the status line. The actuator moves
consecutively to both mechanical end stops.

You can also trigger the adaptation directly on the actuator.

2.3 Synchronization

In the case of synchronization, the actuator moves only to one mechanical end
stop in order to calibrate the origin.

Click the "Synchronization" button on the Service tab to start the synchronization
process.

2.4 Control of the actuator (Simulation)

Set Point Tool: Enter the Set Point in percent of the programmed (or adapted)
operating range. 0% means minimum, 100% means maximum.

Actual Value: Shows the actual angle of rotation or stroke position during simula-
tion process in percent of the programmed (or adapted) operating range.
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1 Introduction

The CM VAV module user manual describes the detail area [D] of the module for
CM VAV controllers. The documentation is divided according to the three index
tabs "Service", "Configuration" and "Simulation".

Note
For function and wiring, see CM-VAV product information
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the CM-VAV control-
ler.

Type CMV-125 SN 01324-30019-160-167
Designation Address MP1
Position

Service Configuration | =& Simulation

Actual setfings-
Mode OC0-10V
Volumetnc flow sefing Vnom 122 m3/h Vmax 83992 m¥'h  Vmid: 66 m3h V'min: 60 m3/h s hronizati
Nominal air velocity 2.0 m's ynchronization

Alt_of installation 550 mas.|.

Bus fail posiion Last value

Actuator information
Firmware 07 V01.05-0000

Data log
Operating ime 200h
Active ime 40h
Stop & Goratio 10%

State:

Register Service

The general part of this manual describes how you can print out the controller pa-
rameters [Section 3.6.2.].
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Meaning of the settings

Control signal Y Type of control

Volumetric flow Operating volumetric flow settings: V'nom / V'max / V'min /

settings V'mid
(only V'nom in open loop operation)

Nominal air velocity Air velocity when air flow is equal to V'nom

Behavior in the event of | Behavior in the event of a communication failure

bus failure

Firmware Software version of the CM-VAV.

Operating time Number of hours during which the actuator was connected
to the power supply

Active time Number of hours during which the actuator was mechani-
cally in motion and connected to the power supply

Stop & Go ratio Ratio of active time/operating time in percent. A high Stop

& Go ratio indicates unstable control
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2.2 Convert units for volumetric flow

The same settings as to VAV Compact apply to the CM VAV module.

Select Tools » PC-Tool options... in the main menu.
Click the "VAV- module” on the left.

With the Volume display combobox, you determine the physical units for the vol-

umetric flow

= m3/h (cubic meters per hour)
= |/s (liters per second)

= cfm (cubic feet per minute).

This setting is for all displays, printouts, labels and writing to the log file [see

General part of this manual].

P PC—TQOIDptionH .

1 =

VAW VRP-M module
Fire & Smoke module
EPIV module

|¥ Set adaption after the calibration process.

Calibration Compact D3
I~ Passive calibration with Vref and Ap@&\/ref

Pretime to Calibrate: 0 [0-9999s]

Altitude compensation
™ Ensable Altitude Compensation

R

Height a.5 1. unit:

General Main view

Release Codes Diefault tab: Flow Unit: Pressure Unit:

MP channel corfiguration

Air module | j |""'3"1'I ﬂ | Fa ﬂ
Water Globe module ¥ Flow input Option [22] field

VAV NMV-D2M module ow input. Option [%] fields

VAV module Calibration

carcel

L

2.3 Synchronisation

In the case of synchronization, a mechanical limit is approached in order to cali-

brate the position calculation.

To start, click the "Synchronization” button on the Service tab.

The progress of the synchronization is displayed in the status line.
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3 Configuration

In the "Configuration" box, parameter values can be read out from the VAV-
Compact controller, changed and stored in a text file. The valid ranges for the pa-
rameter values are displayed in parentheses next to the input boxes.

Type CMV-125 SN 01324-30019-160-167
Designation Address PP
Position

Service Configuration |1, Simulation

A

Designation | Read
Posifion |

Volume flow Write
V'nom 133 m3h MNominal air velocity |3 mis
V' max 50 m3h 60..132 m3h 63 % Store to file._.
V'mid 66 mh £0..89 m3/h 50 % Alt. of installation 550 mas.l.  0.3000
V'min 60 m3'h 0..29 m3h 45 %
Mode & 010V ¢ 210V Feedback U5 |VOIume contraller j

Reduce 'y

Bus fail position |Last value A

State: Stop motor active

"Configuration” tab

The extended input boxes in the bottom area become visible when you click "Ex-
pand".
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Designation

16 characters of any text

Position

16 characters of any text

Volumetric flow, nominal

V'nom

Nominal volumetric flow (read only value)

Nominal air velocity

Air velocity when air flow is equal to V‘nom

Volumetric flow range during operation

V'min Lower limit of operating volumetric flow setting
V'mid CAV level between V'min and V'max
V'max Upper limit of operating volumetric flow setting

You can convert the physical units for the volumetric flow via Tools » PC-Tool op-
tions in the main menu [see Section 2.2.].

In the options, you can also define whether the input of the volumetric flow for
V'min and V'max in percent is possible.

An existing value for V'mid is automatically adapted when V'min and V'Max are
entered: If you enter V'min, V'mid is always larger than or equal to this input val-
ue. If you enter V'max on the other hand, V'mid is always less than or equal to

this value.

Mode (positioning signal Y / feedback U5)

0..10V Sets positioning signal Y =0 ... 10 V,
feedback U5 = volumetric flow, 0 ... 10 V

2..10V Sets positioning signal Y =2 ... 10V,
feedback U5 = volumetric flow, 2 ... 10 V

Behavior in the event of bus failure

Last setpoint

Volumetric flow according to the last received setpoint
from the MP master

Open Move to full angle of rotation/stroke (100%)
Close Move to zero stop

Min / V'min V'min volume

Max / V'max V'max volume

1 Only characters from the Western European character set are permitted for "Descrip-
tion" and "Position" (see General part, table in Section 4.3.3).
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4 Controller simulation

Go to the "Simulation" tab.

Type CMV-125 SN 01324-30019-160-167
Designation Address MP1
Position

Service | Configuration  Simulation

Actuator N Sensor
" Simulaonoff * Close | Setpoint Flow Duct Damper &+ None Value
. i - -10.0 0.0 237 - 73 —]
Setpo!rl‘r V'IN?I'I'\ | z | z | c | % " Active (0_...32V)
" SetpointTool  V'min 0 m3/h 0.0 mjs ~ l—_
" Motor Stop " V'max mv
" Open " V'mid ) : 5 5 Transformation
Active ovemide step: Close B
" Switch <No table>
Test  m [Testile |<Notestscript> -]
Interval 10% Stop Record ] Comment... (=] |3nd files"Test PC-Tool W3.9_CMV-125__01324-30013-160-167_20130828_151746_trend bpttnd
Trend
Test PC-Tool V3.9, CMV-125,
= 100
=
2 =,
oo 3 p o
| open | Close
- <
o 1L A
£ 100
S0
0 -
T T T T T T T T T T T T T T T T T
15:17:40 15:117:46 15:117:50 15:17:52 15:17:594 1511756 15:17:55 15:15:00 15:15:02 15:15:04 15:15:06 15:15:05 15:15:10 15:15:12 15:15:14 15:15:16 15:18:15
|—Set Point [m3/h] Max Position [m3/h] Min Position [m3/h] Actual Yolumetric Flow [m3fh] —— Actual angle [3&]
Values to show Set Point [m3/h] Actual Volumetric Flow [m3/h] [] set voltage [v]
Max Position [m3/h] Actual angle [%] ] air velocity [m/s]
Comments Min Position [m3/h] [] Actual voltage [V] [] Temperature [C]

State:

"Simulation" tab

The controller simulation is influenced when the actuator is currently carrying out
a synchronization. The function "Motor stop" overrides a running adaption or
synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.
= Setpoint Y: Positioning signal at the connection Y.

= Setpoint Tool: The setpoint is entered in % of the volumetric flow (0% corre-
sponds to V'min, 100% V'max).

The control is switched off when you click Motor stop.

The following overrides can be specified via radio button.
= OPEN: Damper completely opened
= CLOSED: Damper completely closed
= \V'nom: Nominal volumetric flow
= V'min: Volumetric flow V'min (0%)
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4.2 Test

= V'max:  Volumetric flow V'max (100%)
= \V'mid: CAV volumetric flow V'mid

Measurement values

The following are displayed:

= The setpoint in V or percent or m¥h, I/s or cfm

= The actual volumetric flow in 0 ... 100% of V'nom

= The actual volumetric flow in m3/h, I/s or cfm

= The feedback voltage in V (U5 signal)

= Actual air velocity [m/s]

= Actual air temperature in the duct [°C]

= The damper opening in %

= An active override is displayed as text, independent of whether they were spec-
ified by the PC-Tool or externally (positioning signal Y).

The trend lines can be fade in or out by selecting the corresponding checkbox.

The function test is available for the structured test of the VAV boxes.

Several consecutive commands [see 4.2.1] are defined in a test script file. When
the function is started, a trend recording is triggered.

Select test file
Select the desired script with the test file combobox.

Start test script
Click the test button * .

Important note

Before starting the actual script, the application checks whether the air
flow/system pressure is sufficient for the actuator test. (If the system pressure is
insufficient, this test can last up to 3 minutes.)
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4.2.1 Test scripts

The following test scripts are available.
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Name of the test file

Functions

Basic_VAV_Test Max-Min 5m.bptts

V'max — 2 minutes
V'min — 2 minutes

Test VAV_0 CAV (Open-Max-Min-Close)
8m.bptts

Open — 1 Y2 minutes
V'max — 2 minutes
V'mid — 2 minutes
V'min — 2 minutes
Close — 1 % minutes

Test VAV_Max-75-50-25-Min-Close 3h.bptts

Open — 2 minutes
V'max — Y2 hour
SetPoint 75% — Y2 hour
SetPoint 50% — Y2 hour
SetPoint 25% — Y2 hour
V'min — % hour

Test_ VAV_Max-Auto-Min 9m.bptts

V'max — 3 minutes
Auto — 3 minutes
V'min — 3 minutes

Test_VAV_Max-Auto 6m.bptts

V'max — 3 minutes
Auto — 3 minutes

Test_VAV_Max-Mid-Min 9m.bptts

V'max — 3 minutes
V'mid — 3 minutes
V'min — 3 minutes

Test_VAV_Max-Min-Max[ 1_Percent ]
37m.bptts

SetPoint 100% - 2 minutes
(afterwards in steps of 1%)
SetPoint 99%...0% - every 10 sec-
onds

SetPoint 1%...100% - every 10 sec-
onds

Test_ VAV_Max 3m.bptts

VMax — 3 minutes

Test_ VAV_Open-Max-75-50-25-Min-
Close22m.bptts

Open — 3 minutes
V'max — 3 minutes
SetPoint 75% — 3 minutes
SetPoint 50% — 3 minutes
SetPoint 25% — 3 minutes
V'min — 3 minutes

4.3 Reading out sensors and switches

The values of integrated sensors and switches can be read out in MP mode. This function, however,
must be activated in the PC-Tool options "General" in advance. Select Tools » PC-Tool options... in the

main menu.
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& PC-Tool Options

—

Project base path

Release Codes

MP channel configuration |C:"-.Users"-.l"."l‘-"a'S.|NGTES"-.Dou:umerﬂs"—-.EeIimo"—-.PCTooI
WAV Compact Manufacturer [~ lRe deeadt

[ Enable MP-Manitor
Simulation/Trend

Iv_ia er if trendfiles should be saved.
Ensor reading functionality

Program update

Check for newer version

|

Air module
Water Globe module Language
xiﬁ ::Td"‘lul'lgzm module |Eng|ish j The new language setting becomes active after a program
VAV VRP-M module Lousi restart.
Fire & Smolke module et ills
EPIV module (* Filepermonth File per week
MP-Meonitor

I

On the Simulation tab, a section with the sensor values is displayed to the right of

the actuator control.

Sensor

* Mone Value

" Active (0...32V) -

& —

e Transformation
" Switch |<ND table>

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either

displayed in volts (active) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the

"Transformation table" section in the General User Manual)
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4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed lat-
er again. Furthermore, you can add any comment texts you would like.

= On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Trend Recod # | Click the "Trend Record" button during simulation. The display changes to a "flat"

button. The recording stops when you click again.

Stop Record B  The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Trend
Belimo Test AG, CMV-125, CM VAV
=
)
= 200
IDD 7 e ’ oy
|‘ Close | | open |
A | s
0 7
£ 120 4
90
&0
30
D -

17257 1A 1209 171301 1A 1303 171305 1A307 171309 113 1313 1nIals 1737 1R l3 19 1R 2L IREE3 12 Inlser

|— Sollwert [m3/h] Max Einstellung [mi3fh] Min Einstellung [r3fh] volurnenstrom [m3fh]  —— klappenstellung [%:]

Values to

show Sollwert [m3/h] Volumenstrom [m3/h] [] sollwert in Volt [v]

Maix Einstellung [m3/h] Klappenstellung [3:] [ Luftgeschwindigkeit [m;s]

Comments Min Einstellung [m3/h] [] 1stwert in volt [V] [] Temperature [#C]

T

rend diagram

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the sampling interval. If the interval is shorter, too
many data points will result and the time for correcting the curve between the
queries can become too short.
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5 PC-Tool options

Variant

For the CM-VAV module the same options as for VAV compact module are valid.
Select Tools » PC-Tool options... in the main menu.

Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

#r PC-Tool DptionsH = 1 ﬁ

General

Release Codes

MP channel configuration
Air module

Water Globe module
WAY NMY-DZM module
VAV module

VAV VRP-M module

Fire & Smoke module
EPIV module

Main view

Calibration

Altitude compensation

Diefault tab: Flow Unit: Pressure Umt:

| 1 [ T I =]

¥ Flow input: Option [%] fields

[v Set adaption after the calibration process.
Calibration Compact D3
[ Passive calibration with \Vref and Ap@Wref
Pretime to Calibrate: 0 [0-9999s]

[ Enable Altitude Compensation
Height a.5.1. unit: m ﬂ

|
‘ -

0 Canoe;l

Dialog for basic settings (VAV-module)

Click the "VAV-module" on the left.

Main window

Depending on the most common application, set which tab should be opened by
default when the program is started with the "Default tab" combobox.

With the Volume display combobox, you determine the physical units for the vol-
umetric flow.

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute)

If you would like to have the option of entering the volumetric flow as a percent-
age, activate the "volumetric flow input: Option [%] boxes" checkbox.

Altitude compensation

The altitude compensation can be activated through the checkbox. The actuator
is then able to supply, on the basis of the entered altitude of installation in the
configuration tab, the altitude compensated differential pressure and the altitude
compensated flow rate values.

With the Height a.s.l(above sea level) unit combobox you can determine the
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physical units for the operating altitude of the plant
= m (Meter)
= ft (Feet)
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1 Introduction

This user manual is directed toward Belimo system integrators and employees
who use the MP-Monitor for analyzing data traffic and for diagnosing problems on
networks with the MP-Bus.

The MP-Monitor allows system monitoring without malfunctions caused by the
PC-Tool as MP master.

All recorded values are stored with timestamp in files for later evaluation and
documentation (see Section 2.6 "Log files").
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2 Functions

2.1 Preparations

Connect the MP-Bus to a serial (COM) interface of your computer as described in
Section 3 "Wiring diagrams". If you start the MP monitor from the PC-Tool
application, the same serial interface is used which is configured for the MP-
Channel.

In order to use another serial interface, you can start the MP-Monitor outside of
PC-Tool (see below).

2.2 Start MP-Monitor

In order for you to be able to use the MP-Monitor, you must activate the
corresponding function in the PC-Tool options under "General".

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

++ PC-Tool Options Iﬁ

General - .

Release Codas Project base path:

MP channel corfiguration |C-\Users\dba‘\Documents" Belimo \PC Tool J
VAV Compact Manufacturer [~ |ze default

Air module

Water Globe module

VAN NMV-DZM module Language:

EiE Ean;pr?qc; m:le [English x| The new language setting becomes active

after a program restart.
Fire & Smoke module

EPIV module Log file:
" File perweek 1 File per month

[v¥ Enable MP-Monitor
Simulation/Trend

=1t trendfiles should be saved.

[ Enable sensor reading functionality

%

Settings for activating the MP-Monitor

Then select MP-Monitor » Start MP-Monitor in the main menu or click the "Start
L@_’ MP-Monitor" icon in the toolbar.

The PC-Tool program window is closed and a console window (DOS box) is
displayed for selecting the operating mode.
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Start MP-Monitor outside of PC-Tool

In order to use another interface other than the one configured in PC-Tool, close
the PC-Tool program. In the Explorer, change to the installation directory of PC-
Tool (default 'C:\Programme\Belimo\Belimo PC Tool V3.x")

If you start the MP-Monitor outside of PC-Tool, you have to have write
authorization in the installation directory of PC-Tool since the log files are stored
there.

Execute the program by double-clicking on the program "mp_mon.exe". A
console window (DOS box) is displayed.

Selection of the serial interface COML1...COM15
With the specified buttons '1', '2', ...'f', you can select the serial interface which is

connected with the MP-Bus.
Afterwards, the window for selecting the operating mode is displayed.
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2.3 Select operating mode

e+ CAProgramme\Belimo\Belimo PC Tool V3.2\mp_mon.ex

F1: MP logging on command level
F3: MP logging on application level

ESC: exit

Select the operating mode

Select the operating mode with the function key 'F1' or 'F3":

F1: Display of commands which are sent over the bus (communication
analysis)

F3: Display of positions, control and sensor values (application analysis).

2.4 Communication analysis (F1)

= CAProgrammel\Belimo\Belimo PC Tool V3.2Ymp_mon.exe

[ MP-MONITOR <u3.1> |[ comt |[ MoDE1 | m [ BACKSPACE: clear | m

In the communication analysis, commands are recorded which are sent over the
MP-Bus. The transferred data bytes and checksums are represented as
hexadecimal numbers.

CHit#> ADR D1 D2 D3 D4 DS D6 A D4 D5 D6 D?

Start window of the communication analysis

The capture of the traffic starts automatically and can be stopped by pressing the
'D' button.

Press the 'E' button to start the recording again.

You can delete the display with the Backspace key and close the program with
the Escape key.
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e C:A\Programmel\Belimo\Belimo PC Tool V3. 2\mp_mon.exe

MP-MOMITOR <U3Z.1> D: disable Ba

COMMAND CHiH> ADE D1 D2 D3 D4 DS D6 A D2 D3 D4 D5 D6 D7?
PEEK {(B@1> MP1 FB 18 @7 56 32 34 4C 4F 4E
PEEK (B@1> MPF1 FB 17 @7 55 53 28 28 28 28
PEEK (B@1> MP1 FB 1E @2 28

GET_SERIESHO (A58> MP1 72

SET_FORCED_CONTROL (814> MP1
SET_RELATIVE (A37> MP1
GET_RELATIVE (B41> MP1
GET_TRANSIT_TIME (@32> MP1
PEEK (881> MP1
PEEK (8@1> MP1
PEEK (B@1> MP1
GET_SERIESHO (a58> MP2
SET_FORCED_CONTROL (814> MP1
SET_RELATIVE <A37> MP1
GET_RELATIVE (841> MP1
GET_TRANSIT_TIME (A32> MP1
GET_SETTINGS a12> MP1
GET_SERIESHO (B58> MP3
SET_FORCED_CONTROL <Ai14> MP1
SET_RELATIVE (B37> MP1
GET_RELATIVE (841> MP1
GET_TRANSIT_TIME (832> MP1
GET_MIN_MID MAX (A59> MP1

a8
D8 88 46

¥
¥
¥
¥
¥
¥
¥
¥
¥
¥
¥
N
¥
¥
¥
¥
¥
|
¥
¥
¥
¥

Recording of communication over the MP-Bus

Meaning of the display

Column Description

COMMAND Name of the command

(###) Command code

ADR MP address

D1...D7 Data bytes, hexadecimal

A "Y' = response, 'N' = no response

Additional information is contained in the log file, which is written parallel to
recording (start byte, check bytes). See also Section 2.6.1 "Communication
analysis log file".
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2.5 Application analysis (F3)

In the application analysis, the MP-Monitor does not show the individual
commands, but the configuration settings, set/actual positions, volumetric flows
for VAV actuators and sensor values.

e CAProgrammelBelimoi\Belimo PC Tool V3.2Y\mp_mon.exe

MP-MONITOR <v3.1> || comi || mopE3 BOCKSPACE: clear

Type Designation Poszition String
Act_pos Range Act_vol Unom Min_Max t_run Direction
MM State Adapt-Snyc-Test

Start window for the application analysis

The capture of the traffic starts automatically and can be stopped by pressing the
'D' button.

Press the 'E' button to start the recording again.

You can delete the display with the Backspace key and close the program with
the Escape key.

e C:\Programmel\Belimo\Belimo PC Tool V3.2\mp_mon.exe

MP-MONITOR <U3.1> _ D: disable || BACKSPACE: clear

Address

Ceries—HNo Type Designation Position String
Override Stpt Act_pos HRange Act_vol Unom Min_Max t_run Direction
Sensopr MM State Adapt-Snyc-Test

MP1

AA626-20013-128-853 MUZ24-MFT2 AVY24-MFT

NONE a 27 23.7mm @::_188:
B880881 8

MP2

HA6H?-38251-142-136 LM24A-MP

NONE a 8 ?3.8° B _188:
a]5]l5 15505 ]0)

MP3

A1234-A56783-146-897 LMU-D2-MP ABC-B1 — Size2%@ Floor 1h

NONE =, a 25.10 a:: 688m3 h @::_188: 158s cu
B8808BHA

MP47?

Recording for positions, control and sensor values

The MP-Monitor does not determine the configuration settings actively by reading
them out of the actuator, but collects the data transmitted over the MP-Bus. For
this reason, the display is built up slowly, step-by-step. If the MP-Master does not
query a piece of information, then it is also not displayed.

The recording per bus address consists of four lines. To interpret a value, see the
corresponding line and position in the table header.
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Column Description

Address MP address of the actuator
Serial no. Serial number of the actuator
Type Actuator type

Designation Designation

Position string Position

Override Digital override via MP-Bus

Stpt Setpoint

Act_pos Actual position

Range Angle of rotation/stroke range
Act_vol Actual volumetric flow (VAV only)
Vnom Nominal volumetric flow (VAV only)
Min_Max Minimum & maximum of the range
t_run Running time

Direction Rotation/stroke direction

Sensor Sensor value

MM state see below

Adapt/Sync/Test Adaptation, synchronization or test active
MM state

Messages which are set in the actuator (bit representation)

Explanation:

If all bits are set to 0, no message is set in the actuator.

If individual bits are set to 1, this means that the corresponding messages are
active and are set in the actuator.

O

222222 T
Excessive utilisation (active if 1 is set)

Mechanical travel increased (active if 1 is set)

Mechanical overload (active if 1 is set)

Fail-Safe fail (active if 1 is set)

(Used by fire smoke dampers only)

The messages can be seen in plain text in the respective PC-Tool module.
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The log files of the MP-Monitor with the recordings are stored in the user-specific
project directory of PC-Tool (default 'C:\Documents and Settings\<Name>\My
Documents\Belimo\PCTool\<Projekt>\monitor files\).

The program stores files for every program start with current date and time ('mp
2012-11-23 14-25-30.txt"). For records over a longer period, a new file will be
saved every 24 hour.

2.6.1 Communication analysis log file

Date: 21.07.2008
Time: 15:51:58

15:51:59.34 MP1 SET FORCED CONTROL
15:51:59.39 Y

15:51:59.48 MP1 SET RELATIVE
15:51:59.53 Y

15:51:59.59 MP1 GET RELATIVE
15:51:59.69 Y

15:51:59.78 MP1 AD CONVERT
15:51:59.83 Y

Each entry consists of 2 lines. The first line shows the sent command, and the
second line, marked with 'Y' shows the response.

Column Description

adr MP address

command Name of the command

(###) Command code, decima

st Start byte, hexadecimal

cc Command code, hexadecimal

d1...d7 Data bytes, hexadecimal

cl Cross parity (check byte), hexadecimal
c2 Length parity (check byte), hexadecimal
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2.6.2 Application analysis log file

This log file contains the data transmitted over the MP-Bus in chronological order
in a readable format.

21.07.2008;15:52:26.24;MP1; Type; LR24A-MP
21.07.2008;15:52:27.08;MP1;0Override; NONE
21.07.2008;15:52:27.22;MP1; Setpoint; 0;%
21.07.2008;15:52:27.38;MP1;Actual position; O
21.07.2008;15:52:27.53;MP1;Sensor Value; 0.4;V
21.07.2008;15:52:27.69;MP3;0verride; NONE
21.07.2008;15:52:27.81;MP3;Setpoint; 0;%
21.07.2008;15:52:27.99;MP3;Actual position; 10;

.

r ©

o°

Each entry consists of several values which are separated from each other by
semicolons:

= Date
= Time

= Bus address

=  Property
=  Value(s)
= Unit(s)

Evaluation with MS Excel

For an easy-to-understand illustration and evaluation, the text format of the MP
log files can be opened directly with the MS Office application Excel.

When opening in Excel, select "Text files (*.prn, *.txt, *.csv)" as the data type and
the semicolon (;) as the separator.

With the autofilter function (Data menu * Filter » Autofilter), comboboxes are
shown in the first lines of the tables. There you can select the bus addresses or
properties which you are interested in.

The filtered values can be displayed as a diagram, for example.
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3 Wiring diagrams

3.1 Mode switch set to "MO" (monitor)

Note:

4
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The mode switch on the ZIP-USB-MP must be set to "MO" if working with
the MP-Monitor.

The mode switch must first be set to "MO" before the MP-Monitor can be
opened in the PC-Tool.

Attention: ZIP-USP-MP devices off a newer generation have no switch to

toggle between MO and MA operating mode. These devices switch
automatically into Monitor mode when Monitor tool has been started.
Precondition: The Monitor tool has a Version number V3.5 or higher.

3.2 Diagram Variant 1 with ZK2-GEN cable

Switch position ,MO* RJ1 1 (4/6) UK. ..Gateway
USB 2.0 cable r
- BELIMO
Belimo @ & ZK2-GEN
o O Enabl:
PC-Tool |5 2/ g £ GND 24V MP
8 = white = GND j—W
Q blue = not connected
ZIP-USB-MP € green = MP
— USB o (/)-(Z)f)
MP
@ @ @
MP-Bus - L d
....A-MP ....A-MP ...A-MP ....A-MP ...A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
MFTR) || MFTE) || MFT@) || .MFT@) || ..MFT@) || ..MFT(2)

MP-Master
DDC Controller
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3.3 Diagram Variant 2 with ZKS-MP cable

4
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MP-Bus

UK24LON/EIB BELIO
O o o | g oo
=k ® | © © ©
LonTalk MP-Com. Power
USB 2.0 cable Switch position ,MO“ a b 0V_24V_Y_U/MP 0V 24V n.c.
EE) ogog EELE
- BELINIO I
E O Enable %
S e $ 3pol
8 = —I
ZIP-USB-MP 43
usB AC24V 1 ~
DC24V — +
ZKS-MP |
L 2 L 2 L 2 L L 4
@ @ @ @ L
....A-MP ....A-MP ....A-MP ....A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
..MFT(2) ...MFT(2) ..MFT(2) ..MFT(2) ..MFT(2)
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1 Introduction

The VAV-Universal (VRU) user manual describes the detail area [D] of the mod-
ule for all versions of this product (VRU-D3-BAC, VRU-M1-BAC, and VRU-M1R-
BAC). The documentation is divided accordingly to present the specific character-
istics for each product family.

VAV-Universal product range

The modular structure of the VAV-Universal controller product range with inte-
grated differential pressure sensor enables the ideal combination of controller
and damper motorization. With this product range, individual solutions for all spe-
cial applications in the field of ventilation can be created.

Applications

¢ Volumetric flow VAV/CAV.
¢ Volumetric flow summation.
e Duct and room pressure.

Differential pressure sensor

¢ D3 — Flow (dynamic) suitable for comfort zone.
¢ M1 — Diaphragm (static) suitable for polluted air.
¢ MI1R - Diaphragm (static) for room pressure control.

Note

For function and writing, see VAV-Universal product information
VRU-D3-BAC, VRU-M1-BAC, VRU-M1R-BAC
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2 VRU-D3-BAC / VRU-M1-BAC

2.1 Displayed settings

PC-Tool gives in a single tab an overview of the current settings of the VRU-D3-
BAC or VRU-M1-BAC controller.

Type VRU-D3-BAC SN 21947-30009-032-029 : \/
Designation QUIX Line DN125 Address PP i
- .
Position Room 345G 2T
ol
Basic Settings Application Control Settings Y / U
Designation QUIX Line DN125 Setpoint Offset 50.50% e
Position Room 345G Setpoint Signal DC variable w Write
Application Type VAV Control v Start 0.5.80VDC
Control Type VAVCAV v Stop 26.100V0C HinBiie-
Pressure Cascade Off ~ Feedback Parameter Flow ~
OEM Settings Feedback U DC 2-10V v
Vnom 450 ..50000 m3h - Enable Trend
Lp@\nom_Cal 150 38.500 Pa Active Time o h
Altitude of Calibration 200/ 0.3000m Operating Time 0| h
Dir. of Rotation cow ~ Changes In Direction 84
NFC Interface Read/write Mechanical Overloads 67
Project Settings Actuator State oK
Altitude compensation  |On w Simulation
Altitude of installati 410 0.3000m Contral Simulation off -
Vmax 324| 90.450 m3‘h Applied Setpoint 216| m3h
Vmin 324 m3th Airflow absolute 0| m3h
Communication Mp 1/ Pa
Bus Protocol Mp - Damper pesition 100
Compatibility-Mode Standard - Adaption # Synchronization / State
Actuator Settings Synchronization Synchronisation
Serial Number Actuator | 01935-30043-140-126 Adaption Adaption
Synchronization at Y=0i e State Control
Power ON behavior Mo action ~
MNominal range Adapted ~
Mominal range 93.37 .96.00"°
Main view of a VRU-D3-BAC device
Type VRU-M1-BAC SN 21939-30017-032-029 \/
Designation Address PP é
Position Buero Hinwil R

Difference in the view of a VRU-M1-BAC device

The displayed settings will vary depending on the application selected for the de-
vice and the specific settings of every available field.

A description of the available settings, as well as the applications were they are
visible, can be found in the table below.
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Settings Description )
S| 4| 3
S @ 4
Q (O]
S| =| &
> = 3]
o
| 2| 3
Basic Settings
Designation Description of the device. 16 characters of any text. X X X
Position lgitnuﬁcatmn of the location / plant of the device. 32 characters of any X X X
Application Type Active application (VAV-Control / Flow Meas. / Pressure control) X X X
Control Type? Active control type (VAV-CAV / Position control) X
Room Pressure cascade application (On / Off)
1
Pressure Cascade Enables VAV unit as: Secondary circuit VAV. X
OEM Settings
V'nom? Nominal volumetric flow rate (OEM parameter). X X
OEM specific parameter set by the manufacturer of the VAV-box.
Calibration value (OEM parameter)
Ap@V'nom_Cal* OEM specific parameter set by the manufacturer of the VAV-box X X
during the calibration run.
Altitude of Altitude at which the VRU controller is calibrated. X X
Calibration® OEM specific parameter set by the manufacturer of the VAV-box.
1 Nominal pressure. Specific parameter set by the manufacturer of the
Pnom : X
control damper solution.
Controller Sensitivity Defines sensitivity of the controller (0.10-10.00) X
Controller Deadband Defines the dead band of the controller (1.0-10.0 %) X
Dir. of Rotation Damper actuator opening in clockwise / counterclockwise direction. X X
NFC Interface NFC mode (Read / Write). X X X
Project Settings
Altitude Compensation | Enables altitude compensation calculations (On / Off) X X X
Altitude of Installation | Operating altitude of the plant. X X X
V'max / Pmax / max Upper limit of_operatmg voIqme_tnc flow / pressure / damper position X X X
setting (Relative to the application selected).
V'min / Pmin / min Lower limit of_operatmg voIqme_tnc flow / pressure / damper position X X X
setting (Relative to the application selected).
Suppresls damper Enables damper leakage compensation calculations (On / Off) X
leakage
Communication
Bus Protocol Defines bus protocol used (MP / BACnet MS/TP / Modbus RTU) X X X
Compatibilit Only used in existing MP-Bus systems, in case a VRP-M is replaced
Modg y by a VRU controller (MP address 1...8) X X X
(Standard / VRP-M)
MAC Address? Defines the address of the actuator (BACnet: 1-127 / Modbus: 1-247) X X X
Defines the communication baud rate.
1
Baudrate (9600 / 19200 / 38400 / 76800 / 115200) X | X X
Terminating Resistor! | Terminating resistor is present in bus (On / Off) X X X
Instance Number?! Defines BACnet instance number (1-4194304) X X X
Device Name? Defines BACnet device name. 32 characters of any text. X X X
Max. Master! Defines maximum BACnet Master (1-127) X X X
Parity! Defines Modbus parity (1-8-N-2 / 1-8-E-1 / 1-8-O-1/ 1-8-N-1) X X X
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Actuator Settings
Serial Number* Shows the serial number of the actuator. Read only X X
Synchronization at Stop position 0% or 100%. X X
Power ON behavior Behavpr when system is swnchgd on or after a voltage interruption X X
(No action / Adaption / Synchronization).
Nominal range Angle of rotation range, defines the range limitation (Adapted / Pro- X X
(Menu) grammed)
Nominal range Adapted: To the range of rotation from the mechanical stop settings.
X : : X X
(Number) Programmed: Selects the maximum angle of rotation.
Application Control
Settings Y/ U
Setpoint Defines the source of the setpoint received (Bus / Analog). X X X
. Room pressure balance, offset for exhaust air box.
Setpoint Offset (+/- correction to the received setpoint signal) X
Setpoint Signal Defines the setpoint signal type X X
0...10V Fixed operating range from 0 to 10 V X X
2..10V Fixed operating range from 2 to 10 V X X
Variable Voltage range can be defined: Start 0.0...8.0 V/ Stop 2.0...10.0 V X X
Range between start and stop must be at least 2 V.
Feedback Parameter Defines the feedback received (Position / Flow / Ap) X X X
Feedback U Defines the feedback signal type X X X
0...10V Fixed operating range from 0 to 10 V X X X
2..10V Fixed operating range from 2 to 10 V X X X
. Voltage range can be defined: Start 0.0...8.0 V/ Stop 2.0...10.0 V
Variable Range between start and stop must be at least 2 V. X X X
Installation
Active Time?! Motor active time in hours. X X X
Operating Time Powered time in hours. X X X
Changes in Direction! | Direction change counter. X X
Mechanical Overload® | Mechanical overload counter. X X
Actuator State Feedback Status from actuator (OK / Cannot Move / Gear disen- X X
gaged / Travel increased / Actuator doesn't match)
Simulation
Control Actuators behavior for the simulation (Open / Close / V'nom, P'nom/ X X
V'mix, P'min, Min / V'max ,P'max, Max / Motor Stop / Setpoint %)
Applied Setpoint Actual defined setpoint (Units depending on Application) X X
Airflow absolute Actual airflow value X X
Ap Actual Ap Value X X X
Damper position® Actual damper position X X
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Synchronization /
Adaption / State
Synchronization I\_/Iovesl,l to a mechanical limit (according to the setting "Synchroniza- X X
tion at").
Adaption Moves to both mechanical limits and recalculates angle-dependent X X
parameters.
Shows status of the actuator. If no synchronization or adaption is in
State : - " X X
progress, the displayed value is "Control".

! The visualization of the setting is influenced by the overall settings of the controller and / or release codes.

2.2 Flow measurement Application

Volumetric flow measuring device (transmitter) for recording or monitoring a vol-

umetric flow.

For a more detailed information about the application, please consult the docu-

ment Room and system applications with VAV-Universal.

Type VRU-D3-BAC SN 21947-30009-032-029
Designation QUIX Line DN125 Address PP
Position Room 345G
Basic Settings Application Control Settings ¥ / Ll
Designation QUIX Line DN125 Setpoint Bus ~
Position Room 345G Feedback Parameter Ji's] w
Application Type Flow measurement w Feedback U DC 2-10v w
QEM Settings Installation
Vnom 450 ..50000 m3h Operating Time o h
Lp@E\Vnom_Cal 150, 38..500 Pa Simulation
Altitude of Calibration 200 0.3000m Airflow absolute m3/h
NFC Interface Read /write Lp 1| =
Project Settings
Altitude compensation | On e
Altitude of i 410| 0.3000m
Communication
Bus Protocol Modbus RTU ~
Address 1.247
Baudrate 38400 ~
Terminating Resistor Off w
Parity 1-8-N-2 i

View of a VRU-D3-BAC device with Flow measurement application active

N

“== [}

W)
et

Read
Write

Store to file...

Enable Trend
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2.3 Flow Control Applications

VAV - Variable or CAV - Constant air volume control

o Variable air volume control (VAV): V'min ... V'max.
o Constant air volume control (CAV): Damper Closed / V'min / V'max /
Damper open.

Position Control (Open-Loop)

VAV-Universal VRU-... sensor / actuator in Position Control mode (Open-Loop,
VAV control function inactive).

0 Volume flow: Display 0 ... 100% of V'nom.
o Damper actuator: Control O ... 100% of actuators rotation range.

For a more detailed information about the application, please consult the docu-

Type VRU-D3-BAC
Designation QUIX Line DN125

Basic Settings

Designation
Position
Application Type
Control Type

QEM Settings

Vnom
Ap@\Vnom_Cal
Altitude of Calibration
Dir. of Rotation

NFC Interface

Project Settings

Altitude compensation
Altitude of installation
Max

Min

Communication

Bus Protocol

Compatibility-Mode

SN 21947-30009-032-029

ment Room and system applications with VAV-Universal.
Address PP . \/

Position Room 345G e /'
ok
Application Control Settings ¥ / Ll
QUIX Line DN125 Setpoint Offset 50.50% Read
Room 345G Setpoint Signal DC variable ~ Write
VAV Control v Start 05.80VDC
Postion Cortrol Siop 26.100VDC HiETils
Feedback Parameter Ji's] w
450 ..50000 m3th Feedback U OC 2-10v -
150| 38.500Pa Installation Enable Trend
2 0..3000 m Active Time 0| h
cow ~ Operating Time 0| h
Read/write Changes In Direction 84
Mechanical Overloads 65
On - Actuator State oK
DT Simulation
20.100 % Control Simulation off -
2% Applied Setpoint 216/ m3h
Airflow absolute m/h
ME ~ p 1 Pa
Standard > Damper position

Actuator Settings
Serial Number Actuator

Synchronization at
Power ON behavior
Mominal range

Mominal range

01935-30043-140-126

Y=0%
No action

Adapted

Adaption / Synchronization / State

Synchronization Synchronisation

Adaption Adaption

State Control

.96.00°

View of a VRU-D3-BAC device with VAV Control application active
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2.4 Duct Pressure control Application

Duct Pressure control

0 Modulating (STP): P'min ... P'max.
0 Constant pressure control (STP): P'min / P'Max / Damper Closed / Damper

open / Motor stop

e
BELIMO

For a more detailed information about the application, please consult the docu-

ment Room and system applications with VAV-Universal.

Type VRU-D3-BAC
Designation QUIX Line DN125
Position Room 345G

Basic Settings

Designation QUIX Line DN125

Position Room 345G

Application Type Duct Pressure w
QEM Settings

P'nom 250 38.500 Pa

Controller Sensitivity 0.10.10.00
Controller Deadband +- 50| 1.0.100%

Dir. of Rotation cow ~
NFC Interface Read /write

Project Settings

Altitude compensation | On w
Altitude of installati 410| 0.3000m
P'max 180| 50..250 Pa
P'min 180 Pa
Communication

Bus Protocol MP ~
Compatibility-Mode Standard w

Actuator Settings

Serial Number Actuator | 11935-30043-140-126

Synchronization at Y=0% w
Power ON behavior No action ~
Mominal range Adapted w
Mominal range 93.37 .56.00 °

SN 21947-30009-032-029

Address PP

Application Control Settings ¥ / Ll

Setpoint Signal DC variable w

Start 0.5.8.0VDC

Stop 26.100VDC

Feedback Parameter s} w
Feedback U DC 210V w
Installation

Active Time 0 h
Operating Time 0| h
Changes In Direction 84
Mechanical Overloads 65
Actuator State oK

Simulation

Control Simulation off =
Applied Setpoint 120, Pa
Ap 1/ Pa
Damper position 50

Adaption / Synchronization / State

Synchronization Synchronisation
Adaption Adaption
State Control

v

Read

Write

Store to file...

Enable Trend

View of a VRU-D3-BAC device with Duct Pressure application active
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2.5 Enable Trend functionality

|Trend Record [ ] I

At any moment, the time progress of the setpoint and actual values can be dis-
played in a plot. This graphic can be visualized through the button "Enable
Trend". The values are saved in a trend file and can be displayed again at a later
time. Furthermore, you can add any comment texts you would like.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button. The display changes to a "flat" button with the
label "Stop Record". The recording stops when you click the button again.

| Stop Record m|
The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).
If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.
Interval ﬂls Stop Record 1 Comment... [ [1\Temp\trend files'test_project_VRU-D3-BAC_Room 345G_21939-30034-032-029_20151112_092453_trend bpttnd |
Trend
test_project, VRU-D3-BAC, Room 345G
R Ry
P
f;% I e e e N T s
E o1 //’ """"""
E 07 /\/\
1] T T T T T T T T T T T T T T T T
09:24:53 092456 09:24:59 02502 0925:05  0MZ5:08 09025011 09:25:14 092517 09:25:20 0902523 092526 092529 0Wz25e3z 02535 0925058
| Applied Setpoint [%] Damper [%] - Birflow absolute [m3fh] — ap [Pa]|

Values to show Applied Setpoint [96] Ap [Pa]

Damper [%]

Comments Airflow absolute [m3/h]

State:

Trending area available in PC-Tool

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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3 VRU-

M1R-BAC

3.1 Displayed settings

PC-Tool gives in a single tab an overview of the current settings of the VRU-
M1R-BAC controller.

Type VRU-M1R-BAC SN 21940-30015-032-029 J
Designation RP Controller Address PP Z
Position Room 456K S
a7t
Basic Settings Application Control Settings Y / U
Designation RP Controller Setpaint Signal DC 210V - Read
Pesition Room 456K Feedback Parameter Ji's] - Write
Application Type Room Pressure Feedback U DC 210V ~
Pressure Cascade Off w Installation Storetofile...
OEM Settings Active Time 0| h
FP'nom 50.0| 5.0.75.0Pa Operating Time 0| h
Controller Sensitivity 0.10..10.00 Changes In Direction 1 Enable Trend
Controller Deadband +- 50( 1.0.10.0Pa Mechanical Overloads 10
Dir. of Rotation cw ~ Actuator State 0K
NFC Interface Read only Simulation
Project Settings Control Simulation off ~
Pmax 10.50 Pa Applied Setpoint 15| Pa
P'min 40Fs Ap 1| Pa
Room Pressure Owerpressure ~ Dramper position 33 %
Pesitioning Supply Air ~ Adaption / Synchronization / State
T Synchronization Synchronisation
Bus Protocol MP w Adaption Adaption
Actuator Settings State Control

Serial Number Actuator
Synchronization at
Pawer ON behavior
MNominal range

Mominzl range

01943-00072-140-126

Y=100% ~

No action ~

Adapted ~
92.93 ..96.00°

Main view of a VRU-M1R-BAC device

The displayed settings will vary depending on the settings selected for the device
in every available field. All settings are available for the Room Pressure applica-
tion.

A description of the available settings can be found in the table below.
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Settings Description
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Basic Settings

Designation

Description of the device. 16 characters of any text.

Position

Identification of the location / plant for the device. 16 characters of
any text.

Application Type

Application active (only Room Pressure available)

Pressure Cascade

Room Pressure cascade application.
Enables the VRU-M1R-BAC as primary Ap circuit.
(On/ On, fast / Off)

OEM Settings

Pnom

Nominal Pressure. Specific parameter set by the manufacturer.

Controller Sensitivity

Defines sensitivity of the controller (0.10-10.00)

Controller Deadband

Defines the dead band of the controller (1.0-10.0 %)

Dir. of Rotation

Clockwise/counterclockwise operation of attached actuator.

NFC Interface

NFC mode (read/write).

Project Settings

Pmax

Upper limit of operating pressure.

Pmin

Lower limit of operating pressure.

Room Pressure

Sets up calculations for Ap (Overpressure / Under pressure).

Actuator Settings

Synchronization at

Stop position 0% or 100%

Power ON behavior

Behavior when system is switched on or after a voltage interruption.
(No action / Adaption / Synchronization).

Nominal range

Angle of rotation range. Defines the range limitation.

(Menu) (Adapted / Programmed).
Nominal range Adapted: To the range of rotation from the mechanical stop settings.
(number) Programmed: Selects the maximum angle of rotation.

Application Control
Settings Y/ U

Setpoint

Defines the source of the setpoint received (Bus / Analog).

Setpoint Signal

Defines the setpoint signal type

0...10V Fixed operating range from 0 to 10 V
2..10V Fixed operating range from 2 to 10 V

. Voltage range can be defined: Start 0.0...8.0 V / Stop 2.0...10.0 V
Variable

Range between start and stop must be at least 2 V.

Feedback Parameter

Defines the feedback received (Position / Ap)

Feedback U Defines the feedback signal type
0...10V Fixed operating range from 0 to 10 V
2..10V Fixed operating range from 2 to 10 V
Variable Voltage range can be defined: Start 0.0...8.0 V / Stop 2.0...10.0 V

Range between start and stop must be at least 2 V.
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Installation

Active Time?!

Motor active time in hours.

Operating Time

Powered time in hours.

Changes in Direction®

Direction change counter.

Mechanical Overload?!

Mechanical Overload counter.

Actuator State?

Feedback Status from actuator (OK / Cannot Move / Gear disen-
gaged / Travel increased / Actuator doesn't match)

Simulation

Control

Select the desired behavior of the actuator for the simulation
(Open / Close / Nominal / Min / Max / Motor Stop / Setpoint %)

Applied Setpoint

Actual defined setpoint (Pa)

Applied Setpoint

Defines the Ap to be simulated

Ap

Actual Ap value

Damper

Actual damper position

Synchronization /
Adaption / State

Synchronization

Moves to a mechanical limit (according to the setting "Synchroniza-
tion at").

Adaption

Moves to both mechanical limits and recalculates angle-dependent
parameters.

State

Shows status of the actuator. If no synchronization or adaption is in
progress, the displayed value is "Control".

Communication

Bus Protocol

Defines bus protocol used (MP / BACnet MS/TP / Modbus RTU)

MAC Address?

Defines the address of the actuator (BACnet: 1-127 / Modbus: 1-247)

Baudrate?

Defines the communication baud rate.
(9600 / 19200 / 38400 / 76800 / 115200)

Terminating Resistor!

Terminating resistor is present in bus (On / Off)

Instance Number?!

Defines BACnet instance number (1-4194304)

Device Name?!

Defines BACnet device name. 32 characters of any text.

Max. Master!

Defines maximum BACnet Master (1-127)

Parity*

Defines Modbus parity (1-8-N-2 / 1-8-E-1 / 1-8-O-1/ 1-8-N-1)

1 The visualization of the setting is influenced by the overall settings of the controller.
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3.2 Room Pressure Application

Room pressure control RP:

Suitable for rooms with non-critical leakage rates / overflows.

0 Modulationg: P'min ... P'max / Motor stop.

0 Step operation: P'min / P'max / Damper closed / Damper open / Motor stop.
Volume flow & room pressure control:

Suitable for rooms with low leakage rate / overflow.

0 Volume flow VAV / CAV: V'min ... V'max

0 Room pressure bypass damper: P'min / P'max / Motor Stop
Room pressure & volume flow cascade control

This application consists on:
0 Room pressure cascade controller (VRU-M1R-BAC [RPC])

o Volume flow rate cascade controller (VRU-D3/M1-BAC [VAV]).
o Volume flow controller (VRU-D3/M1-BAC [VAV]).

For a more detailed information about the application, please consult the docu-
ment Room and system applications with VAV-Universal.

Type VRU-M1R-BAC SN 21940-30015-032-029 J
Designation RP Controller Address PP 2 )
Position Room 456K 4 b N
Basic Settings Application Control Settings ¥ / U
Designation RP Controller Setpoint Signal DC 210V v Read
Paosition Room 456K Installation Write
Application Type Room Pressure Operating Time 0] h
Pressure Cascade On ~ Simlation Hsioile
Contral Simulation off ~
OEM Settings
Pnom 500/ 5.0.75.0Pa Applied Setpoint 15| Fa
Controller Sensitivity 0.10..10.00 p 1 Enable Trend
Controller D i 50|/ 1.0.100Pa Output to Cascade VAV €1 V
NFC Interface Read only
Project Settings
F'min .40Pa
Room Pressure Overpressure ~
Paositioning Supply Air e
Communication
Bus Protocol MP ~

View of a VRU-M1R-BAC device with Room pressure control application active
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3.3 Enable Trend functionality

At any moment, the time progress of the setpoint and actual values can be dis-
played in a plot. This graphic can be visualized through the button "Enable
Trend". The values are saved in a trend file and can be displayed again at a later
time. Furthermore, you can add any comment texts you would like.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button. The display changes to a "flat" button with the
label "Stop Record". The recording stops when you click the button again.

Stop Record [ |
The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).
If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.
Interval 1.0(s Stop Record ] Comment... H |'-.Temp'-irendfiles'-test _project_WVRU-M1R-BAC_A1-50d AB_21 54D~3DD1B—D32—D25_2D151115_D?4345_trend.bpﬂnd|
Trend
test_project, VRU-M1R-BAC, A1-Siid AB
BQ 100 o .
ric Simulation Mode. |
e Smulation tose. )
o - rd
B e e
P 1 S S AN AN I A R NN S N B S i
&g ]

o T T T

074346 07:43:49 07:48:52 07:48:55 074358 074901 07:49:04 07:49:07 07049010 07:49:13 0749016 074319 074222 074925 07:49:28 07:49:531  07:49:34

[ pplied Setpoint [%] — Damper [%] - Output to EXH. AY [v] — 4p [Pa] |

Values to show Applied Setpoint [%:] Ap [Pa]

Damper [%]

Comments Output to EXH. VAV [V]

State:

Trending area available in PC-Tool

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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1 Introduction

The "PR(K)" module user manual describes the detail area [D] of the PR(K) but-
terfly valve actuators.
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2 PR(K)

2.1 Displayed settings

e
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PC-Tool gives in a single tab an overview of the current settings of the PRCA-

BAC-S2-T-200. Settings may differ from type to type.

Type PRKCA-BAC-S2-T-200

Designation Room 1

Position Left corner

Basic Settings

Designation | Room1

Paosition

Setpoint

5 e

[+]

o

3

@
o s
=] s

£

Running Time 30.120s
Max. Position 33..100 %
Valve Settings DN200/8" w
Application Control Settings Y / U

Control x. 10V ~

Y3 Start 05.20 V
Y3 Stop 10.0| 40100V
Control Signal Mormal w

US Start 05.20 V
US Stop 35.100 V
Feedback Signal Mormal w
Bus Settings

Bus Protocol BACnet MS/TP ~
MAC Address 127
Baudrate 38400 ~
Terminating Resistor Off w
Instance Number

Device Name |

Max Master 127 127
Installation

Voltage Source 24V DC

Voltage Failures 5

Operating Time 576 h

Active Time 0 h

SN 01747-00113-163-049
Address PP

Operation

Full open

Full close

Motor Starts
Change In Direction

System

Mechanical Overload
NFC enabled

Simulation

Override Control

Walve Position

None

Main view of a PRCA-BAC-S2-T-200 device

v

Read
Write
Store to file_..
Load from file_..

Enable Trend
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Basic Settings

Designation Description of the device. 16 characters of any text.
. Identification of the location / plant of the device. 32 characters of any
Position
text.
Setpoint! Defines the source of the setpoint received (Bus / Analog).

Running Time

Time needed to cover the full operating range (30...120s).

Sensor1/2

If a sensor is configured (via Modbus or BACnet) — Sensor type e.g.
PT1000 and temperature will be displayed.

Max. Position

Limitation of the angle of rotation. Range 33...100%

Valve Settings

Specifying the actual parameterization of the actuator for the specific
DN sizes of the valve. Selection: Regular, DN200/8 or DN250/10

Application Control
Settings Y/ U

Different options for control type. Positions: x...10V / O-C /3-point /

Control 4...20mA
Y3 Start Starting point for control. Range between 0.5 ...2.0 V
Y3 Stop End point for control. Range between 4.0 ...10.0 V

Control signal

Type of control signal. Normal or inverted.

U5 Start

Starting point for feedback signal. Range between 0.5...2.0 V

U5 Stop

End point for feedback signal. Range between 4.0...10.0 V

Feedback Signal

Type of feedback signal. Normal or inverted.

Bus Settings

Bus Protocol

Defines bus protocol used (MP / BACnet MS/TP / Modbus RTU)

MP Address? MP Address of the actuator
MAC Address?! Defines the address of the actuator (BACnet: 1-127 / Modbus: 1-247)
Baudrate! Defines the communication baud rate.

(9600 / 19200 / 38400 / 76800 / 115200)

Terminating Resistor!

Terminating resistor is present in bus (On / Off)

Instance Number?!

Defines BACnet instance number (1-4194304)

Device Name?

Defines BACnet device name. 32 characters of any text.

Max. Master?

Defines maximum BACnet Master (1-127)

Parity!

Defines Modbus parity (1-8-N-2 / 1-8-E-1 / 1-8-O-1/ 1-8-N-1)

Installation

Voltage Source

Shows the current voltage source. 24V AC or 230 V

Voltage Failures

Shows the total number of voltage failures/ power losses

Operating Time

Number of hours during which the actuator was connected to the
power supply

Number of hours during which the actuator was mechanically in mo-

Active Time tion and connected to the power supply
Operation

Shows the total number of full openings of the valves (reaching the
Full Open

upper end stop)

Shows the total number of full closings of the valves (reaching the
Full Close

lower end stop)
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Motor Starts

Total quantity of motor starts. How often the actuator starts running.

Change in Direction

Shows how often the actuator change its direction. High value could
be an indication for a hunting system.

System

Mechanical overload

Actuator did not reach setpoint because an obstacle has reduced the
operating range.

NFC is enabled

Shows if NFC (Near Field Communication) is enabled or not.
Value 1 = NFC is enabled. Value 0 = NFC is disabled.

Simulation

Override Control

Remote control of the actuator via PC-Tool

Valve Position

Shows the actual valve position to which the actuator is mounted to.
Value shown in %.

! The visualization of the setting is influenced by the overall settings of the controller.

Note: For the Supercap actuator the following fields are not displayed and can not be configured via the

PC-Tool:

¢ Fail-safe position (POP). Factory setting: 0% (range 0 — 100%)

¢ Bridging time. Factory setting: 2 sec. (range 0 — 10 sec.)
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2.2 Enable Trend functionality

|Trend Record

| Stop Record

At any moment, the time progress of the setpoint and actual values can be dis-
played in a plot. This graphic can be visualized through the button "Enable
Trend". The values are saved in a trend file and can be displayed again at a later
time. Furthermore, you can add any comment texts you would like.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button. The display changes to a "flat" button with the
label "Stop Record". The recording stops when you click the button again.

The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Normally the actual setpoint is active. Can however be overwritten by Override
control values.

Simulation
Cverride Control Mone -
Damper Position Open

Close

Stop

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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1 Introduction

The "PM/PK module" user manual describes the detail area [D] of the damper ac-
tuators.
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2 PM/PK

2.1 Displayed settings

PC-Tool gives in a single tab an overview of the current settings of the PMCA-
BAC-S2-T. Setting may differ from type to type.

Type PMCA-BAC-S2-T SN 01904-40012-163-049 o \/
Designation hak test Address PP S
Position Ecke rechts 3

Basic Settings Operation -~
Designation |hak test | Full open 40 Read
Position [Ecke rechts | Full close 83
Write
Setpoint Analogue ~ Motor Starts 278
Running Time 30.1205 Change In Direction 244 Store to file._.
Sensor 1: PT1000 64107 Q System
) Load from file. ..
Max. Position 33.100 % esiae GeEine 0
Mid. Position 5% R Enhled L Enable Trend
Min. Position [ o .2% Simuation
Override Control None @
Application Cortrol Settings Y / U
Contrel x. 10V v Damper Position
Y3 Start 0.5.20 V
¥3 Stop 25100V
Control Signal MNomal ~
US Start 05.20 V
U5 Stop 10.0( 4.0.100 V
Feedback Signal MNomal -
Bus Settings
Bus Protocol BACnet MS/TP w
MAC Address 127

Terminating Resistor

Instance Number

Baudrate 33400 ~
Off

Device Name

Max Master 127 127

Installation

eltage Source 24V DC
Voltage Failures 74
Operating Time 224| h

Active Time 0 h -

Main view of a PMCA-BAC-S2-T device
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Basic Settings

Designation Description of the device. 16 characters of any text.
. Identification of the location / plant of the device. 32 characters of any
Position
text.
Setpoint! Defines the source of the setpoint received (Bus / Analog).

Running Time

Time needed to cover the full operating range (30...120s).

Sensor1/2

If a sensor is configured (via Modbus or BACnet) — Sensor type e.g.
PT1000 and resistance will be displayed.

Max. Position

Limitation of the angle of rotation. Range 33...100%

Mid. Position

Min... Max %

Min. Position

0...70%, Min<=Max-30%

Application Control
Settings Y /U

Different options for control type. Positions: x...10V / O-C /3-point /

Control 4...20mA
Y3 Start Starting point for control. Range between 0.5 ...2.0 V
Y3 Stop End point for control. Range between 4.0 ...10.0 V

Control signal

Type of control signal. Normal or inverted.

U5 Start Starting point for feedback signal. Range between 0.5...2.0 V
U5 Stop End point for feedback signal. Range between 4.0...10.0 V
Feedback Signal Type of feedback signal. Normal or inverted.

Bus Settings

Bus Protocol

Defines bus protocol used (MP / BACnet MS/TP / Modbus RTU)

MP Address? MP Address of the actuator
MAC Address* Defines the address of the actuator (BACnet: 1-127 / Modbus: 1-247)
Baudrate! Defines the communication baud rate.

(9600 / 19200 / 38400 / 76800 / 115200)

Terminating Resistor!

Terminating resistor is present in bus (On / Off)

Instance Number?!

Defines BACnet instance number (1-4194304)

Device Name?

Defines BACnet device name. 32 characters of any text.

Max. Master?

Defines maximum BACnet Master (1-127)

Parity*

Defines Modbus parity (1-8-N-2 / 1-8-E-1 / 1-8-O-1/ 1-8-N-1)

Installation

Voltage Source

Shows the current voltage source. 24V AC or 230 V

Voltage Failures

Shows the total number of voltage failures/ power losses

Operating Time

Number of hours during which the actuator was connected to the
power supply

Number of hours during which the actuator was mechanically in mo-

Active Time tion and connected to the power supply
Operation
Full Open Shows the total number of full openings of the valves (reaching the

upper end stop)
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Full Close

Shows the total number of full closings of the valves (reaching the
lower end stop)

Motor Starts

Total quantity of motor starts. How often the actuator starts running.

Change in Direction

Shows how often the actuator change its direction. High value could
be an indication for a hunting system.

System

Mechanical overload

Actuator did not reach setpoint because an obstacle has reduced the
operating range.

NFC is enabled

Shows if NFC (Near Field Communication) is enabled or not.
Value 1= NFC is enabled. Value 0 = NFC is disabled.

Simulation

Override Control

Remote control of the actuator via PC-Tool

Valve Position

Shows the actual valve position to which the actuator is mounted to.
Value shown in %.

! The visualization of the setting is influenced by the overall settings of the controller.

Note: For the Supercap actuator the following fields are not displayed and can not be configured via the

PC-Tool:

¢ Fail-safe position (POP). Factory setting: 0% (range 0 — 100%)

¢ Bridging time. Factory setting: 2 sec. (range 0 — 10 sec.)
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2.2 Enable Trend functionality

|Trend Record

| Stop Record

At any moment, the time progress of the setpoint and actual values can be dis-
played in a plot. This graphic can be visualized through the button "Enable
Trend". The values are saved in a trend file and can be displayed again at a later
time. Furthermore, you can add any comment texts you would like.

On trend record, the trend is automatically saved to a temporary file and retained
for one month. Click on the icon "Save" to save the trend with a different name
and location (after stop record).

In the PC tool options "General" specify whether the program should ask for the
new file name (ask user if trend files should be saved). The suggested file name
can be modified before saving the file.

Click the "Trend Record" button. The display changes to a "flat" button with the
label "Stop Record". The recording stops when you click the button again.

The position is queried every second by default. You can change the query inter-
val in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Normally the actual setpoint is active. Can however be overwritten by Override
values.

Simulation
Cverride Control Mone -
Damper Position Open

Close

Stop

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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